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Panoramica

Configurazione del sistema

Questa sezione illustra un esempio di configurazione di un sistema videocamera.

SELP28135G
SEL1635Z
SELP18200
Obiettivo
[T
ECM-MS2
Microfono LA-EAS,
LA-EA4
Adattatore
per innesto
. A-mount
IFU-WLM3
Modulo LAN wireless USB
(fornito)

UWP-D11, SMAD-P3 XLR-K2M HVL-LBPC
UWP-D12 Adattatore a Kitadattatore Luce video
Pacchetto slitta Multi- XLR

microfono interface

wireless

Serie S/IN/M/H/G
Scheda di memoria XQD

MRW-E80

BP-U30, BP-U60,
BP-U60T, BP-U90
Pacco batteria
(BP-U30 fornito)

BC-U1A, BC-U2A
Adattatore CA/
Caricabatterie
(BC-U1A fornito)

XDCA-FS7
Unita di
estensione

RMT-845
Telecomando ad
infrarossi (fornito)

Adattatore wireless
CBK-WA100

Telecomando impugnatura
(fornito)

VCT-FS7
Adattatore da spalla

050

(o) -ae]

)
HXR-IFR5 AXS-R5
Unita di Registratore
interfaccia portatile con

scheda di
memoria



Posizione e funzione delle parti

Per informazioni dettagliate sull utilizzo e la funzione di ogni parte, fare riferimento alla pagina indicata.
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10.

. Maniglia (pagina 8)

. Connettore mirino (pagina 22)

. Connettore REMOTE (pagina 25)

. Selettore INPUT1 (LINE/MIC/MIC+48V)

(pagina 45)

. Selettore INPUT2 (LINE/MIC/MIC+48V)

(pagina 45)

. Attacco impugnatura (pagina 25)
. Connettore modulo LAN wireless USB

. Indicatore registrazione (pagina 101)

Lampeggia quando la capacita rimanente del

supporto di registrazione o della batteria ¢ bassa.

. Gancio per metro a nastro

11 gancio del metro a nastro si trova sullo stesso
piano del sensore immagine. Per misurare con
precisione la distanza tra il camcorder e il
soggetto, utilizzare questo gancio come punto di
riferimento. Fissare I’estremita di un metro a
nastro a questo gancio per misurare la distanza
del soggetto.

Pulsante WB SET (impostazione
bilanciamento del bianco) (pagina 45)

11.
12.
13.
14.

15.

16.

Perno di blocco obiettivo (pagina 24)
Pulsante di sblocco obiettivo (pagina 24)
Slitta accessori

Pulsante START/STOP registrazione
della maniglia

11 pulsante di registrazione non puo essere
azionato quando la levetta di blocco si trova in
posizione di blocco.

Levetta dello zoom sulla maniglia
(pagina 71)

Slitta Multi-interface

® Multi
Y interface Shoe

Per informazioni dettagliate sulla gamma di
accessori utilizzabili con la slitta Multi-
interface, rivolgersi al proprio rappresentante di
vendita.



Montaggio della slitta accessori

1 Sollevare il bordo anteriore della molla della slitta e
tirare la molla nella direzione opposta a quella indicata
dalla freccia incisa sulla slitta stessa.

Molla della slitta

SN
R >
Slitta accessori

2 Posizionare la slitta accessori sulla sua sede di
montaggio, allineando le sporgenze della slitta con il
punti corrispondenti della sede di montaggio, quindi
serrare le quattro viti.

3 Inserire la molla della slitta nella direzione della
freccia in modo che la porzione a forma di U si
inserisca in fondo alla slitta.

Molla della slitta

Rimozione della slitta accessori

Rimuovere la molla della slitta come descritto al
passo 1 del paragrafo “Montaggio della slitta
accessori”, svitare le quattro viti e rimuovere la
slitta acessori.

Montaggio della piastra di protezione del

modulo LAN wireless USB

1 Rimuovere la vite di montaggio della maniglia.

2 Montare la piastra di protezione, quindi stringere la
vite.

Rimozione della maniglia
Per rimuovere la maniglia dal camcorder, svitare
le sue quattro viti di fissaggio.

Montaggio del coperchietto di protezione del
connettore della maniglia (in dotazione)
Quando si usa il camcorder senza la maniglia,
proteggere il connettore con il coperchietto di
protezione in dotazione.

Protezione dei terminali del connettore
Montare il coperchietto sui connettori non
utilizzati per proteggere i terminali del
connettore.
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1. Pulsante START/STOP
2. Manopola ND FILTER (pagina 44)
3. Pulsanti programmabili ASSIGN.da1a3
(pagina 47)
4. Pulsante PUSH AUTO IRIS (pagina 43)
5. Pulsante PUSH AUTO FOCUS
(pagina 41)
6. Selettore FOCUS (pagina 41)
7. Pulsante DISPLAY (pagina 13)
8. Pulsante FULL AUTO (pagina 39)
9. Interruttore POWER (pagina 19)
10. Manopola IRIS (pagina 47)
11. Pulsante STATUS CHECK (pagina 16)
12. Selettore HOLD (pagina 101)
13. Selettore CH1 LEVEL CONTROL
(pagina 45)
14. Manopola CH1 INPUT LEVEL
(pagina 45)
15. Selettore CH2 LEVEL CONTROL
(pagina 45)
16. Manopola CH2 INPUT LEVEL
(pagina 45)
17. Pulsante SLOT SELECT (selezione della
scheda di memoria XQD) (pagina 31)
18. Pulsante CANCEL/BACK (pagina 60)
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19. Pulsante MENU (pagina 62)
20. Pulsante THUMBNAIL (pagina 59)

21. Pulsante destro
Consente di impostare valori numerici e
spostare il cursore a destra nelle schermate delle
miniature e nei menu.

22. Manopola SEL/SET (seleziona/imposta)
Ruotare la manopola per spostare il cursore
verso I’alto o il basso e selezionare voci di menu
o impostazioni. Premere per applicare la voce
selezionata.

23. Pulsante sinistro
Consente di impostare valori numerici e
spostare il cursore a sinistra nelle schermate
delle miniature e nei menu.

24. Pulsante SHUTTER (pagina 44)

25. Selettore WHT BAL (selezione memoria
bilanciamento del bianco) (pagina 44)

26. Pulsante WHT BAL (bilanciamento del
bianco) (pagina 44)

27. Selettore GAIN (selezione guadagno)
(pagina 43)

28. Pulsante ISO/Gain (pagina 43)



. Connettore cuffie (pagina 42)

. Slot scheda XQD A (pagina 31)

. Slot scheda UTILITY SD (pagina 32)

. Indicatore di accesso XQD (A) (pagina 31)

. Indicatore di accesso scheda SD

(pagina 32)
. Indicatore di accesso XQD (B (pagina 31)
7. Connettore USB
Consente il collegamento a un computer
mediante un cavo USB per accedere ai supporti

di registrazione inseriti in uno slot per schede
XQD del camcorder.

8. Slot scheda XQD B (pagina 31)
9. Altoparlante incorporato (pagina 42)

Sl A W N =

(=2

10. Pulsante rilascio coperchio schede
(pagina 31)

11. Connettore unita di estensione (pagina 33)

12. Indicatore registrazione posteriore
(pagina 39)

13. Connettore DC IN (pagina 20)

14. Pulsante BATT RELEASE (rilascio
batteria) (pagina 19)

15. Batteria (pagina 19)
16. Attacco pacco batteria (pagina 19)

17. Sensore ricevitore telecomando
infrarossi(pagina 36)

18. Microfono interno (pagina 45)
Microfono di narrazione per la registrazione
dell’audio ambientale.

19. Connettore INPUT1 (ingresso audio 1)
(pagina 45)

20. Connettore INPUT2 (ingresso audio 2)
(pagina 45)

21. Connettore SDI OUT 1 (pagina 106)
22. Connettore SDI OUT 2 (pagina 106)
23. Connettore HDMI OUT (pagina 106)

Lato inferiore




1. Attacco filettato di montaggio del

treppiede (1/4 pollici, 3/8 pollici) Telecomando impugnatura
Compatibile con viti 1/4-20UNC e 3/8-16UNC.
Consente il montaggio di un treppiede Per informazioni dettagliate sul montaggio del
(opzionale, vite di lunghezza max. 5,5 mm). telecomando dell’impugnatura (in dotazione),
vedere pagina 25.
Mirino

Per informazioni dettagliate sul montaggio di
mirino (in dotazione) e oculare, vedere
pagina 22.

5
AR
1. Manopola CONTRAST 7 TS as\\m\\\\;@% ;

8 [
2. Pulsante PEAKING
3. Pulsante ZEBRA )
4. Selettore MIRROR

5. Ganci di montaggio oculare

Oculare 1. Levetta dello zoom

2. Pulsante programmabile ASSIGN 4
3. Manopola programmabile

4. Pulsante programmabile ASSIGN 6
5. Pulsante START/STOP registrazione
6. Multiselettore

Per informazioni dettagliate sul montaggio
dell’oculare (in dotazione), vedere pagina 23.

7. Pulsante di rotazione impugnatura
8. Pulsante programmabile ASSIGN 5

1. Manopola di regolazione diottrica

2. Coppa dell’oculare

Obiettivo (solo PXW-FS7K)

Per informazioni dettagliate, fare riferimento al
manuale operativo dell’obiettivo.

11



Telecomando ad infrarossi Unita di estensione (opzione)

8 Per informazioni dettagliate sul montaggio
’_l\ dell’unita di estensione (opzione), vedere
1 E— pagina 33.
4 Y 10 1—
5 [? G(D » @
6 E/a 12
7 13 2
3 I
- J 4
—_ 5
1. Pulsante DATA CODE 6

Non utilizzato in questa versione.
2. Pulsante TC RESET
3. Pulsante SCAN/SLOW 2. Connettore della batteria

4. Pulsante ¢/»» (PREV/NEXT) 3. Connettore GENLOCK IN
5. Pulsante PLAY 4. Connettore DC IN

6. Pulsante STOP 5. Connettore DC OUT

7. Pulsante DISPLAY 6. Indicatore di registrazione
7. Connettore REF OUT
8. Connettore TC IN/OUT
9. Selettore TC IN/OUT

10. Connettore RAW OUT

1. Pulsante BATT RELEASE

8. Trasmettitore del telecomando
9. Pulsante START/STOP

10. Levetta dello zoom

11. Pulsante PAUSE

12. Pulsante MODE
Non utilizzato in questa versione.

13. Pulsante </»/A/Y/ENTER

12



Visualizzazione a schermo

Schermo del mirino

Durante la ripresa (registrazione/standby) e la riproduzione, le informazioni sullo stato del camcorder e le
sue impostazioni sono sovraimposte all’immagine visualizzata nel mirino.
E possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY.

E inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre (pagina 86).
L’immagine con rapporto di formato 17:9 acquisita dal sensore immagine ¢ visualizzata nel mirino. Nei
formati di registrazione 16:9, le porzioni scure sui bordi destro e sinistro non vengono registrate.

Informazioni visualizzate a schermo durante le riprese
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1. Indicatore modalita otturatore / velocita 5. Indicatori di modalita di registrazione,
otturatore (pagina 44) icona slot A/B e stato

2. Indicatore filtro ND (pagina 44)

3. Indicatore guadagno (pagina 43)
Visualizzato come valore EI quando Base
Setting (pagina 97) >Shooting Mode nel menu
System ¢ impostato su “Cine EI”.

4. Indicazione posizione di messa a fuoco
Visualizza la posizione di messa a fuoco (se &
montato un obiettivo che supporta questa
funzione).

/ ®Rec

Registrazione

/[B] Stby

Standby

S&Q[A /[B]®Rec

Registrazione Slow &
Quick Motion, modalita
High Frame Rate

S&Q[A /[B]stby

Slow & Quick Motion,
modalita High Frame
Rate standby

Int|A|/@Rec

Registrazione Interval
Rec

Int|A]/@Stby

Standby caricamento
immagine Interval Rec




10.

1.

12

13.

14

15.

16.

Standby registrazione
Interval Rec

Int[A]/[B Stby

Registrazione cache

A/Ble

immagine
Cache immagine
[Al/|B|@Cache standby
. Icona Slot B e indicatori di stato
®Rec Registrazione
Stby Standby

. Indicatore registrazione RAW esterna

(pagina 54)

. Indicatore di profondita di campo

. Indicatore temperatura di colore

(pagina 44)

Indicatore frequenza fotogrammi S&Q
Motion (pagina 91)/Visualizzazione
intervallo registrazione Interval Rec
(pagina 49)

Indicatore carica residua della batteria/
tensione DC IN (pagina 20)

. Indicatore formato di registrazione

(dimensioni immagine) (pagina 27, 98)
Visualizza le dimensioni immagine per la
registrazione su schede di memoria XQD.
Alla sinistra delle dimensioni immagine &
indicata la modalita di scansione del sensore
immagini (F: 2K Full, C: 2K Center). Se
Codec ¢ impostato su “RAW” ¢ indicata solo
la modalita di scansione (2KF: 2K Full, 2KC:
2K Center).

Indicatore formato di registrazione

(frequenza fotogrammi e metodo di
scansione)

. Indicatore formato di registrazione

(codec) (pagina 43)
Visualizza il nome del formato di
registrazione su schede di memoria XQD.

Indicatore LUT monitor/gamma

(pagina 75, 84)

Visualizza le impostazioni di gamma.
Quando Shooting Mode (pagina 97) &
impostato su “Cine EI”, visualizza le
impostazioni LUT monitor o gamma per la
registrazione di video su schede di memoria
XQD.

Indicatore formato uscita esterna
(pagina 83)
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17.

18.

19.

20.

21.

22.

23.

24.

25.
26.
27.

28.
29.

Indicatore di blocco esterno codice
temporale

Visualizza “EXT-LK” quando I’apparecchio
¢ sincronizzato sul codice temporale di un
dispositivo esterno.

Indicatore di stato della connessione Wi-Fi
(pagina 55)

Visualizzato quando la funzione Wi-Fi &
impostata su “Enable”. Se non & montato un
modulo IFU-WLM3 sul camcorder, [§] non
viene visualizzato.

Indicatore stato GPS (pagina 53)
Visualizza lo stato della funzione GPS.

Indicatore Focus Assist di assistenza alla
messa a fuoco (pagina 42)

Visualizza un riquadro di rilevazione
(indicatore zona di messa a fuoco) che indica
la zona in cui viene rilevata la messa a fuoco
e una barra di livelli (indicatore Focus Assist)
che segnala il grado di messa a fuoco
all’interno della zona indicata.

Monitor segnale video (pagina 53)
Visualizza forma d’onda, vettorscopio e
istogramma.

Quando Shooting Mode (pagina 97) & impostata
su Cine EI, visualizza anche le informazioni di
LUT del monitor (pagina 53).

Indicatore stato/capacita rimanente
supporto in slot A/B (pagina 31)

Supporto di registrazione quando il lato
sinistro dell’icona ¢ di colore arancione.
Supporto di riproduzione quando I’ indicatore
verde in alto a destra dell’icona ¢ illuminato.

Indicatore di livellamento

Visualizza I’orizzontalita trasversale e
longitudinale in incrementi di +1° fino a un
massimo di +20°.

Indicatore di livello audio

CH3 e CH4 possono essere monitorati sulla
schermata di stato.

Indicatore nome clip (pagina 59)
Indicatore di messa a fuoco
Visualizzazione dei dati temporali
(pagina 46)

Indicatore scheda SD

Indicatore di stato controllo uscita SDI
(pagina 106)



30. Indicazione modalita bilanciamento del
bianco (pagina 44)

W:P Modalita predefinita
W:A Modalita memoria A
W:B Modalita memoria B

31. Indicatore della modalita AE (pagina 43)

32. Indicatore diaframma automatico (Auto
Iris) (pagina 43)

33. Indicatore AGC (pagina 43)
34. Indicatore otturatore automatico
(pagina 44)
35. Indicatore della modalita di messa a fuoco

36. Indicatore della modalita di
stabilizzazione dell’immagine

37. Indicatore della zona di messa a fuoco
Visualizza la zona di messa a fuoco per la messa
a fuoco automatica.
Quando ¢ disponibile la funzione Push Auto
Focus

Durante la messa a fuoco automatica

Non visualizzato quando Focus Area
(pagina 68) ¢ impostata su Wide.

38. Indicazione posizione di zoom
Visualizza il valore di zoom nel campo da 0
(grandangolo) a 99 (teleobiettivo) (se & montato
un obiettivo che supporta questa funzione).
Visualizzabile anche come un grafico a barre
(pagina 88).

39. Indicazione valore di diaframma
Visualizza il valore di diaframma (se & montato
un obiettivo che supporta questa funzione).
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Informazioni visualizzate a schermo durante la
riproduzione

Le seguenti informazioni vengono sovraimposte
sull’immagine riprodotta.

! 2

(000170012 Gips)

~No onbs

A001C001_1234567A

(TCR00:00:00:00) [ &
I I
10 9

1. Numero clip / Numero totale dei clip
. Modalita di riproduzione

3. Indicatore della carica residua della
batteria

4. Indicatore formato di riproduzione
(dimensioni immagine)

5. Indicatore formato di riproduzione
(frequenza fotogrammi)

6. Indicatore formato di riproduzione
(codec)

7. Indicatore di stato della connessione Wi-Fi
(pagina 55)
Visualizzato quando la funzione Wi-Fi ¢
impostata su “Enable”. Se non & montato un
modulo IFU-WLM3 sul camcorder, [§] non
viene visualizzato.

8. Indicatore supporto

9. Indicatore del livello audio
Visualizza I’indicatore di livello audio durante
la registrazione.
10. Visualizzazione dei dati temporali
Quando Display On/Off >Timecode nel menu
VF ¢ impostato su “On”, visualizza i dati
temporali quando si preme il pulsante
DISPLAY.



Schermata di stato

Per visualizzare la schermata di stato:
* Premere il pulsante STATUS CHECK.

Per cambiare schermata di stato:

* Ruotare la manopola SEL/SET.

« Spostare il multiselettore verso 1’alto o verso il
basso.

Per nascondere la schermata di stato:
¢ Premere il pulsante STATUS CHECK.

Schermata Camera Status
Visualizza le impostazioni dell’otturatore

elettronico del camcorder e lo stato dell’ obiettivo.

ISO/Gain/EI<H> Impostazione ISO/Gain/EI<H>

ISO/Gain/EI<M> Impostazione ISO/Gain/EI<M>

ISO/Gain/EI<L> Impostazione ISO/Gain/EI<L>

Shutter Impostazioni otturatore (Speed/
Angle/ECS/Off)

Iris Valore di F-stop ottenuto
dall’obiettivo

Zebral Impostazione Zebral On/Off e
livello

Zebra2 Impostazione Zebra2 On/Off e
livello

Gamma Impostazione Gamma Select

White Modalita e impostazioni di

bilanciamento del bianco

Focal Length Valore di lunghezza focale

ottenuto dall’obiettivo

AE Level Impostazione livello AE

AE Speed Impostazione velocita di controllo
AE

AGC Limit Valore di guadagno massimo della
funzione AGC

A.SHT Limit Velocita otturatore massima della
funzione auto shutter

AE Mode Impostazione modalita AE

(Backlight/Standard/Spotlight)

Schermata Audio Status

Visualizza le impostazioni di ingresso,
I’indicatore di livello audio e le impostazioni del
filtro di riduzione del rumore del vento per
ciascun canale.

Indicatore di livello audio del
canale 1

CHI level meter

CHI1 Source Sorgente di ingresso del canale 1

CHI Ref./Sens. Livello di riferimento di ingresso

del canale 1
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CHI1 Wind Filter ~ Valore di riduzione del filtro
antivento del microfono del canale

Indicatore di livello audio del
canale 2

CH2 level meter

CH2 Source Sorgente di ingresso del canale 2

CH2 Ref./Sens. Livello di riferimento di ingresso

del canale 2

CH2 Wind Filter ~ Valore di riduzione del filtro
antivento del microfono del canale

2

Indicatore di livello audio del
canale 3

CH3 level meter

CH3 Source Sorgente di ingresso del canale 3

CH3 Wind Filter ~ Valore di riduzione del filtro
antivento del microfono del canale
3

CH4 level meter  Indicatore di livello audio del
canale 4

CH4 Source Sorgente di ingresso del canale 4

CH4 Wind Filter ~ Valore di riduzione del filtro
antivento del microfono del
canale 4

Audio Input Level Impostazioni di ingresso audio

Monitor CH Impostazione di monitoraggio del
canale

HDMI Output CH Impostazione combinazione
canali audio HDMI di uscita.

Headphone Out Impostazione del tipo di uscita

cuffie

Schermata System Status
Visualizza le impostazioni del segnale video.

Country Impostazioni regionali NTSC o
PAL
Rec Format Formato di registrazione su schede

di memoria XQD

Picture Size Dimensioni immagine per la
registrazione su schede di

memoria XQD

Frame Rate Frequenza fotogrammi per la
registrazione su schede di

memoria XQD

Rec Function Impostazioni e formato di

registrazione speciale attivo

Simul Rec Stato Simul Rec On/Off

Picture Cache Rec Stato Picture Cache Rec On/Off

Video Light Set Indicatore luce video HVL-LBPC

on/off

Modalita di scansione del sensore
immagine

Imager Scan




Schermata Video Output Status

Visualizza le impostazioni di uscita SDI, HDMI e

video.

SDI1

Dimensioni immagine di uscita
Spazio colore

Uscita visualizzazione a schermo
Gamma

SDI2

Dimensioni immagine di uscita
Spazio colore

Uscita visualizzazione a schermo
Gamma

HDMI

Dimensioni immagine di uscita
Spazio colore

Uscita visualizzazione a schermo
Gamma

REF

Dimensioni immagine di uscita

Schermata Media Status

Visualizza la capacita rimanente e il tempo di
registrazione rimanente dei supporti di
registrazione (schede di memoria XQD A e B).

Informazioni
scheda A

Visualizza I'icona della scheda
quando ¢ inserito un supporto di
registrazione nello slot A.

Protezione scheda
A

Visualizza I’icona di blocco
quando il supporto di
registrazione inserito nello slot A
& protetto.

Non & possibile proteggere schede
di memoria XQD con il

RAW

Dimensioni immagine di uscita

Schermata di stato dei pulsanti programmabili
Visualizza le funzioni assegnate ai pulsanti

camcorder.
Indicatore Visualizza la capacita rimanente
capacitarimanente del supporto di registrazione
scheda A inserito nello slot A come
percentuale su una barra.
Tempo di Visualizza il tempo stimato di
registrazione registrazione rimanente sul

rimanente scheda
A

supporto di registrazione inserito
nello slot A in minuti nelle
condizioni di registrazione attuali.

Informazioni
scheda B

Visualizza I’icona della scheda
quando ¢& inserito un supporto di
registrazione nello slot B.

programmabili.

1 Funzione assegnata al pulsante
ASSIGN 1

2 Funzione assegnata al pulsante
ASSIGN 2

3 Funzione assegnata al pulsante
ASSIGN 3

4 Funzione assegnata al pulsante
ASSIGN 4

5 Funzione assegnata al pulsante
ASSIGN 5

6 Funzione assegnata al pulsante
ASSIGN 6

IRIS Dial Funzione assegnata alla manopola
IRIS

Assignable Dial ~ Funzione assegnata alla manopola

programmabile

Protezione scheda
B

Visualizza I’icona di blocco
quando il supporto di
registrazione inserito nello slot B
¢ protetto.

Non ¢ possibile proteggere schede
di memoria XQD con il

Schermata Battery Status
Visualizza informazioni sulla batteria e la

sorgente di alimentazione collegata al connettore

camcorder.
Indicatore Visualizza la capacita rimanente
capacitarimanente del supporto di registrazione
scheda B inserito nello slot B come
percentuale su una barra.
Tempo di Visualizza il tempo stimato di
registrazione registrazione rimanente sul

rimanente scheda
B

supporto di registrazione inserito
nello slot B in minuti nelle
condizioni di registrazione attuali.

DCIN.

Detected Battery ~ Tipo di batteria
Remaining Capacita rimanente (%)
Charge Count Numero di ricariche
Capacity Capacita rimanente (Ah)
Voltage Tensione (V)

Manufacture Date

Data di fabbricazione della
batteria

Informazioni
scheda SD

Visualizza I’icona della scheda
quando ¢ inserito un supporto di
memoria nello slot per schede
UTILITY SD.

Video Light
Remaining

Visualizza la capacita rimanente
della batteria della luce video.

Power Source

Sorgente di alimentazione

Supplied Voltage

Tensione fornita dalla sorgente di
alimentazione.

Protezione della
scheda SD

Visualizza I’icona di blocco
quando il supporto di memoria
inserito nello slot per schede
UTILITY SD ¢ protetto.




Indicatore
capacitarimanente
scheda SD

Visualizza la capacita rimanente
del supporto di memoria inserito
nello slot per schede UTILITY SD
come percentuale su una barra.

Capacita
rimanente scheda
SD

Visualizza la capacita rimanente
del supporto di memoria inserito
nello slot per schede UTILITY SD
in GB.

Vita scheda SD

Visualizza la vita utile del
supporto di memoria inserito nello
slot per schede UTILITY SD
come percentuale.

Schermata delle impostazioni del pulsante di

registrazione

Visualizza le impostazioni dei pulsanti di
START/STOP registrazione sul corpo e sulla
maniglia (pagina 40).

Rec Button Visualizza gli slot per la
registrazione comandata mediante
il pulsante di START/STOP
registrazione.

Handle Rec Visualizza gli slot per la

Button registrazione comandata mediante

il pulsante di START/STOP
registrazione della maniglia.
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Operazioni preliminari

Alimentazione

E possibile utilizzare un pacco batteria o
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i
seguenti pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
BP-U30 (in dotazione)
BP-U60

BP-U60T

BP-U90

Adattatori CA/caricabatterie
BC-U1A (in dotazione)
BC-U2A

Non conservare i pacchi batteria in luoghi esposti
alla luce solare diretta o a fiamme libere, oppure
in cui siano presenti elevate temperature.

« Per’alimentazione da una presa di corrente, utilizzare
’adattatore CA fornito.

« Impostare sempre I’interruttore POWER su Off prima
di rimuovere o montare un pacco batteria o un
adattatore CA. Se viene rimosso 0 montato con
I’interruttore POWER su On, in alcuni casi il
camcorder potrebbe non avviarsi.

Se non si riesce ad avviare il camcorder, impostare
I’interruttore POWER su Off e rimuovere
temporaneamente il pacco batteria o I’adattatore CA,
quindi attendere circa 30 secondi prima di tentare un
nuovo montaggio. (Se si rimuove o si monta
I’adattatore CA mentre il camcorder ¢ alimentato dal
pacco batteria, o viceversa, ¢ possibile effettuare la
rimozione o il montaggio con I’interruttore POWER su
On senza problemi.)

Utilizzo del pacco batteria

Per montare un pacco batteria, inserirlo fino in
fondo nell’apposita sede (pagina 10), quindi
spingerlo verso il basso per bloccarlo in
posizione.

Per rimuovere un pacco batteria, premere e
mantenere premuto il pulsante BATT RELEASE
(pagina 10), fare scorrere la batteria verso I’alto e
quindi estrarla dalla sede.

Pulsante BATT
RELEASE

* Prima di montare un pacco batteria, ricaricarlo con
I’adattatore CA/caricabatterie specifico BC-U1A o
BC-U2A.

* Se la batteria viene ricaricata immediatamente dopo
I’uso mentre € ancora calda, & possibile che non si
ricarichi completamente.



Controllo della capacita rimanente

Durante la ripresa o la riproduzione con un pacco
batteria, la capacita rimanente della batteria viene
visualizzata nel mirino (pagina 13).

Icona Capacita residua

91%-100%

71%-90%

51%-70%

31%-50%

11%-30%

0%-10%

BN

Il camcorder indica la capacita rimanente
calcolando il tempo disponibile con il pacco
batteria sulla base del consumo attuale.

Quando si utilizza un’unita di estensione
Quando si utilizza I’unita di estensione XDCA-
FS7, viene visualizzata la tensione della batteria o
la carica residua della batteria, a seconda della
batteria utilizzata.

Non & possibile utilizzare il pacco batteria del camcorder
quando & montata un’unita di estensione XDCA-FS7. E
necessario montare un pacco batteria sull’unita XDCA-
FS7 oppure collegare un alimentatore esterno.

Se il livello di carica della batteria
diventa insufficiente

Se il livello di carica rimanente della batteria
scende al di sotto di un determinato valore
durante 1’utilizzo (stato Low BATT), viene
visualizzato il messaggio di batteria prossima
all’esaurimento, I’indicatore di registrazione
comincia a lampeggiare e viene emesso un
segnale acustico.

Se il livello di carica rimanente si abbassa oltre
fino a raggiungere un livello al quale &
impossibile continuare 1’ utilizzo dell’ apparecchio
(stato BATT Empty), viene visualizzato il
messaggio di batteria esaurita.

Sostituire il pacco batteria esaurito con uno
carico.

Modifica dei livelli di avviso

Per impostazione predefinita, il livello Low
BATT ¢ impostato al 10% della carica completa
della batteria, mentre il livello BATT Empty ¢
impostato sul 3%. E possibile modificare le
percentuali dei livelli di avviso con 1’opzione
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Camera Battery Alarm (pagina 103) del menu
System.

Alimentazione CA

Collegando il camcorder a una presa di corrente
elettrica, & possibile utilizzarlo senza doversi
preoccupare di ricaricare il pacco batteria.

Esempio di connessione: quando si collega BC-
U1A

Connettore DC IN

Alla presa di
corrente

Cavo di
alimentazione

Collegare 1’adattatore CA al connettore DC IN
del camcorder, quindi inserire la spina del cavo di
alimentazione (in dotazione) in una presa
elettrica. Impostare I’interruttore di selezione
della modalita del BC-U1A sulla posizione DC
OUT.

Se la tensione fornita dall’alimentatore
CA si abbassa

Se durante 1’utilizzo la tensione fornita
dall’alimentatore CA scende al di sotto di un
determinato valore (stato DC Low Voltagel),
viene visualizzato un messaggio che segnala
1’abbassamento della tensione dell’alimentatore,
I’indicatore di registrazione comincia a
lampeggiare e viene emesso un segnale acustico.
Se la tensione di uscita dell’adattatore CA scende
al di sotto di un valore che impedisce il
funzionamento corretto (stato DC Low
Voltage2), viene visualizzato un messaggio che



segnala che la tensione di uscita dell’adattatore
CA ¢ insufficiente.

In questo caso, I’adattatore CA pud essere
difettoso. Controllare 1’adattatore CA secondo il
caso.

Modifica dei livelli di avviso

Per impostazione predefinita, il livello DC Low
Voltagel ¢ impostato su 11,5 V e il livello DC
Low Voltage2 & impostato su 11,0 V. E possibile
modificare i valori dei livelli di avviso con
I’opzione Camera DC IN Alarm (pagina 103) del
menu System.

Adattatori CA

* Non collegare né utilizzare un adattatore CA in
uno spazio ristretto, ad esempio fra una parete e
un mobile.

* Collegare I’adattatore CA alla presa di corrente
pit vicina. In caso di problemi durante 1’uso,
estrarre immediatamente la spina dalla presa
elettrica.

« Non cortocircuitare le parti metalliche dello
spinotto dell’adattatore CA. Questo ne
causerebbe il guasto.

 La batteria non pud essere ricaricata mentre &
montata sul camcorder, anche se & connesso
I’adattatore CA.

Montaggio degli
accessori

Montaggio del portamicrofono
[ Note |

« Il portamicrofono & gia montato alla spedizione dalla
fabbrica.

* Montare e smontare il portamicrofono solo mentre il
camcorder & spento.

* Montare e rimuovere sempre il portamicrofono con il
coperchietto di protezione dell’attacco montato per
evitare possibili danni al sensore immagine.

1 Inserireil portamicrofono nella
maniglia.

2 Inserire il blocchetto nella sua sede e
stringere la vite per fissare il
portamicrofono.




Rimozione del portamicrofono

Rimuovere il blocchetto ed eseguire la procedura
di montaggio in ordine inverso.

Montaggio del mirino
[ Nota |

Montare e smontare il mirino solo mentre il camcorder &
spento.

1 Allentare il morsetto di bloccaggio del
mirino ed inserire il mirino nella
sporgenza sulla parte anteriore della
maniglia.

2 Regolare I’orientamento laterale del
mirino, stringere la ghiera di bloccaggio
e quindi connettere il mirino al
connettore del mirino del camcorder.

Controllare che il mirino sia saldamente fissato. Se il
morsetto non & stato correttamente serrato, & possibile
che il mirino possa cadere durante le riprese.

Regolazione dell’orientamento del
mirino.

Inclinare il mirino verso 1’alto o il basso fino ad
ottenere 1’angolazione desiderata.

E possibile orientare il mirino in modo che sia
rivolto verso il soggetto. Spostando il selettore
MIRROR (pagina 51) sulla posizione B/T, lo
schermo LCD visualizza un’immagine speculare.
L’immagine viene tuttavia registrata con
I’orientamento corretto.

Regolazione del contrasto del mirino

Ruotare la manopola CONTRAST per regolare il
contrasto.

E possibile regolare la luminosita utilizzando
I’opzione VF Setting >Brightness (pagina 86) del
menu VF.

Rimozione del mirino

Allentare il morsetto di bloccaggio del mirino e
ripetere la procedura di montaggio in senso
inverso.



Montaggio dell’oculare Apertura dell’oculare

[ Nota | Premere il pulsante indicato dalla freccia.

Montare e smontare I’oculare solo mentre il camcorder ¢
spento.

1 Agganciare i ganci di metallo
dell’oculare ai ganci di montaggio
dell’oculare sul mirino.

Al rilascio del blocco, aprire 1’oculare verso
I’alto. Quando I’oculare & aperto, il mirino rimane
visibile.

Ganci di montaggio oculare

2 Spingere la piastrina di bloccaggio
situata nella parte inferiore dell’oculare
in direzione della freccia per bloccare
I’oculare in posizione.

Rimozione dell’oculare

Sganciare il blocco dell’oculare e rimuovere
I’oculare del mirino.
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Montaggio dell’obiettivo

Obiettivi consigliati
SELP28135G
SEL1635Z
SELP18200

Per informazioni dettagliate sugli obiettivi
supportati dal camcorder, contattare il
rappresentante dell’assistenza tecnica Sony.

Non lasciare 1’obiettivo rivolto verso il sole. La
luce solare diretta condotta dalle ottiche
dell’obiettivo pud mettersi a fuoco all’interno del
camcorder e causare incendi.

* Montare e smontare 1’obiettivo solo mentre il
camcorder ¢ spento.

« Gli obiettivi sono componenti di elevata precisione.
Non appoggiare mai un obiettivo su una superficie con
il suo innesto rivolto verso il basso. Montare sempre il
coperchietto di protezione fornito.

Montaggio di un treppiede

Usare gli attacchi filettati di montaggio del

treppiede sul camcorder quando si monta un

treppiede. L’utilizzo dell’attacco treppiede

sull’obiettivo potrebbe causare danni.

Montaggio di un obiettivo con innesto E-
mount

1 Rimuoverei coperchietti di protezione
dal corpo del camcorder e
dall’obiettivo.
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2 Per montare P’obiettivo, allineare con il
camcorder I’indicatore (bianco)
sull’innesto dell’obiettivo, inserire con
attenzione I’obiettivo nell’innesto,
quindi ruotare I’obiettivo in senso
orario.

Quando I’obiettivo raggiunge la posizione
corretta, si percepira il clic di blocco.

Indicatore di allineamento (bianco)

Montaggio di un obiettivo con innesto A-
mount

Per poter montare un obiettivo con innesto A-
mount, & necessario montare prima 1’apposito
adattatore (opzionale).

¢ Quando si utilizza un obiettivo con innesto A-mount, il
diaframma & impostato su manuale.

* Quando la messa a fuoco & impostata su AF con un
obiettivo LA-EA2 o LA-EA4, il diaframma &
impostato su F3.5 o completamente aperto.

Rimozione dell’obiettivo

Per rimuovere 1’obiettivo, procedere come
descritto di seguito.

1 Mantenendo premuto il pulsante di
rilascio obiettivo, ruotare 1’obiettivo in
senso antiorario.

2 Estrarre obiettivo dal corpo
dell’apparecchio.

Se non viene montato immediatamente un altro
obiettivo, montare il coperchietto di protezione attacco
obiettivo sul lato concavo, ruotandolo in senso orario.



Regolazioni del diaframma con obiettivi
con selettore Auto Iris

¢ Quando il selettore Auto Iris dell’obiettivo ¢
impostato su AUTO, il diaframma viene
regolato automaticamente ma puo essere anche
regolato manualmente dal camcorder.

Quando il selettore Auto Iris ¢ impostato su
MANUAL, il diaframma puo essere regolato
solo usando la ghiera dell’obiettivo. Le
eventuali regolazioni dal camcorder non hanno
alcun effetto.

Regolazioni della messa a fuoco con
obiettivi con selettore di messa a fuoco

* Quando il selettore della messa a fuoco
dell’obiettivo ¢ impostato su AF/MF o AF, la
messa a fuoco viene regolata automaticamente
ma puo essere anche regolata manualmente dal
camcorder.

Quando il selettore della messa a fuoco
dell’obiettivo ¢ impostato su Full MF o MF, la
messa a fuoco pud essere eseguita solo usando
la ghiera dell’obiettivo. Le eventuali
regolazioni dal camcorder non hanno alcun
effetto.

Montaggio del telecomando 2 Collegare il cavo del telecomando
- dell’impugnatura al connettore
dell |mpugnatura REMOTE del camcorder.

Montare e smontare il telecomando dell’impugnatura
solo mentre il camcorder & spento.

1 Montare il braccetto nell’attacco
dell’impugnatura e stringere la vite.
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« Controllare che il braccetto e il telecomando
impugnatura siano saldamente fissati. Se le viti non
sono correttamente serrate, € possibile che possano
cadere durante le riprese.

» Non sostenere mai I’intero peso del camcorder
afferrandolo solo dal telecomando dell’impugnatura.

Regolazione della posizione del
telecomando dell’impugnatura.

Regolare 1’angolazione del braccio (@).
Allentare le due viti sulla parte posteriore del
braccio usando una moneta o un oggetto simile,
regolare la lunghezza del braccio (@), quindi
stringere le due viti.

Premere il pulsante di rotazione dell’impugnatura
(pagina 11) per regolare 1’angolazione del
telecomando dell’impugnatura (®)).

Smontaggio del telecomando
dell’impugnatura

1 Scollegare il cavo del telecomando
dell’impugnatura dal connettore
REMOTE del camcorder.

2 Rimuovere il braccio dal camcorder.

Impostazione
dell’orologio

Quando il camcorder viene acceso per la prima
volta o se la batteria di backup si & scaricata
completamente, nel mirino viene visualizzata la
schermata delle impostazioni iniziali.

Impostare la data e 1’ora dell’orologio interno in
questa schermata.

Time Zone

Time Zone imposta il fuso orario, ovvero la
differenza con 1’ora UTC (Coordinated Universal
Time). Impostare questo valore secondo il caso.

Impostazione di data e ora

Ruotare la manopola SEL/SET (pagina 9) per
selezionare voci e impostazioni, quindi premere
la manopola SEL/SET per applicare il valore
specificato ed avviare 1’orologio.

In seguito, dopo la chiusura della schermata di
impostazione, ¢ possibile modificare data, ora e
fuso orario servendosi dell’opzione Clock Set
(pagina 102) del menu System.

* Se le impostazioni di data e ora sono andate perse
perché la batteria di backup si & scaricata
completamente a seguito di un lungo periodo di tempo
in cui il camcorder & rimasto senza alimentazione
(senza pacco batteria o alimentazione DC IN), verra
nuovamente visualizzata la schermata delle
impostazioni iniziali quando si riaccende nuovamente
il camcorder.

Mentre ¢ visualizzata la schermata delle impostazioni
iniziali non & possibile eseguire alcuna operazione (ad
eccezione dello spegnimento) fino a quando non si
siano completate tutte le impostazioni di questa
schermata.

II camcorder ¢ dotato di una batteria ricaricabile
interna che consente la memorizzazione di data, ora e
altre impostazioni anche quando & spento. Per
informazioni dettagliate sulla batteria ricaricabile
interna, vedere pagina 110.



Configurazione delle
operazioni di base del
camcorder

Prima di iniziare le riprese, & necessario
configurare il funzionamento di base del
camcorder secondo I’applicazione specifica.

Modalita di ripresa

Sono disponibili due modalita di ripresa: la
modalita “Custom”, che consente la creazione
dell’immagine in sito con la massima flessibilita,
e la modalita “Cine EI”, in cui il camcorder viene
utilizzato in maniera analoga a una macchina
cinematografica, sviluppando poi le riprese in
sede di post produzione.

E possibile selezionare la modalita tramite Base
Setting (pagina 97) >Shooting Mode nel menu
System.

Color Space

Color Space seleziona lo spazio colore, ovvero la
gamma di colore di base dei segnali registrati e
dei segnali in uscita.

Quando la modalita di ripresa ¢ impostata su
Custom, Color Space ¢ impostato su “Matrix”.

Matrix: seleziona la gamma di colore con
I’'impostazione Matrix, simile alle
videocamere convenzionali.

Quando la modalita di ripresa ¢ impostata su Cine
EI Color Space seleziona la gamma colore
dell’uscita video con MLUT impostato su Off.

S-Gamut/SLog2: Gamma colore estesa, analoga a
quella degli apparecchi a pellicola.

S-Gamut3.Cine/SLog3: gamme di colore per il
cinema digitale di facile regolazione
(DCIP3).

S-Gamut3/SLog3: gamma colore allargata,
compatibile con le gamme standard future,
ottimizzata con la tecnologia di correzione
delle distorsioni dell’immagine Sony.

E possibile selezionare la gamma colore tramite
Base Setting (pagina 97) >Color Space nel menu
System.

Modalita di scansione del sensore
immagine

E possibile impostare la modalita di scansione del
sensore immagine.

E possibile selezionare la modalita tramite Base
Setting (pagina 97) >Imager Scan Mode nel
menu System.

Normal: se non si sta utilizzando la modalita Slow
& Quick Motion ad elevata frequenza di
fotogrammi, questa opzione esegue la
scansione sull’intero angolo di visuale del
formato Super 35mm.

Se S&Q Motion (pagina 91) >High Frame
Rate Mode nel menu Recording ¢ impostato
su “Full Scan” questa opzione esegue la
scansione sull’intero angolo di visuale del
formato Super 35mm e converte il segnale nel
formato dati 2K. Se ¢ impostato su “Center
Scan” esegue la scansione sull’angolo di
visuale 2K di mezzo formato Super 35mm al
centro dell’immagine.

2K Full: esegue la scansione sull’intero angolo di
visuale del formato Super 35mm e converte il
segnale nel formato dati 2K.

2K Center: esegue la scansione sull’angolo di
visuale 2K di mezzo formato Super 35mm al
centro dell’immagine.

Larisoluzione del formato di registrazione ¢ limitata a un
massimo di 2K quando la modalita Imager Scan
(pagina 98) & impostata su 2K Full o 2K Center.



Utilizzo di schede di
memoria XQD

Il camcorder registra audio e video su schede di
memoria XQD (vendute separatamente) inserite
negli appositi slot.

Informazioni sulle schede di
memoria XQD

Utilizzare con il camcorder le schede di memoria
XQD Sony elencate di seguito.

Per informazioni dettagliate sull’utilizzo
disupporti di memoria di altri fabbricanti, fare
riferimento alle relative istruzioni per 1’uso o
consultare le informazioni del fabbricante.

Schede di memoria XQD serie S

Schede di memoria XQD serie H
Schede di memoria XQD serie N
Schede di memoria XQD serie M
Schede di memoria XQD serie G

Non ¢ possibile garantire il corretto
funzionamento con schede di memoria diverse
dalle schede di memoria XQD Sony.

Per informazioni dettagliate sull’utilizzo e sulle
precauzioni per 'uso delle schede di memoria XQD,
fare riferimento alle istruzioni per ’uso fornite con
le schede di memoria XQD stesse.
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Supporti di memoria consigliati

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e Recording.
Si: Funzionamento supportato
No: il funzionamento corretto non & garantito.

Formato XQDb G XQD N Non piu in
XQD S XQD M vendita
(EB Stream) XQD H
XQD S
(non EB
Stream)
32/64/128 GB  32/64/128 *1 GB 16/32/64 GB
XAVC-I 4096x2160P — 59.94P Si No No
50P Si No No
29.97P Si No No
25P Si No No
24P Si No No
23.98P Si No No
3840x2160  — 59.94P Si No No
50P Si No No
29.97p Si No No
25P Si No No
23.98P Si No No
19201080  Modalita normale o  59.94P Si No No
S&Q (eccetto 59.94i Si Si No
HFR %) 50P Si No No
501 Si Si No
29.97P Si Si No
25P Si Si No
23.98P Si Si No
S&Q (modalita 59.94pP Si No No
HFR) 50P Si No No
29.97p Si No No
25P Si No No
23.98P Si No No
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Formato XQD G XQD N Non piu in

XQD S XQbM vendita
(EB Stream) XQD H
XQD S
(non EB
Stream)
32/64/128 GB  32/64/128 *1 GB 16/32/64 GB
XAVC-L 3840x2160  — 59.94pP Si Si No
50P Si Si No
29.97p Si Si No
25P Si Si No
23.98P Si Si No
19201080  Modalita normale o 59.94P Si Si Si
S&Q (eccetto HFR) 50P Si Si Si
59.94i Si Si Si
501 Si Si Si
29.97P Si Si Si
25P Si Si Si
23.98P Si Si Si
1920x1080  S&Q (modalita 59.94P Si Si No
HFR) 50P Si Si No
29.97p 50 Mbps: No
S 35 Mbﬁsz Si No
25P Si No No
23.98P Si No No
MPEG HD 1920x1080 - 59.94i Si Si Si
422 50i Si Si Si
29.97pP Si Si Si
25P Si Si Si
23.98P Si Si Si
1280x720 - 59.94P Si Si Si
50P Si Si Si
29.97P Si Si Si
25P Si Si Si
23.98P Si Si Si
ProRes 422 1920x1080 - 59.94i Si No No
HQ 50i Si No No
29.97P Si No No
25P Si No No
23.98P Si No No
ProRes 422 1920x1080 - 59.94i Si Si No
501 Si Si No
29.97pP Si Si No
25P Si Si No
23.98P Si Si No

*1 Solo serie M
*2 HFR: High Frame Rate
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Inserimento di una scheda di
memoria XQD

1 Premereil pulsante di rilascio del
coperchietto degli slot (pagina 10) per
aprirlo.

2 Inserire una scheda di memoria XQD
con P’etichetta XQD rivolta a sinistra.
L’indicatore di accesso (pagina 10) si
illumina di rosso, quindi diventa verde se la
scheda ¢ utilizzabile.

w

Chiudere il coperchietto.

La scheda di memoria, lo slot e i dati di immagine
contenuti sulla scheda potrebbero subire danni se la
scheda venisse forzata nello slot con 1’orientamento
errato.

Quando si registra su un supporto in entrambi gli slot
della scheda XQD A e B, inserire in entrambi gli slot il
supporto consigliato per I’'uso con il formato da
registrare.

Espulsione delle schede di
memoria XQD

Premere il pulsante di rilascio del coperchietto
degli slot (pagina 10) per aprirlo, quindi
esercitare una leggera pressione sulla scheda
stessa per espellerla.

Se il camcorder viene spento o la scheda viene rimossa
durante I’accesso alla scheda, non € possibile garantire
I’integrita dei dati contenuti sulla scheda. Tutti i dati
registrati sulla scheda potrebbero essere danneggiati.
Assicurarsi sempre che I’indicatore di accesso sia
illuminato in verde o spento prima di spegnere il
camcorder o rimuovere la scheda di memoria.

* Se si rimuove una scheda di memoria XQD
immediatamente dopo la registrazione, & possibile che
sia calda. Questo tuttavia non indica un problema.

Passaggio da una scheda di
memoria XQD all’altra

Se sono presenti schede di memoria XQD in
entrambi gli slot A e B, ¢ possibile passare da una
all’altra per la registrazione premendo il pulsante
SLOT SELECT (pagina 9).
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Se una scheda si riempie durante la registrazione,
il camcorder passa automaticamente all’altra
scheda.

11 pulsante SLOT SELECT ¢ disabilitato durante la
riproduzione. Non ¢ possibile alternare fra le schede
premendo il pulsante. Il pulsante ¢ abilitato mentre &
visualizzata la schermata delle miniature (pagina 59).

Formattazione (inizializzazione) di
schede di memoria XQD

Se viene inserita una scheda di memoria XQD
non formattata o formattata con altre specifiche, il
mirino visualizza il messaggio “Media Needs to
be Formatted”.

Formattare la scheda come descritto di seguito.

Selezionare Format Media (pagina 94)
>Media(A) o Media(B) nel menu Media,
quindi selezionare Execute. Quando viene
visualizzato un messaggio di conferma,
selezionare nuovamente Execute.

Durante la formattazione & visualizzato un
messaggio e I’indicatore di accesso si illumina di
rosso.

Al termine della formattazione, viene
visualizzato un messaggio per confermare che
I’operazione ¢ stata completata. Premere la
manopola SEL/SET per chiudere il messaggio.

Se la formattazione non riesce

Non ¢ possibile formattare schede di memoria
XQD protette o schede di memoria non
supportate dal camcorder.

Viene visualizzato un messaggio di avvertimento.
Seguire le istruzioni e sostituire la scheda con una
scheda di memoria XQD supportata.

La formattazione di una scheda di memoria elimina tutti
idati che contiene, comprese le registrazioni video e i file
di setup.

Controllo del tempo di
registrazione rimanente

Durante la ripresa (registrazione/standby), ¢
possibile monitorare la capacita rimanente sulla
scheda di memoria XQD di ciascuno slot
mediante gli indicatori di capacita degli slot A e
B visualizzati nel mirino (pagina 13).



1l tempo di registrazione rimanente ¢ calcolato
sulla base della capacita rimanente della scheda di
ciascuno slot e del formato video corrente (bit rate
di registrazione) ed ¢ indicato in minuti.

N . . . - 0
Se la scheda & protetta viene visualizzata I’icona ﬂoﬂ .

Tempi di sostituzione delle schede di
memoria XQD

¢ Quando il tempo di registrazione rimanente
totale sulle due schede scende al di sotto di 5
minuti, viene visualizzato il messaggio “Media
Near Full”, I’indicatore di registrazione
comincia a lampeggiare e viene emesso un
segnale acustico di avvertimento sull’uscita
cuffie. Sostituire con una scheda con spazio
libero sufficiente.

Se si prosegue con la registrazione fino a
esaurire completamente lo spazio disponibile,
appare il messaggio “Media Full” e la
registrazione si arresta.

Su una scheda di memoria XQD puo essere registrato un
massimo di 600 clip circa.

Se il numero di clip registrati raggiunge il limite
massimo, I’indicatore del tempo di registrazione
rimanente segnalera “0” e verra visualizzato il
messaggio “Media Full”.
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Utilizzo di una scheda
UTILITY SD

I dati di configurazione videocamera del
camcorder possono essere salvati su una scheda
SD (disponibile separatamente). E possibile
anche importare da una scheda SD i file di dati
precedentemente salvati in essa.

Schede SD supportate

Schede di memoria SDHC*
Schede di memoria SD*

* Indicate collettivamente come “schede SD” in questo
manuale.

Inserimento di una scheda SD

1 Premereil pulsante di rilascio del
coperchietto degli slot (pagina 10) per
aprirlo.

2 Inserire la scheda di memoria SD con
Petichetta SD rivolta a sinistra.

L’indicatore di accesso (pagina 10) si
illumina di rosso e quindi si spegne se la
scheda ¢ utilizzabile.

3 Chiudereil coperchietto.

Espulsione della scheda SD

Premere il pulsante di rilascio del
coperchietto degli slot (pagina 10) per
aprirlo, quindi esercitare una leggera
pressione sulla scheda SD per espellerla.

« Se il camcorder viene spento o la scheda SD viene
rimossa durante 1’accesso, non & possibile garantire
I’integrita dei dati contenuti su di essa. Tutti i dati
registrati sulla scheda potrebbero essere danneggiati.
Assicurarsi sempre che I’indicatore di accesso non sia
illuminato prima di spegnere il camcorder o rimuovere
la scheda SD.

Prestare attenzione per evitare che la scheda SD salti
fuori dal camcorder durante I’inserimento o
I’espulsione.



Formattazione (inizializzazione) di
schede SD

E necessario formattare le schede SD la prima
volta che vengono utilizzate nel camcorder.

Le schede SD da utilizzare con questo camcorder
dovrebbero essere formattate con la funzione di
formattazione di questo camcorder. Se viene
visualizzato un messaggio quando la scheda SD
viene inserita nel camcorder, formattare la scheda
SD.

Selezionare Format Media (pagina 94) >SD
Card nel menu Media, quindi selezionare
Execute. Quando viene visualizzato un
messaggio di conferma, selezionare
nuovamente Execute.

Durante la formattazione sono visualizzati un
messaggio e I’indicatore di avanzamento
dell’operazione. L’indicatore di accesso € inoltre
illuminato in rosso.

Al termine della formattazione, viene
visualizzato un messaggio per confermare che
I’operazione ¢ stata completata. Premere la
manopola SEL/SET per chiudere il messaggio.

La formattazione di una scheda SD elimina tutti i dati

presenti su di essa. La scheda non puo essere ripristinata.

Controllo della capacita
rimanente

E possibile controllare la capacita rimanente su
una scheda SD nella schermata Media Status
(pagina 17).

. Lo . m
Se la scheda SD ¢ protetta viene visualizzata I’icona Q .

Per utilizzare con un altro dispositivo una scheda
SD formattata con questo camcorder

Eseguire il backup di tutti i dati registrati sulla
scheda, quindi riformattare la scheda nel
dispositivo in cui deve essere utilizzata.

Utilizzo dell’unita di
estensione XDCA-FS7

Montando un’unita di estensione XDCA-FS7
(opzione), & possibile aggiungere al camcorder
ulteriori funzionalita, ad esempio una batteria V-
shoe o un segnale di sync esterno.

Montaggio dell’unita di
estensione XDCA-FS7

» Non ¢ possibile utilizzare il pacco batteria del
camcorder quando ¢ montata un’unita di estensione
XDCA-FS7. E necessario montare un pacco batteria
sull’unita XDCA-FS7 oppure collegare un
alimentatore esterno.

Montare e smontare 1’unita di estensione XDCA-FS7
solo mentre il camcorder & spento.

1 Rimuovereil pacco batteria (pagina 19)
montato sul camcorder.

2 Rimuovere il coperchio della sezione
connettore dell’unita di estensione.




3 Allineare le sporgenze dell’unita di 11 coperchietto della sezione di connessione

estensione XDCA-FS7 con le scanalature dell’unita di estensione puo essere inserito
di sinistra e destra del camcorder, quindi nella parte superiore dell’unita di estensione.
inserire completamente. Infine spingere
unita XDCA-FS7 verso il nell —

u. ta 'C S.veso basso nella §}//;
sezione di connessione. ‘

Scanalature Sporgenze - . S aas
Rimozione dell’'unita XDCA-FS7
4 Assicurare in posizione I’unita XDCA- Allentare le due viti sulla parte superiore
FS7 stringendo le due viti presenti sulla dell’unita XDCA-FS7 per rimuoverla dal
parte superiore dell’unita stessa. camcorder.

Montaggio del pacco batteria

Inserire il pacco batteria nell’apposito
alloggiamento sull’unita XDCA-FS7.
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Rimozione del pacco batteria
Estrarre il pacco batteria dal suo alloggiamento

sull’unita XDCA-FS7 mantenendo premuto allo
stesso tempo il pulsante BATT RELEASE.

Commutazione entrata/uscita del
codice temporale

1l selettore TC IN/OUT (pagina 12) consente di

commutare 1’entrata/uscita del codice temporale.

Per informazioni dettagliate, vedere pagina 108.
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Utilizzo di un’unita di
interfaccia HXR-IFR5 e di
un registratore AXS-R5

E possibile registrare video RAW (pagina 54) su
un registratore RAW AXS-R5 (opzione)
utilizzando un’unita di interfaccia HXR-IFRS
(opzione) e un’unita di estensione XDCA-FS7
(opzione).

Per informazioni dettagliate su come configurare
le unita HXR-IFRS5 e AXS-RS5, fare riferimento al
manuale di istruzioni dell’unita di interfaccia
HXR-IFRS.

Connessione dell’unita di
interfaccia HXR-IFR5 al
camcorder

1 Montare P'unita di estensione
XDCA-FS7 sul camcorder (pagina 33).

2 Collegare il connettore RAW OUT
dell’unita XDCA-FS7 al connettore SDI
IN (RAW) dell’unita HXR-IFR5
mediante un cavetto SDI.

HXR-IFR5

Rimozione dell’unita di
interfaccia HXR-IFR5

Scollegare il cavo SDI dal connettore RAW
OUT dell’unita XDCA-FS7.



Utilizzo del telecomando
a infrarossi

Utilizzo per la prima volta

Estrarre la pellicola di isolamento dal vano
batteria la prima volta che si utilizza il
telecomando ad infrarossi fornito.

Pellicola di isolamento

1

o

Al momento della spedizione, il vano batteria
contiene una batteria al litio CR2025.

Utilizzo del camcorder con il
telecomando

Per utilizzare il telecomando, accendere il
camcorder e quindi abilitare il funzionamento con
telecomando.

Abilitare/disabilitare la funzione di comando a
distanza mediante il menu di configurazione.

Abilitazione mediante il menu

Premere il pulsante MENU per attivare la
modalitd menu del camcorder, quindi impostare
IR Remote (pagina 103) nel menu System su On.

Dirigere il telecomando verso il sensore di ricezione
del telecomando del camcorder.

Collocare il camcorder in modo che il sensore di
ricezione del telecomando non sia esposto alla luce
diretta proveniente dal sole o da altre intense sorgenti
di illuminazione. L’esposizione a luci intense pud
impedire il funzionamento corretto tramite
telecomando.

Durante I’uso con il camcorder, il telecomando fornito
in dotazione potrebbe azionare erroneamente anche
altri deck video. In tal caso, spostare il selettore di
modalita telecomando del deck video su DVD2 oppure
coprirne il sensore di ricezione con carta nera.
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Sostituzione della batteria del
telecomando

11 telecomando utilizza una normale batteria
CR2025.
Utilizzare esclusivamente batterie tipo CR2025.

1 Spingere la linguetta e rimuovere il
portabatteria inserendo un’unghia
nella scanalatura.

2 Inserire la nuova batteria con il lato +
rivolto verso ’alto.

3 Reinserire il portabatteria fino allo
scatto in posizione.

D)
Linguetta 3@ S~

Non conservare i pacchi batteria in luoghi esposti
alla luce solare diretta o a fiamme libere, oppure
in cui siano presenti elevate temperature

La sostituzione della batteria con un’altra di tipo non
raccomandato potrebbe causare il guasto del dispositivo.
Sostituire sempre con il tipo di batteria specificato.
Smaltire le batterie usate in conformita con le normative
nazionali e locali.



Schermata Playback

Utilizzo del telecomando e
Wi' Fi riproduzione

Play/Pause, Stop, F
Fwd, F Rev, Next, Prev

E possibile azionare il camcorder da un browser Assign , Maln
web collegando al camcorder tramite una rete
LAN wireless uno smartphone, un tablet o un -

F Rev Play/Pause

altro dispositivo che consente 1’utilizzo di un
browser web. Questa funzione & denominata
telecomando Wi-Fi.

Questa funzione ¢ utile nelle applicazioni in cui il
camcorder ¢ fissato in una posizione difficile da
raggiungere, ad esempio se & montato su un
braccio aereo.

Per informazioni dettagliate sulla procedura di
configurazione della funzione di telecomando
Wi-Fi, vedere pagina 58.

L] n >
prev stop Next

Schermata Cursor

Stato

Pulsanti cursore

Su, Giu, Sinistra,
Destra, Set, Cancel/
Back, Menu, Status,
Thumbnail, User

Schermata di Wi-Fi Remote (smartphone)

Schermata Main

Assign  Main Playback _Curso
Menu
Camera Control ¢, x * Impostazioni
) S&Q FPS, Shutter,
23:01:52:29 = White, Sensitivity/
. Gain/Exposure Index,
[ > Gamma, MLUT, Color
Assign _ Main _Playback Cursor Bars, Auto Black,
Auto White, Rec Start/
Stop, Lock, Iris, Focus,
Zoom, Auto Iris, Auto
Shutter, AGC, ATW
Schermata Assign
Camera Control M Stal()
 Pulsanti
programmabili
Pulsanti

programmabilida 1 a6

Main Playback Cursor

Auto Black
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Schermata di Wi-Fi Remote (tablet)
Schermata Main

Camera Control

23:01:52:20 ==i==

Playback ~ Cursor

Auto Black

Impostazioni

S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure
Index, Gamma, MLUT, Color Bars, Auto Black, Auto
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto
Iris, Auto Shutter, AGC, ATW

Schermata Playback
Control

23:01:52:29

* Stato
« Pulsanti di comando riproduzione
Play/Pause, Stop, F Fwd, F Rev, Next, Prev
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Schermata Cursor

Camera Control . Lock—~

O omin

CIN 12,0

23:0 0% 2160

Assign

--

-

Thumbnail

« Stato

* Pulsanti cursore
Up, Down, Left, Right, Set, Cancel/Back, Menu,
Status, Thumbnail, User Menu

Schermata Assign

Camera Control . Lock—

oCIN120V

23:01:52:29

« Stato

* Pulsanti programmabili
Pulsanti programmabilida 1 a 6



Operazioni di base

Di seguito si descrive la procedura per eseguire
una semplice ripresa di base.

1 Montarei dispositivi necessari e
controllare che I’alimentazione sia
presente.

2 Inserire almeno una scheda di
memoria.

3 Spostare I’interruttore POWER su ON.

L’immagine della videocamera appare nel
mirino.

4 Premereil pulsante di registrazione
(pagina 7).
L’indicatore di registrazione si illumina e il
camcorder inizia la registrazione.

5 Per arrestare la registrazione premere
nuovamente il pulsante di registrazione.

La registrazione si arresta e il camcorder
entra in modalita STBY (standby).

Se si preme il pulsante di registrazione entro pochi
secondi successivi all’accensione del camcorder,
I’indicatore di registrazione si illumina per indicare che
I’unita ¢ in stato di registrazione, ma, a seconda del
formato di registrazione selezionato, potrebbe non
avvenire alcuna registrazione sul supporto durante i
primi secondi.

Ripresa (modalita Full Auto)

Premere il pulsante FULL AUTO. L’indicatore
del pulsante si illumina.

Le funzioni di diaframma automatico (per gli
obiettivi compatibili), AGC, otturatore
automatico, ATW (tracciamento automatico del
bilanciamento del bianco) sono attivate per
controllare automaticamente luminosita e
bilanciamento del bianco (modalita
completamente automatica).

Per regolare manualmente ciascuna funzione,
disattivare la modalita Full Auto.
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Registrazione continua durante la
sostituzione di schede di memoria
(Relay Rec)

Quando sono presenti schede di memoria in
entrambi gli slot A e B, la registrazione passa
automaticamente alla seconda scheda di memoria
poco prima che la capacita rimanente sulla prima
scheda si esaurisca.

* Non espellere una scheda di memoria mentre & in corso
la registrazione su di essa. Sostituire schede di
memoria solo negli slot il cui indicatore di accesso non
¢ illuminato.
Quando la capacita rimanente sulla scheda di memoria
su cui viene eseguita la registrazione diventa inferiore
aun minuto ed & presente una scheda di memoria
registrabile nell’altro slot, viene visualizzato il
messaggio “Will Switch Slots Soon”. Il messaggio
scompare dopo il passaggio all’altro slot.
La registrazione relay puod non essere possibile se la
registrazione viene avviata quando la capacita
rimanente della scheda di memoria ¢ inferiore a un
minuto. Per consentire il funzionamento corretto della
registrazione relay, controllare che la capacita
rimanente sulla scheda di memoria sia superiore a un
minuto prima di iniziare la registrazione.
I video creati con la funzione di registrazione relay del
camcorder non possono essere riprodotti senza
interruzione sul camcorder.
* Per unire insieme video creato con la funzione di
registrazione relay del camcorder, utilizzare il
software Catalyst Browse.

Registrazione simultanea sulle schede
di memoria A e B (Simul Rec)

E possibile registrare simultaneamente su
entrambe le schede memoria A e B.

Configurare Simul Rec >Setting nel menu
Recording su “On”.

La registrazione simultanea non ¢ supportata nella
modalita Slow & Quick Motion (pagina 91) né nella
modalita di registrazione Picture Cache (pagina 92).
Inoltre, la registrazione simultanea non & supportata per
i formati di registrazione elencati di seguito (pagina 98).



NTSC Area
XAVC-1
4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 24.00P, 4096 x 2160 23.98P,
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P
XAVC-L
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P
RAW (quando sono connessi unita di estensione
XDCA-FS7, unita di interfaccia HXR-IFRS e
registratore AXS-R5)
4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 23.98P, 2048 x 1080 59.94P,

Quando i pulsanti sono impostati per comandare
la registrazione su schede di memoria diverse,
SDI/HDMI Rec Control e RAW Rec Control
seguono lo stato di registrazione dello slot A.

Per modificare I'impostazione

Selezionare Simul Rec >Rec Button Set nel
menu Recording.

Rec Button Set Pulsanti e schede di
memoria

2048 x 1080 29.97P, 2048 x 1080 23.98P “Rec Button Avvia/arresta la registrazione
RAW & XAVC-I (quando sono connessi unita di [SlotA SlotB] simultanea su entrambe le schede
estensione XDCA-FS7, unita di interfaccia Handle Rec di memoria A e B premendo uno
HXR-IFRS e registratore AXS-RS) Button [SlotA qualsiasi dei pulsanti.
4096 x 2160 59.94P, 2048 x 1080 59.9{P SlotB]”
ﬁ:ﬁ;ﬂ;ﬁf:&iggiﬁi gf_ 1(:157) e “Rec Button 1l pulsante START/STOP avvia/
1920 x 1080 59.94i, 1920 x 1080 29.97P, [SlotA] Handle arresta la registrazione sulla
1920 x 1080 23.98P Rec Button scheda di memoria A mentre il
[SlotB]” pulsante START/STOP della
PAL Area maniglia avvia/arresta la
XAVC-I registrazione sulla scheda di
4096 x 2160 50P, 4096 x 2160 25P, memoria B.
3840 x 2160 50P, 3840 x 2160 25P, “Rec Button 11 pulsante START/STOP avvia/
1920 x 1080 50P [SlotB] Handle arresta la registrazione sulla
XAVC-L Rec Button scheda di memoria B mentre il
3840 > 2160 S0P, 3840 x 2160 25P [SlotA]” pulsante START/STOP della

RAW (quando sono connessi unita di estensione
XDCA-FS7, unita di interfaccia HXR-IFRS e
registratore AXS-R5)

4096 x 2160 50P, 4096 x 2160 25P,

2048 x 1080 50P, 2048 x 1080 25P

RAW & XAVC-I (quando sono connessi unita di
estensione XDCA-FS7, unita di interfaccia
HXR-IFRS e registratore AXS-R5)

4096 x 2160 50P, 2048 x 1080 50P

ProRes 422 HQ, ProRes 422 (quando & connessa
I’unita di estensione XDCA-FS7)

1920 x 1080 50i, 1920 x 1080 25P

Modifica delle impostazioni dei pulsanti
START/STOP di registrazione del
camcorder e della maniglia

Quando la funzione di registrazione simultanea
(Simul Rec) ¢ abilitata, & possibile avviare ed
arrestare la registrazione su ciascuna scheda di
memoria indipendentemente utilizzando i
pulsanti di START/STOP registrazione del
camcorder e della maniglia.
Per impostazione predefinita, entrambi i pulsanti
sono impostati per avviare/arrestare la
registrazione simultaneamente su entrambe le
schede memoria A e B.
¢ “Rec Button [SlotA SlotB] Handle Rec Button
[SlotA SlotB]”
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maniglia avvia/arresta la
registrazione sulla scheda di
memoria A.

Regolazione automatica della
messa a fuoco

E necessario che sia montato un obiettivo che
supporta la funzione di messa a fuoco automatica.
Spostare il selettore FOCUS (pagina 9) del
camcorder sulla posizione “AUTO”. Se
I’obiettivo ¢ dotato di un selettore di messa a
fuoco, spostarlo nella posizione “AF/MF” o
“AF”. Se il selettore si trova nelle posizioni “Full
MEF” o “MF” non ¢ possibile eseguire la messa a
fuoco dal camcorder (pagina 25).

L’adattatore opzionale LA-EA1/3 consente solo la
modalita Push Auto Focus.

Impostazione della zona di messa a
fuoco automatica (Focus Area)

E possibile impostare la zona di rilevamento per
la messa a fuoco automatica mediante la voce



Focus >Focus Area (pagina 68) del menu
Camera.

L’adattatore opzionale LA-EA2/4 non consente
I’impostazione della posizione.

Sospensione momentanea della messaa
fuoco automatica (Focus Hold)

Premere il pulsante PUSH AUTO FOCUS
(pagina 9) mentre il camcorder si trova in
modalita di messa a fuoco automatica per
sospendere la messa a fuoco automatica.

Questa capacita ¢ utile, ad esempio, quando
qualcosa attraversa la zona di ripresa fra il
soggetto e il camcorder e non si desidera che sia
messo a fuoco, oppure quando la messa a fuoco
automatica viene perduta.

Regolazione manuale della
messa a fuoco

Per regolare manualmente la messa a fuoco,
spostare il selettore FOCUS (pagina 9) su
“MAN”.
Questo consente di regolare la messa a fuoco
manualmente secondo le condizioni di ripresa.
La messa a fuoco manuale ¢ utile per le seguenti
tipologie di soggetti:
- Soggetti sull’altro lato di una finestra coperta
di goccioline d’acqua
- Soggetti con un basso contrasto rispetto allo
sfondo
- Soggetti piu lontani in presenza di soggetti
vicini

Regolazione rapida della messa a fuoco
in modalita manuale (Push Auto Focus)

Posizionare il soggetto da mettere a fuoco al
centro dell’immagine, quindi premere il pulsante
PUSH AUTO FOCUS (pagina 9).

La messa a fuoco ritorna all’impostazione
precedente non appena si rilascia il pulsante.
Questa capacita ¢ utile quando si desidera mettere
a fuoco rapidamente il soggetto prima di avviare
la ripresa.

E possibile impostare la posizione per la messa a
fuoco mediante la voce Focus >Focus Area (Push
AF) (pagina 69) del menu Camera.
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* La funzione Push Auto Focus non ¢ attiva se
I’obiettivo & impostato per la messa a fuoco manuale.

* Durante I’utilizzo della funzione Push Auto Focus con
un obiettivo LA-EA2/4, 1a modalita Full Auto & On.

* Durante I’ingrandimento della messa a fuoco, la messa
a fuoco si adatta alla posizione di visualizzazione
ingrandita.

Indicatore di messa a fuoco

Indica lo stato della messa a fuoco

¢ (Illuminato): Soggetto a fuoco.

» (Lampeggiante): Soggetto non a fuoco. Dato
che la messa a fuoco non ¢ automatica,
cambiare la composizione e le impostazioni di
messa a fuoco per mettere a fuoco il soggetto.

Messa a fuoco con vista ingrandita
(Focus Magnifier)

Per impostazione predefinita, la funzione Focus
Magnifier x4/x8 ¢ assegnata al pulsante
ASSIGN4 del telecomando dell’impugnatura
(pagina 47).

Premere il pulsante ASSIGN4.

Viene visualizzata la schermata Focus Magnifier,
con il centro ingrandito di circa quattro volte.
Premere nuovamente il pulsante per aumentare
I’ingrandimento a circa otto volte. Questa
funzione ¢ utile per controllare la messa a fuoco.
Premere nuovamente il pulsante per tornare alla
schermata normale.

Durante I’ingrandimento della messa a fuoco, &
possibile spostare la zona ingrandita mediante il
multiselettore. Premere il multiselettore per
tornare al centro dell’immagine. E possibile
spostare la posizione anche mediante i pulsanti
destro e sinistro e la manopola SEL/SET del
camcorder, il telecomando a infrarossi o il
telecomando Wi-Fi Remote.

Se viene utilizzata la funzione Push Auto Focus
durante I’ingrandimento della messa a fuoco, la
messa a fuoco si adatta alla posizione di
visualizzazione ingrandita.

 L’ingrandimento della messa a fuoco non ingrandisce
I’'immagine registrata né I’immagine fornita sull’ uscita
SDI/HDMI.

¢ Durante I’ingrandimento della messa a fuoco, il
pulsante STATUS CHECK e i pulsanti di menu non
sono attivi.

* La posizione di messa a fuoco viene annullata allo
spegnimento del camcorder. Alla riaccensione del
camcorder, quando si apre la schermata di



ingrandimento della messa a fuoco la posizione di
ingrandimento torna al centro dell’immagine.

Regolazione della messa a fuoco con
I'ausilio dell’indicatore focus assist

Riquadro del campo di rilevamento della
messa a fuoco
(Indicatore della zona di messa a fuoco)

-T-:I

Indicatore Focus Assist di
assistenza alla messa a fuoco

La posizione di messa a fuoco corretta € indicata
dalla massima lunghezza della barra. Regolare la
messa a fuoco fino a raggiungere la massima
lunghezza della barra.

A fuoco: massima %
lunghezza raggiunta

dalla barra

Nelle riprese di soggetti con superfici uniformi e senza
variazioni oppure nelle riprese in condizioni di scarsa
illuminazione, la lunghezza dell’indicatore di messa a
fuoco pud non variare o variare molto poco.

Non ¢ possibile impostare il campo di rilevamento.

Monitoraggio audio

L’audio registrato pud essere monitorato tramite
le cuffie.

Collegando delle cuffie al relativo connettore
(pagina 10) & possibile monitorare I’audio
durante la registrazione. L audio di riproduzione
(pagina 60) puod essere monitorato sia tramite
I’altoparlante incorporato (pagina 10) che le
cuffie.

E possibile selezionare il canale audio da
monitorare e regolare il volume con I’opzione
Audio Output (pagina 82) del menu Audio.

Passaggio da una scheda di
memoria XQD all’altra

Quando sono inserite due schede di memoria
XQD, premere il pulsante SLOT SELECT
(pagina 9) per passare da una scheda all’altra.

Non ¢& possibile passare da una scheda all’altra durante la
riproduzione. Non ¢ inoltre possibile la riproduzione
continuata di un clip che si estende su entrambe le schede
di memoria dei due slot A e B.

Clip (dati registrati)

Quando si arresta la registrazione, il video,
I’audio e i dati accessori dall’inizio alla fine
della registrazione vengono salvati come un
unico “clip” sulla scheda di memoria XQD.

Nome dei clip

Ai clip registrati dal camcorder viene
automaticamente assegnato un nome composto
dalla parola “Clip” e da un numero di 4 cifre. 11
numero di 4 cifre ¢ incrementato
automaticamente ad ogni registrazione.

Per modificare il prefisso “Clip”, utilizzare la
voce Clip del menu Media.

Durata massima dei clip

Fino a 6 ore per clip.

Nella funzione di registrazione relay, vengono
registrati pill clip in successione 1’'uno dopo
I’altro. Tuttavia la registrazione si arresta
automaticamente dopo circo 13 ore.




Modifica delle
impostazioni di base

E possibile modificare le impostazioni in base
all’applicazione o alle condizioni di
registrazione.

Selezione della modalita di
registrazione

I formati disponibili e selezionabili variano a
seconda del paese di utilizzo e del codec
specificato.

Selezionare un formato tramite 1’opzione Rec
Format >Video Format nel menu System.

Regolazione della luminosita

E possibile regolare la luminosita variando
opportunamente i valori di diaframma, guadagno,
velocita dell’otturatore, nonché regolando il
livello di luce mediante i filtri ND.

Per regolare la luminosita senza utilizzare filtri
ND, disattivare la modalita Full Auto

(pagina 39).

E possibile regolare il livello di controllo della
luminosita servendosi del menu di
configurazione.

Regolazione del livello di controllo

Impostare il livello mediante 1’opzione Auto
Exposure (pagina 67) >Level del menu Camera.

Non ¢ possibile regolare automaticamente la luminosita
nella modalita Cine EI.

Regolazione automatica del diaframma

Questa funzione regola la luminosita in base al
soggetto. E necessario che sia montato un
obiettivo che supporta la funzione di regolazione
automatica del diaframma.

1 Se ¢ montato un obiettivo con selettore
Auto Iris, impostarlo su AUTO.
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2 Premereil pulsante IRIS (pagina 47)
per attivare la modalita Auto Iris.
La funzione viene attivata o disattivata ad
ogni pressione del pulsante IRIS.

11 diaframma non puo essere regolato
automaticamente su un obiettivo con innesto A-
mount.

Regolazione manuale del diaframma

Premere il pulsante IRIS per disattivare la
funzione Auto Iris, quindi regolare
utilizzando la manopola IRIS.

E possibile anche assegnare la funzione IRIS a
una manopola programmabile (pagina 47).

Regolazione automatica temporanea del
diaframma

Mantenere premuto il pulsante PUSH AUTO
IRIS per attivare momentaneamente la funzione
di regolazione automatica del diaframma.

Il diaframma ritorna all’impostazione precedente
non appena si rilascia il pulsante.

Se il selettore Auto Iris dell’obiettivo ¢ impostato su
“MANUAL?”, le funzioni Auto Iris e Push Auto Iris del
camcorder non hanno effetto. Non hanno effetto
nemmeno le regolazioni manuali del diaframma sul
camcorder.

Regolazione automatica del guadagno

Premere il pulsante ISO/Gain (pagina 9) per
attivare la funzione AGC.

Oppure, selezionare Auto Exposure (pagina 67)
>AGC nel menu Camera e impostare su “On”.

Regolazione manuale del guadagno

La regolazione del guadagno ¢ utile per regolare
I’esposizione mentre si utilizza un valore di
diaframma fisso oppure se si desidera evitare
I’aumento del guadagno generato dalla funzione
AGC.

1 Premereil pulsante ISO/Gain
(pagina 9) per disattivare la funzione
AGC.

2 Spostare il selettore GAIN (pagina 9) su
H,MolL.



Regolazione fine del guadagno

Ruotare la manopola IRIS o la manopola
programmabile a cui ¢ assegnata la funzione ISO/
Gain/EI per regolare il valore di guadagno
impostato dal selettore GAIN.

Questa funzione ¢ utile se si desidera correggere
I’esposizione di un passo senza tuttavia
modificare la profondita di campo.

Per annullare il valore di guadagno modificato,
spostare il selettore GAIN o riattivare la funzione
AGC.

Riprese con otturatore automatico

Questa funzione regola la velocita dell’ otturatore
automaticamente in risposta alla luminosita
dell’immagine.

Premere il pulsante SHUTTER (pagina 9).

Se era visualizzata la schermata delle
impostazioni, premere nuovamente il pulsante.
Oppure impostare Auto Exposure (pagina 67)
>Auto Shutter nel menu Camera su On.

Riprese con otturatore fisso

E possibile eseguire riprese con una velocita di
otturatore fissa.

Premere il pulsante SHUTTER per visualizzare
una schermata con i valori di otturatore
disponibili, quindi selezionare ed impostare il
valore desiderato mediante la manopola SEL/
SET. Se si preme nuovamente il pulsante
SHUTTER invece della manopola SEL/SET,
viene attivata la funzione di otturatore
automatico.

Impostazione nel menu Camera
Selezionare Shutter (pagina 70) nel menu
Camera e scegliere la modalita e la velocita
otturatore desiderate.

Regolazione del livello di luce (filtro ND)

In condizioni di illuminazione troppo intensa, &
possibile ottenere la luminosita corretta
utilizzando un filtro ND.

Ruotare la manopola ND FILTER (pagina 9) per
selezionare in sequenza Clear — 1/4 — 1/16 —
1/64 — Clear.
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Come ottenere colori naturali
(bilanciamento del bianco)

E possibile selezionare la modalita di regolazione
piu adatta per le condizioni di ripresa.

Modalita ATW (bilanciamento
automatico del bianco)

Questa funzione regola automaticamente il
bilanciamento del bianco a un livello ottimale.

1l valore di bilanciamento del bianco viene
automaticamente regolato quando cambia la
temperatura di colore della sorgente luminosa.
Premere il pulsante WHT BAL (pagina 9) per
attivare o disattivare la funzione ATW.

E possibile selezionare la velocita di regolazione
(cinque livelli) con 1’opzione White >ATW
Speed (pagina 73) del menu Paint.

E possibile “congelare” il valore di bilanciamento
del bianco corrente assegnando la funzione ATW
Hold a un pulsante programmabile (pagina 47) e
premendo tale pulsante per sospendere
temporaneamente la modalita ATW.

* La funzione ATW non ¢& utilizzabile in modalita Cine
EL
* A seconda delle condizioni di illuminazione e del
soggetto, la funzione ATW pud non essere in grado di
ottimizzare sempre il colore.
Esempi:
- Quando il soggetto ¢ dominato da un unico colore,
ad esempio cielo, mare, prati o fiori.
- Quando la temperatura di colore & estremamente
alta o bassa.
Se non & possibile ottenere 1’effetto opportuno
perché la velocita di regolazione automatica ATW
¢ insufficiente o per altri motivi, eseguire la
funzione di bilanciamento automatico del bianco.

Regolazione manuale del bilanciamento
del bianco

1 Disattivare la modalita Full Auto
(pagina 39).

2 Quando il bilanciamento del bianco ¢
impostato sulla modalita ATW,
premere il pulsante WHT BAL
(pagina 9) per impostare la modalita
manuale.



3 Selezionare B, A 0 PRESET con il

selettore WHT BAL (pagina 9).

B: Modalita memoria B *

A: modalita memoria A
PRESET: modalita predefinita

* B pud essere assegnato a ATW ON.

Modalita predefinita

Questa modalita regola la temperatura di colore
su un valore preimpostato (valore predefinito:
3200K).

Modalita memoria A / memoria B

Questa modalita imposta il bilanciamento del
bianco sul valore salvato rispettivamente nella
memoria A o B.

Le impostazioni del selettore WHT BAL in modalita
Cine EI sono fissate come indicato di seguito.

B: 5500K
A: 4300K
PRESET: 3200K

Esecuzione del hilanciamento
automatico del bianco

1

Premere il pulsante ISO/Gain
(pagina 9) per attivare la funzione
AGC.

Oppure, selezionare Auto Exposure
(pagina 67) >AGC nel menu Camera e
impostare su “On”.

Per salvare un valore di regolazione in
memoria, selezionare la modalita
memoria A o la modalita memoria B.

Collocare un foglio o un altro oggetto
bianco in una posizione con la stessa
sorgente di luce e le stesse condizioni di
illuminazione del soggetto, quindi
zoomare sul foglio fino a riempire lo
schermo di bianco.

Regolare la luminosita.

Regolare il diaframma servendosi della
procedura descritta in “Regolazione manuale
del diaframma” (pagina 43).

Premere il pulsante WB SET (pagina 7).

Se il valore di bilanciamento automatico del
bianco & impostato sulla modalita di
memoria, il valore di regolazione viene

salvato nella memoria A o B selezionata al
punto 2.

Se il valore di bilanciamento automatico del
bianco ¢ impostato sulla modalita ATW, la
regolazione del bilanciamento del bianco
torna alla modalita di bilanciamento del
bianco ATW al termine della regolazione.

1l bilanciamento automatico del bianco non puo essere
eseguito in modalita Cine EI

Se la regolazione non puo essere eseguita
correttamente, viene visualizzato un messaggio di
errore sullo schermo per circa tre secondi. Se il
messaggio di errore persiste anche dopo ripetuti
tentativi di impostazione del bilanciamento del bianco,
rivolgersi al servizio di assistenza tecnica Sony.

Impostazione dell’audio da
registrare

E possibile specificare I’audio da registrare
scegliendo opportunamente i connettori di
ingresso e utilizzando i selettori e le manopole del
camcorder.

Connettori e selettori di ingresso audio esterno
Connettore INPUT1 (pagina 10)

Connettore INPUT?2 (pagina 10)

Selettore INPUT1 (LINE/MIC/MIC+48V)
(pagina 7)

Selettore INPUT2 (LINE/MIC/MIC+48V)
(pagina 7)

Selettori per 'impostazione del livello audio
Selettore CHI LEVEL CONTROL (pagina 9)
Selettore CH2 LEVEL CONTROL (pagina 9)
Manopola CH1 INPUT LEVEL (pagina 9)
Manopola CH2 INPUT LEVEL (pagina 9)

Selezione del dispositivo di ingresso
audio

1 Selezionare il connettore di ingresso
audio

Selezionare I’ingresso audio mediante le voci
Audio Input >CHI Input Select o CH2 Input
Select del menu Audio.

Impostare su INPUT1 o INPUT2 a seconda
del connettore a cui € connesso il dispositivo.
Se si utilizza un microfono con connessione
a slitta o adattatore XLR, specificare Shoe 1
o Shoe 2 in maniera analoga. Per
informazioni dettagliate sull’ adattatore XLR,



vedere “Aggiunta di connettori di ingresso
audio” (pagina 55).

Il camcorder ¢ dotato di un microfono interno. Pur
non essendo adeguato per la produzione dell’audio
finale, puo essere utilizzato per la sincronizzazione
con altre apparecchiature. In tal caso, specificare
Internal MIC.

2 Selezionare la sorgente di ingresso
audio
Impostare i selettori INPUT1/INPUT2
(LINE/MIC/MIC+48V) in base ai dispositivi
connessi rispettivamente ai connettori
INPUT1/INPUT?2.

Dispositivo collegato Posizione

selettore
Sorgente audio esterna (ad LINE
es. mixer)
Microfono dinamico, MIC
microfono a batteria
Microfono con MIC+48V

alimentazione phantom
+48 V

¢ Se si seleziona “MIC+48V”, assicurarsi
che il microfono connesso sia compatibile
con una sorgente a +48 V per evitare di
danneggiarlo. Controllare questa
impostazione prima di procedere con il
collegamento.

In caso di problemi di rumore sui
connettori ai quali non & connesso nessun
dispositivo, impostare su “LINE” il
selettore INPUT1/INPUT2 (LINE/MIC/
MIC+48V) corrispondente.

Regolazione automatica del livello di
registrazione audio

Spostare i selettori CHI/CH2 LEVEL
CONTROL dei canali da regolare
automaticamente su “AUTO”.

Per CH3/CH4, impostare Audio Input >CH3
Level Control e CH4 Level Control nel menu
Audio su “Auto” (pagina 80).
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Regolazione manuale del livello di
registrazione audio

La seguente procedura consente di regolare il
livello di registrazione audio per i canali CH1/
CH2.

1 Impostare i connettori CH1/CH2
LEVEL CONTROL dei canali da
regolare manualmente su “MAN”.

2 Durantela ripresa o lo standby, ruotare
le manopole INPUT LEVEL (CH1)/
(CH2) per regolare il livello audio del
canale corrispondente.

E possibile regolare il livello di registrazione
tramite la manopola programmabile
(pagina 47), se precedentemente assegnata
alla funzione Audio Input Level oppure
mediante il menu di configurazione.

Per CH3/CH4, impostare Audio Input >CH3
Level Control e CH4 Level Control nel menu
Audio su “Manual”, quindi impostare il
livello di registrazione audio in CH3 Input
Level e CH4 Input Level (pagina 80).

Con determinate combinazioni di impostazioni
del menu Audio, I’'impostazione Audio Input
Level potrebbe essere disabilitata. Per
informazioni dettagliate, vedere il diagramma a
pagina 138.

Se Audio Input >CHI1 Input Select oppure CH2
Input Select nel menu Audio sono impostati su
“Internal MIC”, CH2 viene commutato su
automatico/manuale seguendo il selettore CH1
LEVEL CONTROL. Inoltre, il livello di
registrazione audio di CH2 ¢ impostato sulla
base dell’impostazione della manopola CH1
INPUT LEVEL (pagina 80).

Il camcorder supporta combinazioni di varie
impostazioni. Per informazioni dettagliate,
vedere il diagramma a pagina 138.

Specifica dei dati temporali

Impostazione del codice temporale

Specificare il codice temporale da registrare con
I’opzione Timecode (pagina 90) del menu TC/
UB.



Visualizzazione dei dati temporali

Premere il tasto DISPLAY per visualizzare i dati
temporali sullo schermo (pagina 14).
Specificare il codice temporale da visualizzare
mediante 1’opzione TC Display (pagina 90)
>Display Select del menu TC/UB.

Premendo un pulsante programmabile

(pagina 47) a cui & assegnata la funzione
DURATION/TC/U-BIT, ¢ possibile visualizzare
in sequenza il codice temporale, i bit utente e la
durata.
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Funzioni utili

Pulsanti e manopole
programmabili

Il camcorder ¢ dotato di sei pulsanti
programmabili (pagina 9, pagina 11) a cui
possono essere assegnate varie funzioni.

E possibile assegnare funzioni anche alla
manopola IRIS (pagina 9) del camcorder e alla
manopola programmabile (pagina 11) del
telecomando dell’impugnatura.

Modifica della funzione assegnata al
pulsante

Utilizzare Assignable Button (pagina 99) nel
menu System.

Le funzioni assegnate sono visualizzate nella
schermata Assignable Button Status (pagina 17).

Funzioni predefinite assegnate ai vari pulsanti
programmabili al momento dell’acquisto:

Pulsante 1 S&Q Motion

Pulsante 2 IRIS

Pulsante 3 User Menu

Pulsante 4 Focus Magnifier x4/x8
Pulsante 5 User Menu

Pulsante 6 Off

Funzioni assegnabili

* Off

* Marker

* Zebra

* Peaking

* Video Signal Monitor
* DURATION/TC/U-BIT
* Focus Magnifier x4/x8
* Focus Magnifier x4

* Focus Magnifier x8

* Push AF/Focus Hold

* Focus Area

* Focus Area (Push AF)
* VF Mode

* RIS

* AGC

* SHUTTER

* Auto Exposure Level

* Push Auto Iris



¢ Push AGC

* Spotlight

* Backlight

* ATW

*« ATW Hold

« SteadyShot

¢ Color Bars

¢ User Menu

* Rec Lamp

¢ S&Q Motion

* Picture Cache Rec
* Rec Review

¢ Thumbnail

¢ Shot Mark1

¢ Shot Mark2

« Clip Flag OK

* Clip Flag NG

* Clip Flag Keep
* High/Low Key

Modifica della funzione assegnata alla
manopola

Utilizzare Assignable Dial (pagina 101) nel
menu System.
Le funzioni assegnate sono visualizzate nella

schermata Assignable Button Status (pagina 17).

La funzione IRIS ¢ assegnata per impostazione
predefinita.

Funzioni assegnabili
o Off

* [RIS

* ISO/GAIN/EI

¢ Focus

¢ Audio Input Level

Slow & Quick Motion

Quando il formato video (pagina 97) & impostato
su uno dei valori elencati di seguito, & possibile
specificare valori diversi per le frequenze
fotogrammi di registrazione e di riproduzione.

NTSC Area
XAVC-I
4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 24.00P, 4096 x 2160 23.98P,
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P,
1920 x 1080 29.97P, 1920 x 1080 23.98P
XAVC-L
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 %2160 23.98P, 1920 x 1080 59.94P 50,
1920 x 1080 59.94P 35, 1920 x 1080 29.97P
50, 1920 x 1080 29.97P 35, 1920 x 1080
23.98P 50, 1920 x 1080 23.98P 35

PAL Area

XAVC-1

4096 x 2160 50P, 4096 x 2160 25P,

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P, 1920 x 1080 25P

XAVC-L

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P 50, 1920 x 1080 S0P 35,

1920 x 1080 25P 50, 1920 x 1080 25P 35
E possibile impostare la frequenza fotogrammi di
registrazione premendo un pulsante
programmabile a cui & stata assegnata la funzione
S&Q Motion.

* La funzione Slow & Quick Motion non puo essere
impostata durante la registrazione, la riproduzione o
mentre ¢ visualizzata la schermata delle miniature.
La modalita Slow & Quick Motion non consente la
registrazione di audio.

In modalita Quick & Slow Motion, la funzione di
messa a fuoco automatica ¢ disabilitata.

Per la ripresa con frequenze fotogrammi superiore a 60
fps si applicano le seguenti condizioni:

- Gli indicatori di assistenza alla messa a fuoco,
profondita di campo, posizione di messa a fuoco,
posizione diaframma e posizione di zoom non sono
visibili.



NTSC Area

Formato Risoluzione Fre- Valori di High
quenza Frame Rate
foto-
grammi

XAVC-I 2160 Dala Non supportato
60 fps
(59.94P, 29.97P, 24.00P,
23.98P)

1080 Dala 72/75180/90/96/

60 fps 100/110/120/125/
135/144/150/160/

168/175/180 fps
(59.94P, 29.97P, 23.98P)
XAVC-L 2160 Dala Non supportato
60 fps
(59.94P, 29.97P, 23.98P)
1080 Dala 72/75/80/90/96/

60 fps 100/110/120 fps

(59.94P 50, 59.94P 35,29.97P
50, 29.97P 35, 23.98P 50,
23.98P 35)

PAL Area

Formato Risoluzione Fre- Valori di High
quenza Frame Rate
foto-
grammi

XAVC-I 2160 Dala
60 fps

Non supportato

(59P, 25P)

1080 Dala 72/75/80/90/96/
60 fps 100/110/120/125/
135/144/150 fps

(59P, 25P)
XAVC-L 2160 Dala Non supportato
60 fps
(59P, 25P)
1080 Dala 72/75/80/90/96/

60 fps 100/110/120 fps

(50P 50, 50P 35, 25P 50,
25P 35)

Registrazione di video a intervalli
(Interval Rec)

Il camcorder ¢ dotato della funzione Interval Rec
che consente di catturare video in time-lapse nella
sua memoria interna. Questa funzione ¢ efficace
per riprendere soggetti che cambiano molto
lentamente.

Quando si avvia la registrazione in questa
modalitd, il camcorder registra automaticamente

un numero specificato di fotogrammi a intervalli
specificati.
Questa funzione ¢ abilitata quando il camcorder &
impostato su uno dei seguenti formati video
(pagina 97):

XAVC-1

XAVC-L*

MPEG HD 422*

* 59.94i e 50i non supportati.

Durata dell'intervallo (Interval Time)

I_l_l

Numero di fotogrammi in ciascuna ripresa
(Number of Frames)

Quando ¢ attiva la modalita Interval Rec, la luce
video HVL-LBPC (opzionale) si accende
automaticamente prima dell’avvio della
registrazione per consentire la ripresa di
immagini in stabili condizioni di illuminazione e
di temperatura di colore (funzione di
preilluminazione Pre-Lighting).

Impostazioni e ripresa in modalita
Interval Rec

« E possibile utilizzare una sola funzione di registrazione
speciale (ad esempio Interval Rec) alla volta.

Se durante I’utilizzo di Interval Rec viene attivata
un’altra modalita di registrazione speciale, il
camcorder esce dalla modalita Interval Rec.

Il camcorder esce automaticamente dalla modalita
Interval Rec se vengono modificate le impostazioni di
sistema, ad esempio il formato video.

Le impostazioni della modalita Interval Rec non
possono essere modificate durante la registrazione, la
riproduzione o mentre & visualizzata la schermata delle
miniature.



Impostazione di Interval Rec

Impostare Interval Rec (pagina 91) >Setting nel
menu Recording su On, quindi impostare Number
of Frames e Interval Time.

Se si utilizza la luce video HVL-LBPC
(opzionale), specificare mediante 1’opzione Pre-
Lighting del menu Interval Rec con che anticipo
dovra accendersi la luce prima dell’avvio della
registrazione secondo le proprie esigenze.

Se si desidera accendere la luce video prima dell’avvio
della registrazione, spostare il selettore della luce
video su AUTO. La luce video si accendera e spegnera
automaticamente secondo I’'impostazione dell’opzione
Video Light Set (pagina 72) nel menu Camera.
Spostando su ON il selettore della luce video, la luce
rimane sempre accesa (non si accende e spegne
automaticamente).

Se laluce video & configurata in modo da spegnersi per
5 secondi 0 meno, la luce video non si spegne.

Allo spegnimento, il camcorder esce dalla
modalita Interval Rec, ma i valori impostati in
Number of Frames, Interval Time e Pre-Lighting
sono mantenuti. Non & necessario impostarli
nuovamente la volta successiva che si utilizza la
funzione Interval Rec.

Ripresa in modalita Interval Rec

Premere il pulsante di registrazione per avviare la
registrazione. Il mirino visualizza,
alternativamente, le indicazioni “Int /

®ORec” e “Int[A]/[B @Stby”.

Se si utilizza la funzione di preilluminazione, la
luce video si illumina prima dell’avvio della
registrazione.

Arresto della ripresa

Arrestare la registrazione.

Al termine della ripresa, i dati video memorizzati
fino a quel momento nella memoria vengono
salvati sul supporto di registrazione.

Uscire dalla modalita Interval Rec

Eseguire una delle operazioni indicate di seguito.

* Spostare il selettore POWER su OFF.

« In modalita standby di registrazione, impostare
Interval Rec >Setting nel menu Recording su
Off.

Il camcorder esce automaticamente dalla

modalita Interval Rec anche quando viene

riavviato.

Limitazioni durante la registrazione
* Non viene registrato audio.
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* Non ¢ possibile rivedere la registrazione (Rec
Review).
* Non ¢ applicato un Genlock

Se il camcorder viene spento durante la
registrazione

* Se il selettore POWER del camcorder si trova
nella posizione Off, il camcorder accede per
alcuni secondi al supporto di registrazione per
salvare le immagini contenute in memoria fino
al quel momento, quindi si spegne
automaticamente.

Se I’alimentazione si interrompe perché ¢ stata
rimossa la batteria, ¢ stato scollegato il cavo di
alimentazione CC oppure & stata interrotta
I’alimentazione all’adattatore CA, tutti i dati
video ed audio registrati fino a quel momento
andranno persi (max. 10 secondi).

Prestare attenzione prima di sostituire la
batteria.

Registrazione cache immagine
(Picture Cache Rec)

Mantenendo una memoria cache interna di una
durata specificata durante le riprese, la funzione
di registrazione cache immagine consente di
catturare video “retroattivamente” all’avvio della
registrazione e registrarlo sulle schede di
memoria XQD. Il tempo di registrazione cache
immagine viene impostato con la voce Picture
Cache Rec >Cache Rec Time (pagina 92) nel menu
Recording.

Formati di registrazione supportati

Formato di Risoluzione = Tempo cache [s]
registrazione
RAW 4096x2160 Non supportato
2048x1080
XAVC *1 4096x2160 Da0a2
3840%x2160
1920x1080 Da0a2/da?2ad/da
4a6/da6al
MPEG-2 1920x1080 Da0a2/da2a4/da
4a6/da6a8/da8a
10/da13 a 15
ProRes422 1920x1080 Non supportato

#1: XAVC-I 59.94P e 50P non supportati.

* La funzione Picture Cache Rec non puo essere attiva
mentre sono attive le modalita Interval Rec o Slow &



Quick Motion. Quando viene attivata la funzione
Picture Cache Rec, queste altre modalita di
registrazione vengono disattivate automaticamente.
Non ¢ possibile selezionare la modalita Picture Cache
Rec durante la registrazione o Rec Review.

Mentre Picture Cache Rec ¢ attiva, il codice temporale
viene sempre registrato in modalita Free Run
indipendentemente dall’impostazione nel menu TC/
UB. (pagina 90)

L’impostazione Output Format potrebbe non essere
configurabile nella modalita Picture Cache Rec. In tal
caso, impostare provvisoriamente Picture Cache Rec
su Off e modificare le impostazioni desiderate.

Configurazione prima della ripresa

Configurare Picture Cache Rec (pagina 92) nel
menu Recording prima della ripresa.

E possibile anche assegnare la funzione Picture
Cache Rec >Setting a un pulsante programmabile
(pagina 47) ed attivarla o disattivarla utilizzando
tale pulsante.

Quando & configurata, I’indicatore @ (verde) &
visualizzato nel mirino (pagina 13).

Registrazione cache immagine

Quando viene premuto il pulsante di
registrazione, la registrazione si avvia e il video
viene registrato sulle schede di memoria XQD a
partire dal video contenuto nella memoria cache.

Per annullare Picture Cache Rec

Disattivare Picture Cache Rec >Setting nel menu
Recording, oppure premere il pulsante
programmabile a cui ¢ assegnata la funzione
Picture Cache Rec.

Se si cambia il formato di registrazione, il video gia
esistente nella memoria cache viene eliminato e la
memoria cache inizia a registrare nuovo video. Di
conseguenza, non ¢ possibile registrare le immagini
presenti nella cache prima del cambiamento del
formato anche se la registrazione viene avviata
immediatamente dopo il cambiamento del formato.
Se Picture Cache Rec viene attivata o disattivata
immediatamente dopo I’inserimento di una scheda di
memoria XQD ¢ possibile che i dati della cache non
vengano registrati sulla scheda.

1l video viene memorizzato nella cache a partire dal
momento in cui la funzione di registrazione cache &
attivata. Prima dell’attivazione della funzione il video
non viene memorizzato.

Durante I’accesso a una scheda di memoria XQD, ad
esempio durante riproduzione, Rec Review o
visualizzazione delle miniature, nella memoria cache
non viene memorizzato video. Durante tale periodo
non ¢ possibile registrare immagini di cache.

E possibile modificare il tempo di registrazione della
cache tramite il menu anche durante la registrazione,

ma il nuovo valore entrera in effetto solo al termine
della registrazione corrente.

Rivedere una registrazione (Rec
Review)

E possibile controllare il video dell’ultimo clip
registrato sullo schermo.

Mentre la registrazione & arrestata,
premere il pulsante programmabile
(pagina 47) a cui ¢ assegnata la funzione Rec
Review.

1l clip viene riprodotto fino alla fine e il
camcorder esce dalla funzione Rec Review e
torna alla modalita di STBY (standby).
Premere e mantenere premuto il pulsante per
avviare la riproduzione nella direzione opposta.
Rilasciando il pulsante, il clip viene riprodotto
fino alla fine.

Per arrestare Rec Review
Premere il pulsante programmabile a cui ¢
assegnata la funzione Rec Review.

La funzione Rec Review non ¢ supportata se il formato
video ¢ stato modificato dopo la registrazione del clip.

Modalita autoritratto

E possibile ruotare I’immagine visualizzata nel
mirino (pagina 11) verticalmente oppure
orizzontalmente e verticalmente mediante il
selettore MIRROR.

Questa funzione consente di ruotare il mirino di
180° verso I’obiettivo.



[ T

OFF B/T ROT

)

OFF

L’immagine non & invertita.

B/T
L’immagine & capovolta verticalmente.

La visualizzazione delle informazioni viene
ruotata verticalmente ed orizzontalmente.
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ROT

L’immagine ¢ capovolta verticalmente ed
orizzontalmente.

Anche la visualizzazione delle informazioni
viene capovolta verticalmente ed
orizzontalmente.

Le viste B/T e ROT sono visualizzate solo nel mirino. Il
video in uscita e il video registrato rimangono inalterati.

Visualizzazione del Peaking

E possibile visualizzare o nascondere i dati di
peaking premendo il pulsante PEAKING sul
mirino (pagina 11).

Per attivare o disattivare il peaking ed impostarne
il tipo e la frequenza, utilizzare la voce Peaking
(pagina 86) del menu VF.



Visualizzazione del motivo zebra

E possibile visualizzare o nascondere il motivo
zebra premendo il pulsante ZEBRA sul mirino
(pagina 11).

Per attivare o disattivare la visualizzazione del
motivo zebra e impostarne il tipo e il livello di
visualizzazione utilizzare la voce Zebra
(pagina 86) del menu VF.

Il camcorder misura i valori dell’immagine nel mirino. In
modalita Cine EI, regolare il livello di visualizzazione ed
altri parametri in base alle impostazioni di Monitor LUT
del mirino (pagina 84).

Video Signal Monitor

La voce Video Signal Monitor > Setting
(pagina 89) del menu VF consente di specificare
se visualizzare il segnale video sullo schermo del
mirino come forma d’onda, vettorscopio o
istogramma.

Il monitor del segnale video del camcorder
misura il segnale video allo stadio di uscita del
segnale. Pertanto, se il video viene emesso in
uscita con il bordo ritagliato rispetto al video
registrato, la componente di segnale eliminata dal
ritaglio non verra misurata. In tal caso,
I’indicazione “EC” viene visualizzata nell’angolo
superiore sinistro del monitor del segnale video.
Se I'uscita video ¢ impostata su 2K o un valore
inferiore in modalita Cine EI, & possibile scegliere
se misurare il segnale video dal sistema SDII o
dal sistema SDI2 tramite la voce Video Signal
Monitor >Source (pagina 89) del menu VF.
L’impostazione del LUT di monitoraggio
(pagina 84) del sistema SDI specificato viene
visualizzata nell’angolo superiore destro del
monitor del segnale video.

EC LUT 709

234567890123456
mmfpmm [ A ]000min [ B ]000min

¢ Quando la voce Display On/Off >Setting (pagina 88)
del menu VF ¢ impostata su Off, il monitor del segnale
video non viene visualizzato.

¢ Quando I'impostazione del LUT di monitoraggio del
sistema SDI specificato & impostata su Off, nell’angolo
superiore destro del monitor del segnale video viene
visualizzata I’'impostazione di Color Space
(pagina 97).

Acquisizione delle informazioni di
posizione (GPS)

Impostare GPS su “On” nel menu System.

Durante la ricerca dei satelliti GPS, il camcorder
mostra I’icona . Una volta acquisito il
posizionamento, le informazioni di posizione
sono registrate con il video ripreso.

L’opzione GPS del menu System non puo essere
impostata su “On” quando la maniglia non ¢ montata.
Il ricevitore GPS si trova infatti all’interno della
maniglia stessa.

L’icona visualizzata nel mirino varia a seconda della
qualita di ricezione del segnale proveniente dai satelliti
GPS.

Stato di Visualiz- Stato della ricezione

posiziona- zazione GPS

mento

Off Nessuna GPS impostato su “Off”

visualizza- o si & verificato un errore.
zione

Posiziona- NO GPS Non ¢ possibile acquisire

mento non SIGNAL informazioni di

disponibile posizione perché non ¢
possibile ricevere il
segnale GPS. Spostarsi
in un luogo che permetta
una visione del cielo
senza impedimenti.

Ricerca di Ricerca dei satelliti GPS

satelliti in x@ L’acquisizi dei

A4 quisizione dei

corso satelliti puo richiedere
alcuni minuti.

Posiziona- 0 11 segnale GPS ricevuto &

mento ¢\| molto debole.

P 11 segnale GPS ricevuto &
\ N e
ol adeguato. E possibile
acquisire informazioni
geografiche.

11 segnale GPS ricevuto &
Xl E possibi
ol buono. E possibile
acquisire informazioni di
posizione.

* Per impostazione predefinita, la funzione GPS ¢
impostata su “On”. Mentre la funzione di
posizionamento ¢ attiva, il camcorder registra le
informazioni di posizione, data e ora del video ripreso.



Se tuttavia I’icona di posizionamento non appare entro
alcuni minuti, ¢ possibile che vi siano problemi con la
ricezione del segnale. Avviare la ripresa senza
informazioni di posizione o spostarsi in un luogo che
permetta una visione del cielo senza impedimenti. Se
I’icona di posizionamento non ¢ visualizzata, le
informazioni di posizione non saranno registrate con le
riprese.

11 segnale GPS puo non essere ricevibile durante le
riprese in interni o in prossimita di edifici di una certa
altezza. Spostarsi in un luogo che permetta una visione
del cielo senza impedimenti.

A seconda dell’intensita del segnale ricevuto, la
registrazione delle informazioni di posizione potrebbe
interrompersi anche se I’icona di posizionamento
rimane visualizzata.

Riprese in modalita Cine El

Questa modalita imita il funzionamento di una
macchina da presa cinematografica e presuppone
lo “sviluppo” in post-produzione.

Limitazioni della modalita Cine EI

* Funzioni che non possono essere regolate
automaticamente
- Bilanciamento del bianco

Configurare il registratore RAW
esterno (pagina 35).

Impostare Base Setting >Shooting
Mode nel menu System su Cine EI.

Impostare Codec >Select nel menu
System su RAW.

Selezionando RAW & XAVC-I & possibile
registrare contemporaneamente video RAW
sul registratore RAW esterno e video HD sulle
schede di memoria XQD del camcorder.

Impostare la risoluzione mediante
Imager Scan Mode nel menu System.

Se impostato su Normal, la risoluzione RAW
sara 4096x2160.

Impostare la frequenza fotogrammi in
Rec Format >RAW Output Format nel
menu System.

Controllare che il registratore esterno
sia acceso, quindi premere il pulsante di
registrazione del camcorder.

- Guadagno

- Shutter

- Iris

- Auto Exposure

Di seguito si elencano i formati di uscita RAW.

NTSC Area

« Funzioni che non possono essere configurate
- Guadagno
- Impostazioni del menu Paint
- Scene File
- Lens File

Impostazione Formati di uscita RAW
Codec >Select
RAW /RAW & 4096 x 2160 59.94P

XAVC-1/RAW &
XAVC-L/RAW &

4096 x 2160 29.97P
4096 x 2160 23.98P

Funzioni disponibili solo in modalita
Cine El

* Exposure Index

* Monitor LUT

* High/Low Key

¢ Registrazione di video RAW

Registrazione di vileo RAW

E possibile registrare video RAW su un
registratore AXS-RS5 (opzione) convertendo il
segnale in uscita dal connettore RAW OUT di
un’unita di estensione XDCA-FS7 (opzione)
connessa al camcorder tramite un’unita di
interfaccia HXR-IFRS5 (opzione) (pagina 35).

MPEG HD422 2048 x 1080 59.94P
2048 x 1080 29.97P
2048 x 1080 23.98P
PAL Area
Impostazione Formati di uscita RAW
Codec >Select
RAW /RAW & 4096 x 2160 S0P

4096 x 2160 25P
2048 x 1080 50P
2048 x 1080 25P

XAVC-1/RAW &
XAVC-L/RAW &
MPEG HD422

Indicazione dello stato di registrazione

Se Display On/Off (pagina 88) >HXR-IFR5 Rec
Control del menu VF & impostato su “On”, lo
stato della registrazione RAW ¢ visualizzato nel
mirino con un’icona.
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Registrazione Slow & Quick Motion

Se S&Q Motion >Setting del menu Recording ¢
impostata su “On”, il video RAW viene registrato
in modalita Slow & Quick.

L’uscita RAW in Slow & Quick Motion ¢
supportata solo per la risoluzione 2K a 120/240
fps (NTSC) e 100/200 fps (PAL).

11 connettore RAW OUT del camcorder controlla la
registrazione solo inviando un segnale Rec Control al
registratore esterno. Per questa ragione, & possibile che
il camcorder indichi che € in corso una registrazione
RAW anche se il registratore esterno in realta non sta
registrando. Controllare ’effettivo stato operativo
servendosi sempre dell’indicatore del registratore
esterno.

Quando si avvia la registrazione su un registratore
esterno, senza utilizzare il pulsante di registrazione del

camcorder, i clip non vengono registrati correttamente.

Aggiunta di connettori di ingresso
audio

E possibile collegare contemporaneamente al
camcorder fino a quattro canali di dispositivi
audio XLR utilizzando un adattatore XLR-K2M
XLR (non in dotazione).

Montare 1’adattatore XLR sulla slitta MI e, nel
menu Audio, impostare Audio Input >CH3 Input
Select su “Shoe 1” e CH4 Input Select su “Shoe
27

Le funzioni del camcorder che si sovrappongono
verranno disabilitate per i canali per i quali &
selezionato come ingresso 1’adattatore XLR.
Eseguire le regolazioni necessarie servendosi dei
pulsanti e delle manopole dell’adattatore XLR.

* Se Audio Input >CH3 Level e CH4 Level nel menu
Audio sono impostati su “Audio Input Level”, il valore
di Audio Input Level del camcorder verra regolato in
modo da corrispondere al valore impostato
sull’adattatore XLR. Audio Input Level viene abilitato
anche quando il selettore dell’adattatore XLR &
impostato su AUTO. Se ¢ specificato “Through”,
I’audio verra registrato al livello impostato con
I’adattatore XLR (pagina 139).

E possibile impostare anche su CH1 e CH2 montando
un adattatore XLR e impostando Audio Input >CH1
Input Select e CH2 Input Select nel menu Audio
rispettivamente su “Shoe 1” e “Shoe 2”. Tuttavia, se si
assegna I’ingresso dall’adattatore XLR a entrambi i
canali CHI e CH2, non sara possibile assegnare a tali
canali I’ingresso dai connettori INPUT1/INPUT?2 del
camcorder.
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Connessione a
dispositivi esterni
tramite una LAN
wireless

Montando il modulo LAN wireless USB IFU-
WLM3 (fornito) oppure un adattatore wireless
CBK-WAI100 (opzione), il camcorder ¢ in grado
di connettersi a smartphone, tablet e altri
dispositivi mediante una connessione LAN
wireless.

Non ¢ supportato Iutilizzo di moduli wireless USB
diversi dal modello IFU-WLM3.

I dispositivi connessi tramite una rete LAN wireless
consentono di eseguire le funzioni elencate di seguito.
* Telecomando

Consente il comando a distanza del
camcorder.

* Monitoraggio video (solo con adattatore CBK-

WAT100)

Consente il monitoraggio del video del
camcorder.
E necessario utilizzare 1’adattatore CBK-
WAT100 (opzione) e I’applicazione Content
Browser Mobile.

Per informazioni dettagliate sull’applicazione
Content Browser Mobile rivolgersi al proprio
rappresentante commerciale o di assistenza tecnica
Sony.

Dispositivi compatibili

E possibile utilizzare smartphone, tablet o
computer per configurare e azionare il camcorder.
La seguente tabella indica i dispositivi, i sistemi
operativi e i browser supportati.

Dispositivo Sistema operativo =~ Browser
Smartphone  Android 5.1 Chrome
i0OS 9 Safari
Tablet Android 5.1 Chrome
i0S 9 Safari
Computer Microsoft Windows 7/ Chrome
Microsoft Windows 8.1/
Microsoft Windows 10
Mac OS 10.10/10.11 Safari




2 Montare la staffa di montaggio
Collegamento del modulo IFU- dell’adattatore CBK-WA 100 sul

WLM3 camcorder e stringere le viti.

Inserire il modulo LAN wireless USB IFU-
WML3 nell’apposito connettore (pagina 7).
Dopo averlo montato, impostare Wi-Fi >Wi-Fi
(pagina 103) nel menu System su “Enable” per
abilitare la LAN wireless.

Connettere e disconnettere il modulo IFU-WLM3 solo
mentre il camcorder ¢ spento.

Montaggio dell’adattatore CBK-
WA100

Connettere e disconnettere 1’adattatore CBK-WA100
solo mentre il camcorder & spento.

1 Montare I’adattatore CBK-WA100
sulla staffa di montaggio e stringere le
due viti.

3 Collegare il cavo USB dell’adattatore
CBK-WA100 al connettore del modulo
LAN wireless USB (D) e il cavo SDI al
connettore SDI OUT (®@).

4  Accendere ’adattatore CBK-WA100 e
quindi accendere il camcorder.
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5 Dopo aver eseguito le connessioni,
abilitare la funzione LAN wireless
impostando Wi-Fi >Wi-Fi (pagina 103)
nel menu System su Enable.

Per poter utilizzare I’adattatore CBK-WA100 con il
camcorder & necessario configurare opportunamente le
impostazioni di uscita SDI OUT. Tuttavia il camcorder
non pud emettere un segnale compatibile con I’ adattatore
CBK-WA100 quando si utilizza XAVC-124.0P o
ProRes 23.98P (pagina 83).

Informazioni sull’adattatore CBK-WA100

L’adattatore CBK-WA 100 ¢ dotato di funzioni
per la registrazione di file proxy a bassa
risoluzione su una scheda SD e per il
trasferimento dei file a un server tramite una rete
LAN wireless. Per ulteriori informazioni,
consultare le istruzioni per ’uso fornite con
I’adattatore CBK-WA100.

Connessione “One-Touch” dei
dispositivi NFC (solo con modulo
IFU-WLM3)

I dispositivi che supportano la funzione NFC
possono essere collegati tramite tale funzione
(connessione “One-Touch”).

1 Montare un modulo IFU-WLMS3 sul
camcorder (pagina 56) ed impostare
Wi-Fi >Wi-Fi (pagina 103) nel menu
System su “Enable” per abilitare la
funzione LAN wireless.

N appare sullo schermo.

- F

2 Aprire “Settings” sul dispositivo,
selezionare “More” e contrassegnare
con un segno di spunta la casella di
controllo NFC.

Le opzioni di impostazione disponibili
variano a seconda del dispositivo. Per
informazioni dettagliate, fare riferimento al
manuale di istruzioni del dispositivo.

3 Toccare il camcorder con il dispositivo.
11 dispositivo si connette al camcorder, apre
un browser Web e visualizza il telecomando
Wi-Fi. Alla prima connessione del
dispositivo ¢ necessario eseguire la
procedura di autenticazione.

« Disabilitare in anticipo le modalita sleep e di blocco
schermo.

 Toccare e mantenere fermo il dispositivo fino a quando
non si avvial’applicazione “Content Browser Mobile”
(1 0 2 secondi).



Visualizzazione del
telecomando Wi-Fi
Remote

La schermata dell’applicazione di telecomando
Wi-Fi Remote viene automaticamente
ridimensionata a seconda delle dimensioni dello
schermo del dispositivo collegato.

1 Collegare il camcorder e il dispositivo
tramite una connessione LAN wireless
(pagina 57).

2 Avviare un browser sul dispositivo ed
immettere ‘‘http://<indirizzo IP del
camcorder (Wi-Fi >IP Address nel menu
System>/rm.html” nella barra dell’URL.

Ad esempio, se I’indirizzo IP ¢ 192.168.1.1,
immettere “http://192.168.1.1/rm.html” nella
barra dell’URL.

3 Immettere nome utente e password
(Basic Authentication >User Name e
Password nel menu System).

Quando la connessione ¢ stabilita, la schermata
di Wi-Fi Remote apparira sul dispositivo.
Azionare il camcorder dalla schermata di Wi-
Fi Remote.

E possibile disabilitare il pulsante di
registrazione spostando il selettore Lock
verso destra.

Se si utilizza uno smartphone, visualizzare la pagina
sostituendo “rm.html” con “rms.html” nell’URL. Se si
utilizza un tablet, visualizzare la pagina sostituendo
“rm.html” con “rmt.html]” nell’URL. Se si immette
“rm.html” la pagina dovrebbe cambiare
automaticamente in base al dispositivo connesso.
Ciononostante, & possibile che in certi dispositivi non
venga visualizzata la pagina corretta.
Nelle circostanze elencate di seguito, & possibile che la
schermata di Wi-Fi Remote non corrisponda alle
impostazioni del camcorder. In tal caso, ricaricare la
finestra del browser.
- Se il camcorder viene riavviato mentre ¢ connesso.
- Se il camcorder viene azionato direttamente mentre
€ connesso.
- Se il dispositivo si ¢ riconnesso.
- Se sono stati utilizzati i pulsanti avanti/indietro del
browser.
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« La funzione di telecomando Wi-Fi Remote potrebbe
non funzionare correttamente se I’intensita del segnale
wireless ¢ insufficiente.



Schermata delle miniature

Schermata delle miniature

La schermata delle miniature viene visualizzata premendo il pulsante THUMBNAIL (pagina 9). Questa
schermata mostra miniature (immagini di indice) dei clip contenuti nelle schede di memoria XQD.

La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. La riproduzione
puo essere visualizzata nel mirino e su un monitor esterno.

Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare
all’immagine della videocamera.

¢ La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un
clip registrato che avrebbe dovuto essere presente non ¢ visualizzato, controllare il formato di registrazione. Prestare
attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.

¢ Quando I’opzione Codec >Select del menu System & impostata su uno dei valori seguenti, non sara possibile avviare
la registrazione durante la riproduzione o mentre ¢ visualizzata la schermata delle miniature.
RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

Elementi dello schermo

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui &
posizionato il cursore.

Indicatore della scheda di memoria XQD correntemente selezionata
(se la scheda & protetta, viene visualizzata I'icona del lucchetto).

Numero del clip/Numero dei clip

t)

Cursore
(giallo)
TCR 00: 115 TCR00:00:00:34
.:.4;\{ - -
TCR 00: 2 TCR00:00:02:35
1 . ; :
:00:03: TCR00:00:04:45 TCR00: TCR 00:00:05:21
R Clin0006) ( }—=6
C I ) ( | YIC )
3 4 5
1. Miniatura (immagine indice) con la voce Customize View (pagina 93)
Visualizza I’immagine indice del clip. Quando >Thumbnail Caption del menu Thumbnail.
si registra un clip, il primo fotogramma viene 2. Nome del clip
impostato automaticamente come immagine Visualizza il nome del clip selezionato.
indice.

3. Formato di registrazione video
Visualizza il formato del file del clip
selezionato.

Sotto la miniatura vengono visualizzate
informazioni sul clip e sul fotogramma. E
possibile scegliere le informazioni visualizzate
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4. Informazioni sulla registrazione speciale
Se il clip ¢ stato registrato con una modalita di
registrazione speciale, ne indica la modalita.
Se il clip ¢ registrato in modalita Slow & Quick
Motion, ne viene indicata la frequenza
fotogrammi sulla destra.

5. Durata del clip

6. Data di creazione
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Riproduzione di clip

Riproduzione dei clip registrati

E possibile riprodurre i clip registrati mentre il
camcorder si trova in modalita standby (Stby) di
registrazione.

1 Inserire la scheda di memoria XQD da
riprodurre.

2 Premereil pulsante THUMBNAIL.

3 Ruotando la manopola SEL/SET
(pagina 9),spostare il cursore sul clip da
riprodurre.

4 Premerela manopola SEL/SET.

La riproduzione si avvia dall’inizio del clip
selezionato.

E possibile comandare la riproduzione con i

seguenti pulsanti:

Manopola SEL/SET:

Mette in pausa la riproduzione
Premere una seconda volta per tornare alla
riproduzione normale.

Pressione dei pulsanti sinistro/destro:
Salta all’inizio del clip corrente o all’inizio
del clip successivo.

Pressione continua dei pulsanti sinistro/

destro:

Ritorno e avanzamento veloce.
Torna alla riproduzione normale quando si
rilascia il pulsante.

Pulsante CANCEL/BACK:

Arresta la riproduzione e torna alla modalita
standby di registrazione.

Nel passaggio da un clip a un altro la visualizzazione
dell’immagine potrebbe momentaneamente
frazionarsi o arrestarsi. Durante questo periodo non &
possibile azionare il camcorder.

Quando si seleziona un clip nella schermata delle
miniature e ha inizio la riproduzione, potrebbero
verificarsi temporanei frazionamenti dell’immagine
all’inizio del clip. Per visualizzare I’inizio del clip
senza frazionamenti, avviare la modalita di
riproduzione, mettere in pausa, quindi utilizzare il
pulsante sinistro della manopola SEL/SET per tornare
all’inizio del clip e riavviare la riproduzione.

E possibile comandare la riproduzione anche con il
telecomando fornito in dotazione.



Operazioni con i clip

Nella schermata delle miniature & possibile
eseguire operazioni di gestione dei clip e
controllarne le proprieta tramite il menu delle
miniature.

Il menu delle miniature (pagina 93) viene
visualizzato quando si preme il pulsante MENU e
si seleziona una miniatura.

Utilizzo del menu delle miniature

Ruotare la manopola SEL/SET (pagina 9) per
selezionare una funzione, quindi premere la
manopola SEL/SET.

Premere il pulsante CANCEL/BACK (pagina 9)
per ritornare alla schermata precedente.

A seconda dello stato operativo del camcorder quando
viene visualizzato il menu, alcune voci potrebbero non
essere selezionabili.

Voci del menu delle miniature

Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Per informazioni dettagliate sull’utilizzo del
menu delle miniature, vedere “Menu
Thumbnail” (pagina 93).

Displaying clip properties

Selezionare Display Clip Properties (pagina 93)
nel menu Thumbnail per visualizzare la
schermata delle proprieta dei clip.
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Visualizzazione della schermata delle
miniature con indicatori di
identificazione.

Selezionare Thumbnail View (pagina 93)
>Essence Mark Thumbnail nel menu Thumbnail,
quindi selezionare il tipo di indicatore di
identificazione (Essence Mark) desiderato per
visualizzare le miniature dei fotogrammi che lo
contengono.

Visualizzazione della schermata delle
miniature filtrata

Selezionare Filter Clips (pagina 93) nel menu
Thumbnail, quindi selezionare il tipo di flag dei
clip desiderato per visualizzare solo i clip che lo
contengono.

Per visualizzare tutti i clip, impostare Thumbnail
View >Essence Mark Thumbnail nel menu
Thumbnail su All.

Eliminazione di clip

E possibile eliminare clip dalle schede di
memoria XQD.
Selezionare Delete Clip >Select Clip o All Clips
nel menu Thumbnail.
Select Clip:
Elimina il clip selezionato. E possibile
selezionare pill clip contemporaneamente.
All Clips:
Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate
nella schermata delle miniature

E possibile scegliere le informazioni sui clip o sui
fotogrammi visualizzate sotto la miniatura.
Selezionare Customize View >Thumbnail
Caption nel menu Thumbnail, quindi selezionare
le informazioni da visualizzare.
Date Time:
Visualizza la data e ’ora di creazione e
dell’ultima modifica del clip.
Time Code:
Visualizza il codice temporale.
Duration:
Visualizza la durata del clip.
Sequential Number:
Visualizza un numero sequenziale su ogni
miniatura.



Menu visualizzati e impostazioni

Struttura del menu di configurazione

Premere il pulsante MENU per visualizzare nel
mirino il menu di configurazione in cui
specificare le opzioni necessarie per la ripresa, la
registrazione e la riproduzione (il menu puo
essere visualizzato anche su un monitor esterno).
Il menu di configurazione comprende i menu
elencati di seguito:
Menu User:
Contiene voci di menu configurate
dall’utente tramite il menu Edit User.
Menu Edit User:
Contiene comandi per la modifica del menu
User.
Menu Camera:
Contiene opzioni relative alla ripresa.
Menu Paint:
Contiene opzioni relative alla qualita
dell’immagine.
Menu Audio:
Contiene opzioni relative all’audio.
Menu Video:
Contiene opzioni relative all’uscita video.
Menu VF:
Contiene opzioni relative alla
visualizzazione sul mirino.
Menu TC/UB:
Contiene opzioni relative al codice temporale
e ai bit utente.
Menu Recording:
Contiene opzioni relative alla registrazione.
Menu Thumbnail:
Contiene opzioni relative alla
visualizzazione delle miniature.
Menu Media:
Contiene opzioni relative ai supporti di
memorizzazione.
Menu File:
Contiene opzioni relative ai file.
Menu System:
Contiene opzioni relative al sistema.

Struttura del menu di
configurazione

User
(Impostazioni di
fabbrica)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User

Add Item

Customize Reset

Camera

ISO/Gain/El

Auto Exposure

Focus

Shutter

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint

White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Skin Detail

Aperture

Matrix

Multi Matrix

Maintenance
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Audio Audio Input System Base Setting
Audio Output Codec
Video Output On/Off Rec Format
Output Format Genlock
Output Setting Assignable Button
Monitor LUT Assignable Dial
Output Display Rec Lamp
VF VF Setting Fan Control
Peaking HOLD Switch Setting
Zebra Lens
Marker Language
Display On/Off Clock Set
Video Signal Monitor Country
TC/UB Timecode Hours Meter
TC Display Basic Authentication
User Bits Wi-Fi
HDMI TC Out GPS
Recording S&Q Motion IR Remote
Interval Rec Camera Battery Alarm
Picture Cache Rec Camera DC IN Alarm
Simul Rec Ext. Unit Battery Alarm
SDI/HDMI Rec Control Ext. Unit DC IN Alarm
Thumbnail Display Clip Properties All Reset
Set Index Picture APR
Thumbnail View Camera Config
Set Shot Mark Version
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Filter Clips
Customize View
Media Update Media
Format Media
Clip
File All File
Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File
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Utilizzo del menu di
configurazione

Premere il pulsante MENU per visualizzare nel
mirino il menu di configurazione in cui
specificare le opzioni necessarie per la ripresa, la
registrazione e la riproduzione (il menu pud
essere visualizzato anche su un monitor esterno).

Comandi del menu

Pulsante MENU (pagina 9)
Attiva o disattiva la modalita per utilizzare il
menu di configurazione.

Pulsante sinistro / Pulsante destro (pagina 9)
Manopola SEL/SET (pagina 9)

Premere il pulsante sinistro o destro per spostare
il cursore verso sinistra o destra e selezionare voci
o impostazioni del menu.

Ruotare la manopola SEL/SET per spostare il
cursore verso I’alto o il basso e selezionare voci o
impostazioni del menu.

Premere la manopola SEL/SET per applicare la
voce selezionata.

Pulsante CANCEL/BACK (pagina 9)

Annulla un’impostazione prima della sua
applicazione e si sposta sul livello precedente
della struttura dei menu.

Il menu di configurazione non puo essere utilizzato
quando il camcorder si trova in modalita di
ingrandimento della messa a fuoco (pagina 41).

Impostazione delle voci dei menu

Ruotare la manopola SEL/SET per spostare il

cursore sulla voce di menu da impostare, quindi

premere la manopola per selezionare la voce.

 Nell’area di selezione delle voci del menu
vengono visualizzate un massimo di otto righe.
Se non possono essere visualizzate
contemporaneamente tutte le opzioni
disponibili per una determinata voce, scorrere le
opzioni spostando il cursore verso I’alto o verso
il basso.

 Se la gamma di opzioni disponibili per una voce
€ molto ampia (ad esempio da —99 a + 99),
I’area di selezione non viene visualizzata. Viene
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invece evidenziato il valore corrente per
indicare che tale valore puo essere modificato.

* Per eseguire una funzione, selezionare
[Execute].

* Se si seleziona una voce che richiede conferma
prima dell’esecuzione, il menu verra
momentaneamente nascosto e verra
visualizzato un messaggio di conferma.
Controllare il messaggio e quindi scegliere se
eseguire o annullare la funzione.

Immissione di una stringa di caratteri

Quando si seleziona una voce che richiede
I’immissione di caratteri, viene visualizzata la
schermata di inserimento caratteri.

1

Edit File Name

Kurokawa_Scene_001 a

1 Ruotarela manopola SEL/SET per
selezionare il set di caratteri desiderato,
quindi premere la manopola.

ABC: caratteri alfabetici maiuscoli
abc: caratteri alfabetici minuscoli
123: caratteri numerici

1#$: caratteri speciali

2 Selezionare il carattere desiderato nel
set specificato, quindi premere la
manopola.

11 cursore si sposta sul campo successivo.
Space: inserisce uno spazio nella posizione
del cursore

«—/— : sposta la posizione del cursore.
BS: elimina il carattere alla sinistra del
cursore

3 Al termine, selezionare [Done] e
premere la manopola.
La stringa di caratteri viene confermata e la
schermata di inserimento dei caratteri si
chiude.



Elenco delle voci del menu di configurazione

Questa sezione descrive le funzioni e le impostazioni delle voci di ogni menu.

Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB ).

Menu User

User

Voce Impostazione della voce Descrizione
secondaria

Country Vedere Country nel menu System.

Impostazioni regionali

Base Setting Vedere Base Setting nel menu

Impostazioni di base System.

Rec Format Vedere Rec Format nel menu

Impostazioni del formato di
registrazione

System.

Codec Vedere Codec nel menu System.
Impostazioni codec
S&Q Motion Vedere S&Q Motion nel menu

Impostazioni della modalita Slow
& Quick Motion

Recording.

Picture Cache Rec
Impostazioni della modalita di
registrazione cache immagine

Vedere Picture Cache Rec nel
menu Recording.

Simul Rec
Impostazioni della registrazione
simultanea

Vedere Simul Rec nel menu
Recording.

Output Format
Impostazioni del formato di uscita

Vedere Output Format nel menu
Video.

Monitor LUT Vedere Monitor LUT nel menu
Impostazioni del LUT monitor. ~ Video.
Clip Vedere Clip nel menu Media.

Impostazioni relative al nome dei
clip

VF Setting
Impostazioni del mirino

Vedere VF Setting nel menu VF.

Assignable Button
Impostazioni per I’assegnazione
di funzioni ai pulsanti
programmabili

Vedere Assignable Button nel
menu System.

Assignable Dial
Impostazioni per I’assegnazione
di funzioni alle manopole
programmabili

Vedere Assignable Dial nel menu
System.

Format Media
Formatta (inizializza) schede di
memoria

Vedere Format Media nel menu
Media.
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User

Voce Impostazione della voce

secondaria

Descrizione

Edit User Menu
Modifica le voci del menu User

Consente di modificare le voci del menu User.

Quando si seleziona “Edit User Menu”, il
menu Edit User passa al livello piu alto e
vengono visualizzate tutte le voci di menu.

Menu Edit User

Quando si seleziona “Edit User Menu”, il menu Edit User viene visualizzato al livello piu alto.

Voce Impostazione della voce

secondaria

Descrizione

Add ltem

Aggiunge una voce al menu User

Aggiunge una voce al menu User.

Customize Reset
Ripristina le voci del menu User.

Ripristina I’impostazione predefinita delle voci

del menu User.

Voce di menu selezionata durante Delete

Rimuove dal menu User la voce di menu registrata.

la modifica Move

Cambia I’ordine delle voci registrate del menu

User.

Edit Sub Item

Elimina le voci secondarie registrate nel menu

User.

Menu Camera

Camera

Voce Impostazione della voce Descrizione
secondaria
ISO/Gain/El Mode Seleziona la modalita di impostazione del guadagno.
Impostazioni di 1SO/dB
guadagno 1SO/Gain<H>

Quando Mode & impostato su ISO

e la gamma dinamica ¢ 460%:
1SO 800 /1SO 1000 /
1SO 1250 /1SO 1600 /
1SO 2000/ ISO 2500 /
1SO 3200 /1SO 4000 /
1SO 5000 / ISO 6400

Quando Mode & impostato su ISO

e la gamma dinamica & 800%:
ISO 1600/ 1SO 2000 /
1SO 2500 /1SO 3200 /
ISO 4000/ 1SO 5000 /
1SO 6400 / ISO 8000 /
ISO 10000 /ISO 12500

Imposta il valore predefinito del guadagno <H>.
Quando Mode & impostato su ISO e la gamma dinamica &
1300% (Gamma Category impostata su S-Log2 o S-Log3):
ISO 2000 /1SO 2500 / I1SO 3200 /
ISO 4000 /ISO 5000 / ISO 6400 /
1SO 8000 / ISO 10000 / ISO 12500 /
ISO 16000
Quando Mode ¢ impostato su dB:
—3dB /0dB /3dB / 6dB /
9dB /12dB / 18dB

La gamma dinamica ¢ determinata dalla gamma.

Gamma Gamma dinamica
STD /HG1/HG2/HG3/HG4 460%
HG7 / HG8 / User 800%

S-Log2/ S-Log3 1300%
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Camera

Voce Impostazione della voce Descrizione
secondaria
ISO/Gain<M> Imposta il valore predefinito del guadagno <M>.
(Stesse impostazioni di ISO/ Di seguito si indicano i valori predefiniti.
Gain<H>) Quando Mode ¢ impostato su ISO e la gamma dinamica ¢ 460%:
1SO1600
Quando Mode ¢ impostato su ISO e la gamma dinamica ¢ 800%:
1S03200
Quando Mode ¢ impostato su ISO e la gamma dinamica &
1300% (Gamma Category impostata su S-Log2 o S-Log3):
1S04000
Quando Mode & impostato su dB:
6dB
ISO/Gain<L> Imposta il valore predefinito del guadagno <L>.
(Stesse impostazioni di ISO/ Di seguito si indicano i valori predefiniti.
Gain<H>) Quando Mode ¢ impostato su ISO e la gamma dinamica ¢ 460%:

1SO800
Quando Mode ¢ impostato su ISO e la gamma dinamica ¢ 800%:
1SO1600
Quando Mode ¢ impostato su ISO e la gamma dinamica &
1300% (Gamma Category impostata su S-Log2 o S-Log3):
1S02000
Quando Mode & impostato su dB:
0dB

Exposure Index<H>
500EI/ 4.0E
640EI / 4.3E
800EIL/ 4.7E
1000EI/ 5.0E
1250EI/ 5.3E
1600EI/ 5.7E
2000EI/ 6.0E
2500EI/ 6.3E
3200El/ 6.7E
4000EI/ 7.0E
5000EI/ 7.3E
6400EI/ 7.7E
8000EI / 8.0E

Imposta il valore predefinito dell’indice di esposizione <H>.
Disponibile solo in modalita Cine EI.

Exposure Index<M>
(Stesse impostazioni di
Exposure Index<H>)

Imposta il valore predefinito dell’indice di esposizione <M>.
11 valore predefinito ¢ 1600EI/5.7E

Exposure Index<L>
(Stesse impostazioni di
Exposure Index<H>)

Imposta il valore predefinito dell’indice di esposizione <L>.
11 valore predefinito ¢ 800EI / 4.7E

Shockless Gain

Attiva o disattiva la funzione di guadagno fluido.

On / Off
Auto Exposure Level Imposta i livelli di luminosita per il valore di esposizione
Impostazioni per —2.0/-1.75/-15/-1.25/ rilevato automaticamente.
la correzione -1.0/-0.75/-05/-0.25/0/
automatica +0.25/+0.5/+0.75/+1.0/
dell’esposizione +1.25/+1.5/+1.75/+2.0
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Camera

Voce Impostazione della voce Descrizione
secondaria
Mode Imposta la modalita di controllo.
Backlight / Standard / Backlight:
Spotlight Modalita controluce (i soggetti ripresi in controluce
appaiono meno scuri)
Standard:
Modalita standard
Spotlight:
Modalita riflettore (limita il clipping dei bianchi quando il
soggetto ¢ illuminato da riflettori)
Speed Imposta la velocita di regolazione.
Da-99 a +99 (x0)
AGC Attiva o disattiva la funzione AGC (controllo del guadagno
On / Off automatico).
AGC Limit Imposta il guadagno massimo della funzione AGC.
Quando ISO/Gain/EI >Mode & Quando ISO/Gain/EI >Mode ¢ impostato su ISO e la gamma
impostato su dB: dinamica & 800%:
3dB/6dB/9dB/ 12dB/ 1SO2000 / 1SO3200 / ISO4000 / ISO6400 / 1SO8000 /
15dB / 18dB 1SO12500
Quando ISO/Gain/EI >Mode & Quando ISO/Gain/EI >Mode ¢ impostato su ISO e la gamma
impostato su ISO e la gamma dinamica ¢ 1300%:
dinamica & 460%: 1SO2500 / 1SO4000 / ISO5000 / 1SO8000 / 1SO10000 /
1SO1000/ISO1600/1SO02000/  ISO16000
1S03200 / 1SO4000 / 1ISO6400
Auto Shutter Attiva o disattiva la funzione di otturatore automatico.
On / Off
A.SHT Limit Imposta la velocita massima della funzione di otturatore
1/100/ 1/150/ 1/200 / automatico.
1/250/1/2000
Clip High light Attiva o disattiva la funzione che ignora le zone pit luminose
On / Off per dare una reazione piu piatta alle luminanze elevate.
Detect Window Imposta la gamma di misura della luce per la regolazione
1/2/3/4/5/6 automatica della luce secondo la luminosita del soggetto.
(Non disponibile quando I’esposizione viene regolata
manualmente)
Detect Window Indication Attiva o disattiva la funzione Detect Window.
On/ Off
Focus Focus Area Specifica la zona di messa a fuoco per la messa a fuoco

Impostazioni di
messa a fuoco

Wide / Center / Flexible

automatica (pagina 40).
Wide:
Cerca il soggetto su un ampio angolo dell’immagine
durante la messa a fuoco.
Center:
Mette a fuoco il soggetto al centro dell’immagine.
Flexible Spot:
Mette a fuoco una posizione specificata dell’immagine.
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Camera

Voce Impostazione della voce Descrizione
secondaria
Focus Area (Push AF) Specifica la zona di messa a fuoco per la funzione Push Auto
Center / Flexible Focus (pagina 41).
Center:
Mette a fuoco il soggetto al centro dell’immagine.
Flexible Spot:
Mette a fuoco una posizione specificata dell’immagine.
L’adattatore opzionale LA-EA2/4 non consente
I’impostazione della posizione.
AF Assist Quando ¢ impostato su On, consente di ignorare
On / Off momentaneamente la funzione di messa a fuoco automatica ed

eseguire la messa a fuoco manualmente.
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Voce Impostazione della voce Descrizione

secondaria
Shutter Mode Seleziona la modalita operativa dell’ otturatore elettronico.
Impostazione delle Speed / Angle / ECS / Off Speed/Angle (modalita standard):
condizioni di Consente di eseguire riprese nitide di soggetti in rapido
funzionamento movimento. Seleziona la modalita di impostazione della
dell’ otturatore velocita dell’otturatore in secondi (Speed) o in gradi
elettronico (Angle).

ECS (Extended Clear Scan)
Consente la ripresa senza visualizzare barre orizzontali in
movimento sullo schermo del monitor.

Shutter Speed
Da 1/3 a 1/9000

Imposta la velocita dell’ otturatore quando Mode ¢ impostato

su Speed. I valori disponibili variano a seconda della

frequenza fotogrammi del formato video selezionato.

59.94P/59.94i:
1/4,1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250,
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000,
1/4000, 1/6000, 1/9000

50P/50i:
173, 1/6, 1/12, 1/25,1/50, 1/60, 1/100, 1/120, 1/150, 1/215,
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500,
1/3500, 1/6000, 1/9000

29.97P:
1/4,1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250,
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000,
1/4000, 1/6000, 1/9000

25P:
173, 1/6, 1/12, 1/25,1/50, 1/60, 1/100, 1/120, 1/150, 1/215,
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500,
1/3500, 1/6000, 1/9000

24P:
173, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100,
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200,
1/2400, 1/4800, 1/9000

23.98P:
173, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100,
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200,
1/2400, 1/4800, 1/9000

1/1 puo essere impostato quando la frequenza fotogrammi di
registrazione S&Q € impostata su 1fps.

Shutter Angle
5.625°/11.25°/22.5°/45°/
90°/120° / 144° / 150° /
172.8°/180°/216° / 300°

Imposta I’angolo dell’otturatore quando Mode & impostato su
Angle.

70



Camera

Voce Impostazione della voce Descrizione
secondaria
ECS Frequency Imposta la frequenza ECS quando Mode ¢ impostato su ECS.
Da 23,99 a 8000 1 valori disponibili variano a seconda della frequenza
fotogrammi del formato video selezionato.
Di seguito si indicano i valori predefiniti.
59.94P: 60.00
59.94i: 60.00
50P: 50.00
50i: 50.00
29.97P: 30.00
24P: 24.02
23.98P: 23.99
25P: 25.02
Color Bars Setting Attiva o disattiva la barra colori.
Impostazioni della ~ On/ Off
barra colori m
Questa opzione non pud essere impostata su On quando &
configurata la registrazione di video RAW.
Type Seleziona il tipo di barra colori.
ARIB / SMPTE / 75% / 100%
Noise Setting Attiva o disattiva la soppressione del rumore.
Suppression On/ Off 11 valore predefinito & Off se Base Setting >Shooting Mode nel
Impostazioni della menu System ¢ impostato su Cine EL
funzione di Level Imposta il livello di soppressione del rumore.

soppressione del
rumore

Low / Mid / High

Flicker Reduce Mode Imposta la modalita di correzione dello sfarfallio.

Impostazioni di Auto / On / Off

conezif)ne dello  Frequency Consente di specificare la frequenza della sorgente di

sfarfallio 50Hz / 60Hz alimentazione del dispositivo di illuminazione che causa lo
sfarfallio.

SteadyShot Setting Attiva o disattiva la funzione di stabilizzazione dell’immagine.

Impostazioni della  Active SteadyShot / m

funzione di SteadyShot / Off

stabilizzazione
dell’immagine

Disponibile quando & montato un obiettivo compatibile.

Handle Zoom
Impostazioni dello
zoom della
maniglia

Zoom Speed Type
Fix / Variable / Off

Imposta la modalita della levetta dello zoom della maniglia.

Disabilitato se la maniglia non ¢ montata.

Zoom Speed
Dala8(3)

Imposta la velocita dello zoom della maniglia.
(Abilitata se Zoom Speed Type ¢ impostato su Fix)

Disabilitato se la maniglia non & montata.
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Voce Impostazione della voce Descrizione
secondaria
Auto Black Auto Black Balance Esegue la funzione di bilanciamento automatico del nero.
Balance Execute / Cancel
Impostazioni del m
bilanciamento  Eseguire la funzione di bilanciamento automatico del nero

automatico del
nero

con il copriobiettivo montato.

* Non puo essere eseguita durante la registrazione o la
visualizzazione della barra colori.

* Non puo essere eseguita nelle modalita Interval Rec e Slow
& Quick Motion.

AF Micro
Adjustment
Regolazione micro
della posizione di
messa a fuoco
(Abilitata quando
si utilizza un
adattatore LA-
EA2/4 (opzione))

Setting
On / Off

Attiva o disattiva la funzione di regolazione micro della messa
a fuoco.

Amount
Da-20a0a+20

Imposta il livello di regolazione micro della messa a fuoco

automatica.

Utilizzare la seguente procedura per regolare gli obiettivi con

innesto A-mount.

1 Montare Iobiettivo desiderato servendosi di un adattatore
LA-EA2/4 (opzione).

2 Impostare Setting su On e regolare il valore Amount.
Valori positivi spostano la messa a fuoco dietro al soggetto
mentre valori negativi spostano la messa a fuoco davanti al
soggetto.

Si raccomanda di controllare i risultati utilizzando, ad
esempio, la funzione One Push AF durante la regolazione
della messa a fuoco.

Clear All Inizializza il valori di regolazione salvati.
Execute / Cancel
Video Light Video Light Set Imposta il metodo di controllo dell’illuminazione per la luce

Set

Impostazioni della
luce video (quando
si utilizza una luce
HVL-LBPC
(opzione))

Power Link / Rec Link / Rec
Link + Stby

video montata sulla slitta Multi-interface.

Power Link:
Accende e spegne la luce video in sincronia con
I’accensione o spegnimento del camcorder.

Rec Link:
Accende e spegne la luce video in sincronia con I’avvio e
I’arresto della registrazione.

Rec Link + Stby:
Accende e spegne la luce video in sincronia con la
registrazione e lo standby del camcorder.
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Menu Paint

Voce Impostazione della voce Descrizione
secondaria
White Preset White Imposta il valore predefinito del bilanciamento del bianco.

Impostazioni del Da 2100K a 10000K (3200K)

bilanciamento del ~Cg)or Temp <A>
bianco Da 1500K a 50000K (3200K)

Visualizza la temperatura di colore di bilanciamento del
bianco salvata nella memoria A.

Color Temp. Balance <A>
Da -99 a +99 (x0)

Imposta il valore di guadagno del bilanciamento del bianco
salvato nella memoria A (correlato al guadagno R e al
guadagno B).

R Gain <A>
Da -99 a +99 (x0)

Imposta il valore di guadagno R del bilanciamento del bianco
salvato nella memoria A.

B Gain <A>
Da-99 a +99 (x0)

Imposta il valore di guadagno B del bilanciamento del bianco
salvato nella memoria A.

Color Temp <B>
Da 1500K a 50000K (3200K)

Visualizza la temperatura di colore del bilanciamento del
bianco salvata nella memoria B.

Color Temp. Balance <B>
Da -99 a +99 (x0)

Imposta il valore di guadagno del bilanciamento del bianco
salvato nella memoria B (correlato al guadagno R e al
guadagno B).

R Gain <B> Imposta il valore del guadagno R del bilanciamento del bianco
Da -99 a +99 (x0) salvato nella memoria B.
B Gain <B> Imposta il valore del guadagno B del bilanciamento del bianco
Da-99 a +99 (x0) salvato nella memoria B.
Filter White Memory Attiva o disattiva la funzione che imposta I’area di memoria
On/ Off del bilanciamento del bianco per ciascun filtro ND.
On: imposta una memoria del bilanciamento del bianco per
ciascun filtro ND.
Off: imposta una memoria del bilanciamento del bianco
comune a tutti i filtri ND.
Shockless White Imposta la velocita di risposta del bilanciamento del bianco
Off/1/2/3 quando si cambia la modalita di bilanciamento del bianco.
Off: istantanea
da 1 a 3: il passaggio avviene piu lentamente (velocita minore
con numero pil alto)
‘White Switch<B> Seleziona la modalita di regolazione del bilanciamento del
Memory / ATW bianco che viene selezionata quando I’interruttore WHT BAL
¢ impostato su B.
ATW Speed Imposta la velocita di risposta in modalita ATW.
1/2/3/4/5 1: pil alta velocita di risposta
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Voce Impostazione della voce Descrizione

secondaria
Offset White  Offset White <A> Seleziona se aggiungere (On) o non aggiungere (Off) un
Impostazioni di On / Off valore di correzione al valore di bilanciamento del bianco

correzione del

della memoria A.

bilanciamento del
bianco

‘Warm Cool <A>
Da-99 a +99 (x0)

Imposta come temperatura di colore la correzione aggiunta al
bilanciamento del bianco della memoria A quando Offset
White <A> ¢ impostato su “On”.

‘Warm Cool Balance <A>
Da-99 a +99 (x0)

Imposta una temperatura di colore piu precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I'impostazione Warm Cool <A>.

Offset White <B>
On / Off

Seleziona se aggiungere (On) o non aggiungere (Off) un
valore di correzione al valore di bilanciamento del bianco
della memoria B.

‘Warm Cool <B>
Da-99 a +99 (x0)

Imposta come temperatura di colore la correzione aggiunta al
bilanciamento del bianco della memoria A quando Offset
White <B> ¢ impostato su “On”.

‘Warm Cool Balance <B>
Da -99 a +99 (x0)

Imposta una temperatura di colore piu precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I'impostazione Warm Cool <B>.

Offset White<ATW>
On / Off

Specifica se aggiungere (On) o non aggiungere (Off) un valore
di correzione al bilanciamento del bianco ATW.

‘Warm Cool<ATW>
Da -99 a +99 (x0)

Imposta come temperatura di colore la correzione aggiunta al
bilanciamento del bianco ATW quando Offset White<ATW> ¢
impostato su “On”.

‘Warm Cool Balance<ATW>
Da-99 a +99 (x0)

Imposta una temperatura di colore piu precisa, da utilizzare
quando non & possibile ottenere un’immagine soddisfacente
con I'impostazione Warm Cool<ATW>.

Black
Impostazioni del

nero

Setting Attiva o disattiva la correzione del nero
On/ Off
Master Black Imposta il livello del nero master.

Da -99 a +99 (x0)

Per la regolazione fine, ruotare la manopola SEL/SET
lentamente. In questo caso, il valore visualizzato potrebbe non
cambiare.

R Black Imposta il livello R del nero.
Da-99 a +99 (x0)
B Black Imposta il livello B del nero.

Da -99 a +99 (x0)
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Gamma Setting Attiva o disattiva la funzione di correzione della gamma.
Impostazioni di On/ Off
correzione della  §tep Gamma Imposta il valore di correzione della gamma in intervalli di

gamma

Da 0.35 2 0.45 a2 0.90

0.05.

Master Gamma
Da-99 a +99 (x0)

Imposta il livello di gamma master.

R Gamma Imposta il livello di gamma R.
Da -99 a +99 (x0)
G Gamma Imposta il livello di gamma G.

Da -99 a +99 (x0)

B Gamma
Da -99 a +99 (x0)

Imposta il livello di gamma B.

Gamma Category
STD /HG/ User/ S-Log2 /
S-Log3

Seleziona 1’utilizzo della gamma standard (STD),
HyperGamma (HG), gamma utente (User), S-Log2 o S-Log3.

Gamma Select
Quando Gamma Category ¢
impostato su STD:
STD1 DVW /STD2x 4.5/
STD3 x 3.5/ STD4 240M /
STD5 R709 / STD6 x 5.0
Quando Gamma Category &
impostato su HG:
HG1 3250G36 / HG2 4600G30
/HG3 3259G40 / HG4
4609G33 / HG7 8009G40 /
HGS 8009G33
Quando Gamma Category &
impostato su User:
User 1/ User 2/ User 3/ User 4
/ User 5
Quando Gamma Category &
impostato su S-Log2:
S-Log2
Quando Gamma Category ¢
impostato su S-Log3:

Seleziona la tabella di gamma da utilizzare nella correzione
gamma.

Vedere la tabella sottostante per informazioni dettagliate su
HyperGamma e S-Log2/S-Log3.

White Uscita video
Limit cartoncino
Nome G.amm.a (limitaz. 18% grigio
dinamica . .
verso il  (ingresso
bianco) video 20%)
HG1 3250G36 325% 100% 36%
HG2 4600G30 460% 100% 30%
HG3 3259G40 325% 109% 40%
HG4 4609G33 460% 109% 33%
HG7 8009G40 800% 109% 40%
HGS8 8009G33 800% 109% 33%
S-Log2 1300% - 32%
S-Log3 1300% - 41%

S-Log3
Black Gamma Setting Attiva o disattiva la correzione della gamma del nero.
On / Off (Abilitata quando Gamma >Gamma Category ¢ impostata su
STD)
Le funzioni Black Gamma e Knee>Knee Saturation non
possono essere utilizzate allo stesso tempo.
Range Seleziona il campo effettivo della correzione di gamma del

Low / Mid / High

nero.

Master Black Gamma
Da -99 a +99 (x0)

Specifica il livello di gamma del nero master.
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Knee Setting Attiva o disattiva la funzione di correzione del knee
On/ Off (Abilitata quando Gamma >Gamma Category ¢ impostata su
STD)
Auto Knee Attiva o disattiva la funzione di correzione del knee
On/ Off automatica.
Point Imposta il punto knee
Da 75% a 109% (90%)
Slope Imposta la pendenza del knee
Da-99 a +99 (x0)
Knee Saturation Abilita o disabilita la correzione della saturazione knee
On/ Off (corregge il colore sopra il punto di knee).
Le funzioni Black Gamma e Knee>Knee Saturation non
possono essere utilizzate allo stesso tempo.
Knee Saturation Level Imposta il livello di correzione del colore sopra il punto knee
Da-99 a +99 (x0) (saturazione knee)
White Clip Setting Attiva o disattiva la funzione di regolazione del clip del
Impostazioni di On/ Off bianco.
regolazione del
clip del bianco m
» L’impostazione viene ripristinata su On quando si spegne il
camcorder. Per impostarla perennemente su Off, impostare
Level su 109%.
* Non puo essere impostata quando Gamma >Gamma
Category & impostata su S-Log2 or S-Log3.
Level Specifica il livello di clip del bianco.

Da 90.0% a 109.0%

L’impostazione predefinita varia a

seconda del paese di acquisto.
Area NTSC: 108.0%
Area PAL: 105.0%
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Detail Setting Attiva o disattiva la funzione di regolazione dei dettagli.
Impostazioni di On / Off
regola?ione dei Level Imposta il livello del dettaglio.
dettagli Da 99 a +99 (+0)
H/V Ratio Specifica il rapporto di combinazione tra il livello di dettaglio
Da-99 a +99 (x0) H e il livello di dettaglio V.
Crispening Imposta il livello di miglioramento della nitidezza.

Da -99 a +99 (x0)

Level Depend
On/ Off

Attiva o disattiva la funzione di regolazione della dipendenza
del livello.

Level Depend Level
Da -99 a +99 (x0)

Imposta il livello della dipendenza del livello.

Frequency
Da -99 a +99 (x0)

Imposta la frequenza centrale del dettaglio (spessore di
dettaglio).

11 dettaglio & tanto pil sottile quanto pil alta & la frequenza
centrale e tanto pill spesso quanto piu bassa la frequenza
centrale.

Knee Aperture
On / Off

Attiva o disattiva la funzione di correzione dell’apertura del
knee.

Knee Aperture Level
Da -99 a +99 (x0)

Imposta il livello di apertura knee.

Limit Imposta il valore di limitazione del dettaglio sia verso il
Da -99 a +99 (x0) bianco che verso il nero

‘White Limit Imposta il valore di limitazione del dettaglio verso il bianco.
Da-99 a +99 (x0)

Black Limit Imposta il valore di limitazione del dettaglio verso il nero.

Da -99 a +99 (x0)

V Black Limit
Da -99 a +99 (x0)

Imposta il valore di limitazione del dettaglio V verso il nero.

V Detail Creation

Imposta la sorgente del segnale per la creazione del dettaglio

NAM/Y/G/G+R V su NAM (G o R, qualunque sia maggiore), Y, G o G+R.
Skin Detail Setting Attiva o disattiva la funzione di correzione del dettaglio pelle.
Impostazioni di On / Off

correzione del
dettaglio pelle

Area Detection
Execute / Cancel

Identifica il colore utilizzato per la correzione del dettaglio
pelle.
Execute: esegue I’identificazione

Area Indication

Attiva o disattiva la funzione che visualizza il motivo zebra

On / Off nelle aree del colore utilizzato per la correzione del dettaglio
pelle.
Level Imposta il livello del dettaglio pelle.
Da-99 a +99 (x0)
Saturation Imposta la saturazione del colore su cui applicare la
Da -99 a +99 (x0) correzione del dettaglio pelle.
Hue Imposta la tonalita (hue) del colore su cui applicare la
Da 0a 359 correzione del dettaglio pelle.
‘Width Specifica il campo della tonalita (hue) del colore su cui
Da 0 a 90 (40) applicare la correzione del dettaglio pelle.
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Aperture Setting Abilita o disabilita la funzione di correzione dell’apertura, un
Impostazioni di On/ Off processo che permette di migliorare la risoluzione
correzione aggiungendo sul segnale video un segnale di apertura ad alta
dell’apertura frequenza che corregge il degrado dovuto alle caratteristiche
delle alte frequenze.
Level Imposta il livello della correzione di apertura.
Da-99 a +99 (x0)
Matrix Setting Attiva o disattiva la funzione di correzione della matrice.
Impostazioni di On/ Off
correzione della A daptive Matrix Attiva o disattiva la funzione di matrice adattiva.
matrice On/Off
Preset Matrix Attiva o disattiva la funzione di matrice preimpostata.
On/ Off
Preset Select Seleziona una matrice preimpostata.
Standard
High Saturation
FL Light
Cinema
F55 709 Like
User Matrix Attiva o disattiva la funzione di matrice dell’utente.
On / Off
Level Regola la saturazione del colore dell’intera immagine.
Da -99 a +99 (x0)
Phase Regola il tono di colore (la fase) dell’intera immagine.

Da-99 a +99 (x0)

User Matrix R-G
Da -99 a +99 (x0)

Imposta una matrice R-G definita dall’ utente.

User Matrix R-B
Da -99 a +99 (x0)

Imposta una matrice R-B definita dall’utente.

User Matrix G-R
Da -99 a +99 (x0)

Imposta una matrice G-R definita dall’utente.

User Matrix G-B
Da -99 a +99 (x0)

Imposta una matrice G-B definita dall’utente.

User Matrix B-R
Da-99 a +99 (x0)

Imposta una matrice B-R definita dall’utente.

User Matrix B-G
Da -99 a +99 (x0)

Imposta una matrice B-G definita dall’ utente.
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secondaria
Multi Matrix Setting Attiva o disattiva la correzione multimatrice
Impostazioni di On / Off
correzione Area Indication Attiva o disattiva la funzione di indicazione dell’area.
multimatrice On/ Off
Color Detection Identifica il colore utilizzato per la correzione multimatrice.
Execute / Cancel
Axis Seleziona I’asse.
B /B+/MG-/MG /MG+/
R/R+/YL-/YL/YL+/G-/
G/G+/CY/CY+/B-
Hue Imposta la tonalita (hue) del colore per la correzione
Da-99 a +99 (x0) multimatrice.
Saturation Imposta la saturazione del colore utilizzato per la correzione
Da -99 a +99 (x0) multimatrice.
Maintenance  Test Saw Attiva o disattiva il segnale di prova.
Impostazioni di On/ Off
manutenzione
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Menu Audio

Voce Impostazione della voce
secondaria

Descrizione

Audio Input CH1 Input Select

Seleziona la sorgente di ingresso per la registrazione sul

Impostazioni di INPUT1 / Internal MIC / canale 1.
ingresso audio Shoe 1
CH2 Input Select Seleziona la sorgente di ingresso per la registrazione sul
INPUT1 / INPUT2/ canale 2.
Internal MIC / Shoe 2

CH3 Input Select
Off / Internal MIC / Shoe 1

Seleziona la sorgente di ingresso per la registrazione sul
canale 3.

CH4 Input Select
Off / Internal MIC / Shoe 2

Seleziona la sorgente di ingresso per la registrazione sul
canale 4.

INPUT1 MIC Reference
—60dB / -50dB / -40dB

Imposta il livello di riferimento di registrazione dell’ingresso
microfono XLR su INPUTI.

INPUT2 MIC Reference
—60dB / -50dB / -40dB

Imposta il livello di riferimento di registrazione dell’ingresso
microfono XLR su INPUT2.

CH1 Wind Filter

Abilita o disabilita il filtro di riduzione del rumore del vento

On / Off per la registrazione del canale 1.

CH2 Wind Filter Abilita o disabilita il filtro di riduzione del rumore del vento
On / Off per la registrazione del canale 2.

CH3 Wind Filter Abilita o disabilita il filtro di riduzione del rumore del vento
On / Off per la registrazione del canale 3.

CH4 Wind Filter Abilita o disabilita il filtro di riduzione del rumore del vento
On / Off per la registrazione del canale 4.

CH3 Level Control Seleziona la regolazione del livello di ingresso audio
Auto / Manual automatica o manuale per la registrazione sul canale 3.

Se CH3 Input Select oppure CH4 Input Select sono impostati
su “Internal MIC”, CH4 viene impostato su automatico o
manuale in accordo con questa impostazione.

CH4 Level Control
Auto / Manual

Seleziona la regolazione del livello di ingresso audio
automatica o manuale per la registrazione sul canale 4.

Se CH3 Input Select oppure CH4 Input Select sono impostati
su “Internal MIC”, CH4 viene impostato su automatico o
manuale in accordo I’'impostazione di CH3 Level Control.

CH3 Input Level
Da 0299 (49)

Imposta il livello di ingresso audio per la registrazione del
canale 3.

Se CH3 Input Select oppure CH4 Input Select sono impostati
su “Internal MIC”, I'opzione CH4 Input Level viene impostata
in accordo con questa impostazione.
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Voce

Impostazione della voce
secondaria

Descrizione

CH4 Input Level Imposta il livello di ingresso audio per la registrazione del
Da0a99(49) canale 4.
Se CH3 Input Select oppure CH4 Input Select sono impostati
su “Internal MIC”, I’opzione CH4 Input Level viene impostata
in accordo con I’'impostazione di CH3 Input Level.
Audio Input Level Imposta il livello di ingresso audio.
Da0a99 Utilizzabile come volume master secondo le impostazioni delle
opzioni CH Level da 1 a 4.
Limiter Mode Seleziona la caratteristica di limitazione per i segnali di
Off / —6dB / -9dB / -12dB / ingresso di livello elevato quando il livello di ingresso audio
—15dB /-17dB viene regolato manualmente.
CH1&2 AGC Mode Imposta la modalita di regolazione livello automatica per la
Mono / Stereo registrazione sui canali 1 e 2.
CH3&4 AGC Mode Imposta la modalita di regolazione livello automatica per la
Mono / Stereo registrazione sui canali 3 e 4.
AGC Spec Seleziona la caratteristica AGC.
—6dB /-9dB /-12dB /
—15dB / -17dB
1kHz Tone on Color Bars Attiva o disattiva I’emissione del segnale di tono di
On / Off riferimento a 1 kHz durante la visualizzazione delle barre
colore.
Se impostato su On, viene impostato il segnale di tono di
riferimento a 1 kHz per la registrazione sui canali 3 e 4, anche
se CH3 Input Select e CH4 Input Select sono impostati su Off.
CHI Level Imposta la combinazione delle regolazioni del livello di

Ingresso senza adattatore XLR
Audio Input Level / Side /
Level+Side

Ingresso con adattatore XLR

(pagina 55)

Audio Input Level / Through

ingresso audio abilitate per la registrazione del canale 1.

“Side” indica la manopola CH1 INPUT LEVEL sul lato del
camcorder. Se € selezionato Level+Side, il livello di
registrazione audio & determinato dalla combinazione di
Audio Input Level e la posizione della manopola

(pagina 138).

CH2 Level

Ingresso senza adattatore XLR
Audio Input Level / Side /
Level+Side

Ingresso con adattatore XLR

(pagina 55)
Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di
ingresso audio abilitate per la registrazione del canale 2.

“Side” indica la manopola CH2 INPUT LEVEL sul lato del
camcorder. Se € selezionato Level+Side, il livello di
registrazione audio & determinato dalla combinazione di
Audio Input Level e la posizione della manopola

(pagina 138).

81



Voce

Impostazione della voce
secondaria

Descrizione

CH3 Level

Ingresso senza adattatore XLR
Audio Input Level / CH3 Input
Level / Level+CH3 Input
Level

Ingresso con adattatore XLR

(pagina 55)
Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di
ingresso audio abilitate per la registrazione del canale 3.

Se & selezionato Level+CH3 Input Level, il livello di
registrazione audio & determinato dalla combinazione di
Audio Input Level e CH3 Input Level (pagina 139).

CH4 Level

Ingresso senza adattatore XLR
Audio Input Level / CH4 Input
Level / Level+CH4 Input
Level

Ingresso con adattatore XLR

(pagina 55)
Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di
ingresso audio abilitate per la registrazione del canale 4.

Se ¢ selezionato Level+CH4 Input Level, il livello di
registrazione audio & determinato dalla combinazione di
Audio Input Level e CH4 Input Level (pagina 139).

Audio Output
Impostazioni
uscita audio

Monitor CH
CH1/CH2 / CH3/CH4 / MIX
ALL/CHI1/CH2/CH3/CH4

Seleziona I’uscita del canale audio sul connettore cuffie e
1’altoparlante incorporato.

Se I’audio € impostato per 1’uscita simultanea su pil di un
canale, il livello di uscita di ciascun canale viene ridotto per
evitare il clipping.

Monitor Volume

Regola il livello di uscita dell’audio di monitoraggio sul

Da0al5(7) connettore cuffie e I’altoparlante incorporato.

Headphone Out Specifica se 1’uscita del connettore cuffie deve essere mono o
Mono / Stereo stereo.

Alarm Volume Regola il volume dell’allarme.
Da0a7(4)

Output Limiter Attiva o disattiva il limitatore di uscita audio.
On/ Off

HDMI Output CH Imposta la combinazione dei canali audio sull’uscita HDMI.
CH1/CH2 / CH3/CH4
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Menu Video

Voce Impostazione della voce Descrizione
secondaria

Output On/Off SDI Attiva o disattiva 1’uscita SDL

Impostazioni di On/ Off

uscita video HDMI Attiva o disattiva I’uscita HDMI.

On/ Off

Output Format SDI Imposta la risoluzione delle uscite SDI e HDMI.

Impostazioni del  gpm Per informazioni dettagliate su queste impostazioni, vedere

formato di uscita REF “Formati video e segnali di uscita” (pagina 111).
L’impostazione Output Format potrebbe non essere
configurabile nella modalita Picture Cache Rec. In tal caso,
impostare provvisoriamente Picture Cache Rec su Off e
modificare le impostazioni desiderate.

Output Setting HDMI Target Device Imposta il tipo di dispositivo di ingresso HDMI connesso

Impostazioni della Recorder / Monitor all’uscita HDML.

modalita di
conversione in
uscita

Recorder:
In modalita Cine EI, emette in uscita su HDMI lo stesso
video di SDII.

Monitor:
In modalita Cine EI, emette in uscita su HDMI lo stesso
video di SDI2.

4K/2K to HD Conv.
Edge Crop / Letter Box

Imposta la modalita di conversione per 1’uscita video HD di
video 17:9.
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Voce Impostazione della voce
secondaria

Descrizione

Monitor LUT  Categoria

Impostazioni del LUT / Look Profile / User 3D
LUT monitor. LUT

Disponibile solo in

modalita Cine EI.

Puo non essere
possibile
impostare un
Monitor LUT
indipendente per
ciascun sistema
(pagina 124).

Imposta il tipo di Look applicato come Monitor LUT.

LUT:
Emette in uscita video a cui € applicato il LUT
preimpostato oppure il LUT utente.

Look Profile:
Selezionando il numero di Look opportuno, emette video
simile alla pellicola stampata o adatto come punto di inizio
del grading del colore.

User 3D LUT:
Emette in uscita video con applicato il 3D LUT utente.

User 3D LUT non puo essere selezionato se si imposta Base
Setting >Color Space su S-Gamut/S-Log2 nel menu System.

LUT Select

P1: 709(800%)
P2: HG8009G40
P3: HG8009G33
P4: S-Log2

P5: S-Log3

Ul

U2

U3

U4

us

U6

Seleziona il tipo di LUT, quando Monitor LUT >Category ¢

impostato su LUT.

709(800%):
Segnale con curva di base ITU-R709 con gamma dinamica
estesa fino a 800%.

HG8009G40:
Segnale con HyperGamma con gamma dinamica 800%,
limite del bianco 109% e uscita video scheda grigio 18% al
40%.

HG8009G33:
Segnale con HyperGamma con gamma dinamica 800%,
limite del bianco 109% e uscita video scheda grigio 18% al
33%.

S-Log2:
Segnale di log con gamma dinamica del 1300% che tiene
conto della visibilita su un monitor video, con sviluppo
delle riprese in sede di post produzione.
(Abilitato quando Base Setting >Color Space nel menu
System & impostato su S-Gamut/SLog?2)

S-Log3:
Segnale di log con gamma dinamica del 1300% che imita
le caratteristiche della pellicola, simile alla curva Cineon
Log.
(Abilitato quando Base Setting >Color Space nel menu
System ¢ impostato su S-Gamut3.Cine/SLog3 o S-Gamut3/
SLog3)

Da Ul a U6:
Segnali LUT utente importati da una scheda SD.

Selezionare F55/F5 come formato di uscita quando si
crea un LUT usando RAW Viewer.

Creare e memorizzare i file LUT nella seguente cartella
di una scheda SD:

\PRIVATE\SONY\PRO\CAMERA\PMWEF55_F5
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Voce Impostazione della voce
secondaria

Descrizione

Look Profile Select

Seleziona il tipo di profilo Look quando Monitor LUT

1: LC-709 >Category ¢ impostato su Look Profile.
2: LC-709typeA
3: SLog2-709
4: Cine+709
User 3D LUT Select Seleziona il tipo di 3D LUT utente.
User 3D-1
User 3D-2
User 3D-3
User 3D-4
SDII & Internal Rec Seleziona se applicare il LUT monitor all’uscita video SDI
MLUT On/ MLUT Off OUT! e ai video registrati su schede di memoria XQD.
SDI2 Seleziona se applicare il LUT monitor all’uscita video SDI
MLUT On/ MLUT Off OUT2.
HDMI Indica se il LUT monitor ¢ applicato all’uscita video HDMI
MLUT On/ MLUT Off (pagina 124).
Mirino Seleziona se applicare il LUT monitor all’uscita video sul
MLUT On/ MLUT Off mirino.
Output Display SDI2 Seleziona se sovraimporre menu e stato sui segnali di uscita
Impostazioni del On/ Off SDI e HDMI.
segnale di uscita  gpMmI
On/ Off
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Menu VF

Voce Impostazione della voce Descrizione
secondaria
VF Setting Brightness Regola la luminosita dell’immagine del mirino.
Impostazioni del Da -99 a +99 (x0)
mirino Color Mode Seleziona la modalita di visualizzazione del mirino in
Color / B&W modalita di registrazione o E-E.
Peaking Setting Attiva o disattiva la funzione Peaking.
Impostazioni di On / Off
peaking Peaking Type Seleziona il tipo di peaking.
Normal / Color Normal: peaking normale
Color: peaking a colori
Frequency Seleziona la frequenza di peaking.
Normal / High
Normal Peaking Level Imposta il livello di peaking normale.
Da 0a 99 (50)
Color Seleziona il colore del segnale di peaking colore.
B&W /Red / Yellow / Blue
Color Peaking Level Imposta il livello del peaking colore.
Da0a99 (50)
Zebra Setting Attiva o disattiva la funzione Zebra.
Impostazioni del On / Off
motivo zebra Zebra Select Seleziona il tipo di motivo zebra (Zebral, Zebra2, Both).
1/2/Both

Zebral Level
Da 0% a 107% (70%)

Imposta il livello di visualizzazione del motivo Zebral.

Zebral Aperture Level
Da 1% a 20% (10%)

Imposta il livello di apertura del motivo Zebral.

Zebra2 Level
Da 0% a 109% (100%)

Imposta il livello di visualizzazione del motivo Zebra2.

86



Voce Impostazione della voce Descrizione
secondaria
Marker Setting Attiva o disattiva la visualizzazione di tutti gli indicatori.
Impostazioni di On/ Off
visualizzazione Color Seleziona il colore del segnale dell’indicatore.

degli indicatori

White / Yellow / Cyan / Green /

Magenta / Red / Blue

Center Maker
1/2/3/4/0Off

Attiva o disattiva la visualizzazione dell’indicatore centrale.

Safety Zone
On / Off

Attiva o disattiva la visualizzazione dell’indicatore della zona
di sicurezza.

Safety Area
80% / 90% / 92.5% 1 95%

Seleziona le dimensioni dell’indicatore della zona di sicurezza
(come percentuale delle dimensioni totali dello schermo).

Aspect Marker Seleziona il tipo di indicatore di aspetto.
Line / Mask / Off
Aspect Mask Imposta il livello del segnale video all’esterno dell’indicatore

Da0al5(12)

su un valore percentuale relativo al segnale all’interno
dell’indicatore.

Aspect Safety Zone
On/ Off

Attiva o disattiva la visualizzazione della zona di sicurezza di
aspetto.

Aspect Safety Area
80% /90% / 92.5% 1 95%

Seleziona le dimensioni dell’indicatore della zona di sicurezza
di aspetto come percentuale delle dimensioni totali dello
schermo.

Aspect Select Imposta la modalita di visualizzazione dell’indicatore di
4:3/1.66:1/ aspetto.
1.85:1/2.35:1/2.4:1

User Box Attiva o disattiva la visualizzazione del cursore a riquadro.
On / Off

User Box Width Specifica la larghezza del cursore a riquadro (distanza dal
Da 3 a 479 (240) centro ai bordi destro e sinistro).

User Box Height Specifica I’altezza del cursore a riquadro (distanza dal centro
Da 3 a269 (135) al bordo superiore e inferiore).

User Box H Position
Da -476 a +476 (0)

Imposta la posizione orizzontale del centro del cursore a
riquadro.

User Box V Position
Da -266 a +266 (0)

Specifica la posizione verticale del centro del cursore a
riquadro.

100% Marker Attiva o disattiva la visualizzazione dell’indicatore 100%.
On / Off

Guide Frame Attiva o disattiva la visualizzazione del riquadro di guida.
On / Off
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Voce

Impostazione della voce
secondaria

Descrizione

Display On/Off
Impostazioni della
visualizzazione
delle indicazioni

Setting
On/ Off

Seleziona gli elementi da visualizzare nel mirino.

Shutter Setting
On/ Off

ND Filter Position
On/ Off

Gain Setting
On/ Off

Rec/Play Status
On/ Off

HXR-IFRS5 Rec Control
On/ Off

Color Temp.
On/ Off

Frame Rate / Interval
On/ Off

Battery Remain
On/ Off

Timecode
On/ Off

Audio Manual
On/ Off

Audio Level Meter
On/ Off

Media Status
On/ Off

Focus Position
Meter / Feet / Off

Iris Position
On/ Off

Zoom Position
Number / Bar / Off

SteadyShot
On/ Off

Focus Mode
On/ Off

Focus Area Indicator
On/ Off

Focus Area Ind. (Push AF)
On/ Off

Focus Indicator
On/ Off

Auto Shutter
On/ Off

AGC
On/ Off

Auto Iris
On/ Off
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Voce

Impostazione della voce
secondaria

Descrizione

Auto Exposure Level
On/ Off

White Balance Mode
On/ Off

SDI/HDMI Rec Control
On/ Off

Rec Format
On/ Off

Gamma
On/ Off

Timecode Lock
On/ Off

Wi-Fi Condition
On/ Off

Clip Name
On / Off

Focus Assist Indicator
On/ Off

Focus Area Marker
On/ Off

Video Level Warning
On/ Off

Clip Number
On/ Off

GPS
On/ Off

Level Gauge
On/ Off

Lens Info
Meter / Feet / Off

Notice Message
On/ Off

Video Signal
Monitor
Impostazioni del
monitor del
segnale video
(pagina 53)

Setting
Off / Waveform / Vector /
Histogram

Imposta il tipo di monitor del segnale video.

Non visualizzato se Display On/Off >Setting & impostato su
Off.

Source
In modalita Cine EI con

risoluzione di uscita video di

2K o inferiore:

SDI1 & Internal Rec / SDI2

In modalita Custom o in
modalita Cine EI con

risoluzione di uscita video

superiore a 2K:
Internal Rec

Imposta la sorgente di misura del monitor del segnale video.
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Menu TC/UB

TC/UB

Voce Impostazione della voce Descrizione
secondaria
Timecode Mode Imposta la modalita di avanzamento del codice temporale.
Impostazioni del Preset / Regen / Clock Preset:
codice temporale 11 codice temporale inizia da un valore preimpostato.
Regen:
11 codice temporale prosegue dall’ultimo valore del clip
precedente.
Clock:
Utilizza I’orologio interno come codice temporale.
Run Rec Run: Avanza solo durante la registrazione.

Rec Run/ Free Run

Free Run: Avanzamento costante, indipendentemente
dall’accensione del camcorder.

Setting Imposta il codice temporale su un valore arbitrario.
SET: Imposta il valore.
Reset Azzera il codice temporale (00:00:00:00)
Execute / Cancel Execute: Azzera il codice temporale
TC Format Imposta il formato del codice temporale.
DF / NDF DF: Drop Frame

NDF: Non-Drop Frame

TC Display Display Select Consente di scegliere quali dati temporali devono essere

Impostazioni di Timecode / Users Bit / visualizzati.

visualizzazionedei ~ Duration

dati temporali

User Bit Mode Imposta la modalita del bit utente.

Impostazioni Fix / Time Fix: Utilizza per i bit utente un valore fisso arbitrario.

relative ai bit Time: Utilizza I’ora corrente nei bit utente.

utente. Setting Imposta i bit utente su un valore arbitrario.

HDMI TC Out  Setting Consente di selezionare se emettere il codice temporale ad
On / Off altri dispositivi per altri scopi, tramite HDMI.
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Menu Recording

Voce Impostazione della voce

secondaria

Descrizione

S&Q Motion
Impostazioni della
modalita Slow &
Quick Motion
(pagina 48)

Setting
On / Off

Attiva o disattiva la modalita Slow & Quick Motion.
Quando ¢ impostato su On, le seguenti funzioni sono
disabilitate:

* Auto Iris

¢ Auto Focus

High Frame Rate Mode
Off / Full Scan / Center Scan

Consente di utilizzare una velocita di imaging superiore a 60P.
Off:
Non consente di utilizzare una velocita di imaging
superiore a 60P.
Full Scan:
Imaging ad alta velocita dell’angolo di visuale del formato
Super 35mm.
Center Scan:
Imaging ad alta velocita di meta dell’angolo di visuale del
formato Super 35mm al centro dell’immagine.

Non ¢ possibile adeguare questa impostazione a Imager Scan
Mode se Imager Scan Mode ¢ impostata su 2K Full o 2K
Center.

Frame Rate
Fino a 240fps

Imposta la frequenza fotogrammi per le riprese in modalita
Slow & Quick Motion.

11 valore iniziale varia a seconda delle impostazioni di Codec,
Country, Video Format e RAW Output Format.

Interval Rec
Impostazioni di
Interval Rec

Setting
On / Off

Attiva o disattiva la modalita di registrazione a intervalli
(Attivando questa modalita, si disattivano tutte le altre
modalita speciali).

(pagina 49) Interval Time
1/2/3/4/5/6/7/819/
10/15/20/30/40/50 (sec)
1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50/ (min) 1/
2/3/4/6/12/24 (ore)

Imposta I'intervallo fra registrazioni nella modalita di
registrazione Interval Rec (Interval Rec impostata su On).

Number of Frames
1frame / 2frames / 3frames /
6frames / 9frames / 12frames

Imposta il numero di fotogrammi per ciascuna ripresa nella
modalita di registrazione Interval Rec (Interval Rec impostata
su On).
1 valori disponibili variano a seconda della frequenza
fotogrammi del formato video selezionato.
50P/59.94P:

2frames / 6frames / 12frames
23.98P /25P /29.97P / 50i / 59.94i:

1frame / 3frames / 6frames / 9frames

Pre-Lighting
Disponibile solo se viene utilizzata
la luce video HVL-LBPC
(opzionale).

Off / 2sec / 5sec / 10sec

Specifica con che anticipo in secondi si deve accendere la luce
video prima dell’avvio della registrazione in modalita Interval
Rec.
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Voce Impostazione della voce

secondaria

Descrizione

Picture Cache Setting
Rec On / Off

Attiva o disattiva la funzione di registrazione cache immagine.

Impostazioni della Cache Rec Time
modalita di 0-2sec / 2-4sec / 4-6sec /

Imposta il tempo di registrazione cache immagine quando
Picture Cache Rec ¢ impostato su On.

registrazionecache  §-8sec / 8-10sec /

immagine 10-12sec / 12-14sec /

(pagina 50) 13-15sec

Simul Rec Setting Attiva o disattiva la funzione di registrazione simultanea e
Impostazioni della On / Off specifica il supporto di destinazione della registrazione.
registrazione Rec Button Set Seleziona i pulsanti utilizzati per controllare la registrazione
simultanea “Rec Button [SlotA SlotB] sui vari supporti di registrazione.

(pagina 39) Handle Rec Button [SlotA

SlotB]” / “Rec Button [SlotA]
Handle Rec Button [SlotB]” /

“Rec Button [SlotB] Handle
Rec Button [SlotA]”

SDI/HDMI Rec  Setting
Control On/ Off
Impostazioni della
registrazione SDI/

HDMI

Attiva o disattiva I’avvio e I’arresto della registrazione, tramite
i segnali SDI/HDMI, per un dispositivo esterno connesso.
Quando sono assegnati pulsanti diversi con Rec Button Set, il
segnale di controllo registrazione segue lo stato di
registrazione dello slot A.

Se impostato su On, arresta o avvia la registrazione su un
dispositivo esterno collegato anche se non ¢ inserita nessuna
scheda XQD.
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Menu Thumbnail

Thumbnail

Voce Impostazione della voce Descrizione
secondaria

Display Clip Visualizza la schermata delle proprieta dei clip.
Properties
Schermata di
visualizzazione
delle proprieta dei
clip
Set Index Specifica I'immagine indice del clip.
Picture
Impostazioni
relative
all’immagine
indice
Thumbnail Essence Mark Thumbnail Visualizza le miniature di tutti i fotogrammi contenenti
View All / Rec Start / Shot Markl /  essence mark (indicatori di identificazione).
Impostazioni della Shot Mark?2 / Shot Mark3 /
schermata delle Shot Mark4 / Shot Mark5 /
miniature Shot Mark6 / Shot Mark7 /

Shot Mark8 / Shot Mark9 /

Shot Mark0

Clip Thumbnail

Visualizza miniature dei clip registrati.

Set Shot Mark Add Shot Mark1

Aggiunge lo Shot Mark1

Impostazioni Delete Shot Mark1 Elimina lo Shot Mark1

;;l:r‘l‘("gna(il;j:r‘;‘ i Add Shot Mark2 Aggiunge lo Shot Mark2

ripresa) Delete Shot Mark2 Elimina lo Shot Mark2

Set Clip Flag  Add OK Aggiunge un flag OK.

Impostazioni ~ Add NG Aggiunge un flag NG.

:il;uve aiflag dei Add KEEP Aggiunge un flag Keep.
Delete Clip Flag Elimina tutti i flag.

Lock/Unlock  Select Clip Seleziona e blocca/sblocca un clip.

Clip Lock All Clips Blocca tutti i clip.

Protezione clip 10 A Clips Sblocca tutti 1 clip.

Delete Clip Select Clip Elimina il clip selezionato.

Elimina clip All Clips Elimina tutti i clip visualizzati.

Filter Clips OK

Visualizza solo i clip che contengono un flag OK.

Impostazioni di NG

Visualizza solo i clip che contengono un flag NG.

visualizzazione

KEEP isualizza solo i clip ch flag Keep.
filtrata dei clip Visualizza solo i clip che contengono un flag Keep.

None Visualizza solo i clip che non contengono nessun flag.
Customize Thumbnail Caption Seleziona le informazioni visualizzate sotto le miniature.
View Date Time / Time Code /

Impostazioni della
schermata delle
miniature

Duration / Sequential Number
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Menu Media

Voce Impostazione della voce Descrizione

secondaria
Update Media Media (A) Aggiorna il file di gestione della scheda di memoria XQD
Aggiorna le Execute / Cancel nello slot A.

schede di memoria

Execute: Aggiorna la scheda

Media (B)
Execute / Cancel

Aggiorna il file di gestione della scheda di memoria XQD
nello slot B.
Execute: Aggiorna la scheda

Format Media Media (A)

Inizializza la scheda di memoria XQD nello slot A.

Formatta Execute / Cancel Execute: Inizializza scheda
(inizializ;a) Media (B) Inizializza la scheda di memoria XQD nello slot B.
schede di memoria  Execute / Cancel Execute: Inizializza scheda
SD Card Inizializza la scheda SD UTILITY.
Execute / Cancel Execute: Inizializza scheda
Clip Auto Naming Imposta il metodo per I’assegnazione di nomi ai clip.
Impostazioni del Cam ID + Reel#/ Title Cam ID + Reel#:

nome dei clip

Identificativo videocamera + numero bobina + numero
ripresa + data + stringa casuale

Title:
Stringa impostata tramite Title Prefix + numero del clip

Quando Simul Rec ¢ impostato su On, Cam ID + Reel# non
puo essere configurato.

Camera ID
DaAaZ

Imposta I'identificativo della videocamera quando Auto
Naming ¢ impostato su Cam ID + Reel#.

Reel Number
Da 001 a 999

Imposta la porzione numerica del numero della bobina quando
Auto Naming & impostato su Cam ID + Reel#.

Camera Position
C/L/R

Imposta il prefisso del numero della ripresa quando Auto
Naming ¢ impostato su Cam ID + Reel#.

Title Prefix

Imposta la porzione del titolo del nome del clip quando Auto
Naming ¢ impostato su Title.

(Il valore iniziale ¢ un identificativo basato sul modello, che
comprende le ultime tre cifre del numero di serie).

(Il valore viene inserito utilizzando la schermata di
inserimento caratteri (pagina 64)).

Number Set
Da 0001 a 9999

Imposta la porzione numerica del nome del clip quando Auto
Naming ¢ impostato su Title.
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Menu File

Voce Impostazione della voce Descrizione
secondaria
All File Load SD Card Carica un file ALL.
Impostazioni Execute / Cancel Execute: Carica il file
relative ai file Save SD Card Salva un file ALL.
ALL. Execute / Cancel Execute: Salva il file
File ID Assegna un nome al file.
Scene File Recall Internal Memory Carica un file di scena dalla memoria interna.

Impostazioni dei
file di scena

Execute / Cancel

Execute: Carica il file

Store Internal Memory
Execute / Cancel

Salva un file di scena nella memoria interna.
Execute: Salva il file

Load SD Card Carica un file di scena dalla scheda SD.
Execute / Cancel Execute: Carica il file
Save SD Card Salva un file di scena su una scheda SD.
Execute / Cancel Execute: Salva il file
File ID Assegna un nome al file.
Scene White Data Seleziona se applicare o meno i dati di bilanciamento del
On / Off bianco quando si caricano file di scena.
User Menu Load SD Card Carica le impostazioni del menu utente da una scheda SD alla
Item Execute / Cancel memoria interna.

Impostazioni delle
voci del menu
utente

Execute: Carica le impostazioni

Save SD Card Salva le impostazioni del menu utente su una scheda SD.
Execute / Cancel Execute: Salva le impostazioni
File ID Visualizza il File ID specificato per il file caricato mediante

Load SD Card. Inoltre, imposta o modifica il File ID quando si
salva un file mediante questo menu.

User Gamma
Impostazioni file
gamma utente

Current Settings

Visualizza un elenco delle impostazioni del file gamma utente
correnti (nome dei file).

Load SD Card
Execute / Cancel

Carica le impostazioni di gamma utente da una scheda SD alla
memoria interna.

Execute: Carica la gamma

Per utilizzare sul camcorder i file di camma creati con
CvpFileEditor™ V4.2, salvare i file nella seguente cartella
della scheda SD:
PRIVATE\SONY\PRO\CAMERA\HD_CAM

Reset
1/2/3/4/5/7A1
Valore iniziale: 709(800%)

Ripristina i valori predefiniti dei file di gamma utente
contenuti nella memoria interna.

Da 1 a 5: Ripristina gamme utente specifiche.

All: Ripristina tutte le gamme utente.
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Voce Impostazione della voce Descrizione
secondaria
Monitor LUT  Current Settings Visualizza un elenco delle impostazioni del file LUT monitor

Impostazioni del

correnti (nome dei file).

file LUT monitor.

Load SD Card
Execute / Cancel

Carica le impostazioni di LUT monitor da una scheda SD alla
memoria interna.

Execute: Carica le impostazioni di LUT

Salvare i file LUT utente generati con RAW Viewer nella
seguente cartella della scheda SD:
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Reset
1/2/3/4/5/6/A1

Ripristina i valori predefiniti di LUT monitor contenuti nella
memoria interna.

Da 1 a 6: Ripristina i LUT monitor specificati.

All: Ripristina tutti i LUT monitor.

Monitor 3D Current Settings Visualizza un elenco delle impostazioni del file LUT 3D
LUT monitor correnti (nome dei file).
Impostazioni del [ oad SD Card Carica le impostazioni di LUT 3D monitor da una scheda SD
file LUT 3D Execute / Cancel alla memoria interna.
monitor. Execute: Carica le impostazioni di LUT 3D
E possibile importare file CUBE (*.cube) con risoluzione di
reticolo 17 o 33 creati con Catalyst Browse, RAW Viewer, o
BMD Da Vinci Resolve*.
* Verificato con Resolve V9.0, V10.0, and V11.0.
Se si crea un file CUBE con Catalyst Browse o RAW Viewer,
impostare Source in Catalyst Browse o Input in RAW Viewer
su S-Gamut3.Cine/S-Log3.
Impostare Format su Resolve quando si esporta il file CUBE.
Salvare i dati 3D LUT creati (file User 3D LUT) nella
seguente cartella della scheda SD.
PRIVATE\SONY\PRO\CAMERA\PMWEFS55_F5
 Nota |
La funzione Monitor 3D LUT non puo essere selezionata se si
imposta Base Setting >Color Space su S-Gamut/S-Log2 nel
menu System del camcorder.
Reset Ripristina i valori predefiniti di LUT 3D monitor contenuti
1/2/3/74/Al nella memoria interna.
Da 1 a 4: Ripristina i LUT 3D monitor specificati.
All: Ripristina tutti i LUT 3D monitor.
Lens File White Offset R Imposta il valore di correzione del bilanciamento del bianco
Impostazioni del Da -99 a +99 (x0) del canale R dell’obiettivo nel file obiettivo.
file obiettivo White Offset B Imposta il valore di correzione del bilanciamento del bianco

Da-99 a +99 (x0)

del canale B dell’obiettivo nel file obiettivo.

Salvare i file nelle cartelle della scheda SD indicate di seguito.
File ALL, file Scene, User Menu Item:
PRIVATE\Sony\PRO\CAMERA\PXW-FS7
File di gamma utente:
PRIVATE\Sony\PRO\CAMERA\HD_CAM
File di Monitor LUT, file di monitor LUT 3D:
PRIVATE\Sony\PRO\CAMERA\PMWF55_F5
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Menu System

Voce Impostazione della voce Descrizione
secondaria
Base Setting  Shooting Mode Imposta la modalita di ripresa.

Impostazioni di

Custom / Cine EI

base

Color Space
S-Gamut/SLog2 /
S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3 / Matrix

Imposta lo spazio colore.

Imager Scan Mode
Normal / 2K Full / 2K Center

Imposta la modalita di scansione del sensore immagini per la
cattura delle informazioni (pagina 27).

Codec
Impostazioni
codec

Select
RAW/RAW & XAVC-1/RAW
& XAVC-L / RAW & MPEG
HD 422 / XAVC-1/ XAVC-L /
MPEG HD 422 / ProRes 422
HQ / ProRes 422

Imposta la modalita di registrazione/riproduzione.

* Le opzioni RAW / RAW & XAVC-1/RAW & XAVC-L/
RAW & MPEG HD 422 sono disponibili quando ¢ collegata
un’unita di estensione XDCA-FS7 e Base Setting >Shooting
Mode ¢ impostato su Cine EI.

* Le opzioni ProRes 422 HQ / ProRes 422 sono disponibili
solo quando ¢ collegata un’unita di estensione XDCA-FS7.
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Voce Impostazione della voce Descrizione
secondaria
Rec Format Video Format Imposta il formato di registrazione.
Impostazioni del
formato di * Per sistemi NTSC: e Per sistemi PAL:
registrazione Quando Codec >Select ¢ impostato  Quando Codec >Select ¢ impostato su XAVC-I:
su XAVC-I: 4096x2160 50P
4096x2160 59.94P 4096x2160 25P
4096x2160 29.97P 3840x2160 50P
4096x2160 24.00P 3840x2160 25P
4096x2160 23.98P 19201080 50P
3840x2160 59.94P 1920x1080 501
3840x2160 29.97P 19201080 25P

3840x2160 23.98P
1920x1080 59.94P

Quando Codec >Select ¢ impostato su XAVC-L:
3840x2160 50P

1920x1080 59.94i 3840x2160 25P
1920x1080 29.97P 1920x1080 50P 50
1920x1080 23.98P 1920x1080 50P 35
Quando Codec >Select ¢ impostato 1920x1080 50i 50
su XAVC-L: 1920x1080 50i 35
3840x2160 59.94P 1920x1080 50i 25
38402160 29.97P 1920x1080 25P 50
3840x2160 23.98P 19201080 25P 35
1920%x1080 59.94P 50 Quando Codec >Select ¢ impostato su MPEG HD422:
1920x1080 59.94P 35 1920x1080 50i 50
1920x1080 59.94i 50 1920x1080 25P 50
1920x1080 59.94i 35 1280x720 50P 50
1920x1080 59.94i 25 1280x720 25P 50
1920x1080 29.97P 50 Quando Codec >Select ¢ impostato su ProRes 422 HQ o
1920x1080 29.97P 35 ProRes 422:
1920x1080 23.98P 50 1920%x1080 50i
1920x1080 23.98P 35 1920x1080 25P

Quando Codec >Select ¢ impostato
su MPEG HD422: m

1920x1080 59.94i 50 e “---” non ¢ disponibile (grigio) quando Codec >Select &
1920x1080 29.97P 50 impostato su RAW.

19201080 23.98P 50 * I valori fissi non sono disponibili (grigi) quando Codec
1280x720 59.94P 50 >Select & impostato su RAW & XAVC-I, RAW & XAVC-L
1280%720 29.97P 50 o RAW & MPEG HD 422.

« Il formato di registrazione non puo essere impostato su
4096x2160 o 3840x2160 quando Imager Scan Mode &
impostata su 2K Full o 2K Center.

1280x720 23.98P 50
Quando Codec >Select ¢ impostato
su ProRes 422 HQ o ProRes 422:
1920x1080 59.94i
1920x1080 29.97P
1920x1080 23.98P
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Voce Impostazione della voce Descrizione
secondaria
RAW Output Format Imposta il formato di registrazione per un registratore RAW
esterno.
* Per sistemi NTSC: e Per sistemi PAL:
Quando Codec >Select & impostato  Quando Codec >Select & impostato su un’opzione che include
su un’opzione che include RAW e RAW e Imager Scan Mode ¢ impostata su Normal:
Imager Scan Mode & impostata su 4096x2160 50P
Normal: 4096x2160 25P
4096x2160 59.94P Quando Codec >Select & impostato su un’opzione che include
4096x2160 29.97P RAW e Imager Scan Mode ¢ impostata su 2K Full o 2K
4096x2160 23.98P Center:
Quando Codec >Select & impostato 2048x1080 50P
su un’opzione che include RAW e 2048x1080 25P
Imager Scan Mode ¢ impostata su
2K Full o 2K Center:
2048x1080 59.94P
2048x1080 29.97P
2048%1080 23.98P
Genlock Reference Visualizza lo stato di Genlock. Se Genlock ¢ applicato,
Impostazioni Internal / External(HD) / visualizza il tipo di segnale.
Genlock External(SD) Internal: Genlock esterno non applicato.
External(HD): Genlock su segnale HD.
External(SD): Genlock su segnale SD.
Assignable Da <1>a<6> Assegna funzioni ai pulsanti programmabili.
Button Off / Marker / Zebra / Peaking / Marker:
Impostazioni dei ~ Video Signal Monitor / Focus Attiva o disattiva la funzione Marker.
pulsanti Magnifier x4/x8 / Focus Magnifier Zebra:
programmabili x4 / Focus Magnifier x8 / Focus Attiva o disattiva la funzione Zebra.
Area / Focus Area (Push AF) / VF Peaking:

Mode / IRIS / Push Auto Iris /
AGC / Push AGC/ SHUTTER /
Auto Exposure Level / Spotlight /
Backlight / ATW / ATW Hold /
Push AF/Focus Hold / SteadyShot
/ Color Bars / User Menu / Rec
Lamp / S&Q Motion / Picture
Cache Rec / Rec Review /
Thumbnail / Shot Mark1 / Shot
Mark?2 / Clip Flag OK / Clip Flag
NG / Clip Flag Keep /
DURATION/TC/U-BIT / High/
Low Key

Attiva o disattiva la funzione Peaking.

Video Signal Monitor:
Attiva una modalita di monitor del segnale video (ad
esempio il monitor della forma d’onda).

Focus Magnifier x4/x8:

Focus Magnifier x4:

Focus Magnifier x8:

Attiva o disattiva la funzione di ingrandimento della messa

a fuoco.
Focus Area:
Focus Area (Push AF):
Apre la schermata di configurazione di Focus Area.
VF Mode:
Visualizza I’immagine del mirino a colori o in bianco e
nero.
IRIS:
Alterna fra le modalita di diaframma automatico e
manuale.
Push Auto Iris:
Abilita la funzione di diaframma automatico mentre si
tiene premuto il pulsante.
AGC:
Attiva o disattiva la funzione AGC.
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Voce Impostazione della voce Descrizione
secondaria
Push AGC:
Abilita la funzione AGC mentre si tiene premuto il
pulsante.
SHUTTER:

Alterna fra le modalita di otturatore automatico e manuale.
Auto Exposure Level:
Apre la schermata del livello di esposizione automatica.
Spotlight:
Alterna fra Spotlight e Standard.
Backlight:
Alterna fra Backlight e Standard.
ATW:
Attiva o disattiva la funzione ATW.
ATW Hold
Sospende la funzione ATW.
Push AF/Focus Hold:
Esegue la funzione di Push Auto Fcus o di Focus Hold.
SteadyShot:
Alterna fra Active SteadyShot, SteadyShot e Off.
Color Bars:
Attiva o disattiva la barra colori.
User Menu:
Apre e chiude il User Menu.
Rec Lamp:
Accende o spegne I’indicatore di registrazione.
S&Q Motion:
Attiva o disattiva la modalita Slow & Quick Motion.
Se mantenuto premuto, imposta la frequenza fotogrammi
di registrazione.
Picture Cache Rec:
Attiva o disattiva la funzione di registrazione cache
immagine.
Rec Review:
Attiva o disattiva la funzione Rec Review.
Thumbnail:
Apre o chiude la schermata delle miniature.
Shot Mark1:
Esegue la funzione Add Shot Mark1.
Shot Mark2:
Esegue la funzione Add Shot Mark2.
Clip Flag OK
Esegue la funzione Add OK.
Premere due volte per eseguire Delete Clip Flag.
Clip Flag NG
Esegue la funzione Add NG.
Premere due volte per eseguire Delete Clip Flag.
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Voce Impostazione della voce Descrizione
secondaria
Clip Flag Keep
Esegue la funzione Add Keep.
Premere due volte per eseguire Delete Clip Flag.
DURATION/TC/U-BIT:
Alterna fra Time Code, Users Bit e Duration.
High/Low Key:
Passa, nell’ordine, da High Key (modalita di
visualizzazione per il controllo della sovraesposizione delle
alte luci), a Low Key (modalita di visualizzazione per il
controllo delle zone di sottoesposizione) a Off
(visualizzazione normale).
Si applica ai sistemi in cui Monitor LUT & impostato su
On.
Assignable Assignable Dial Assegna funzioni alla manopola programmabile del
Dial Off / ISO/Gain/EL / IRIS / telecomando dell’impugnatura.
Impostazioni delle Focus / Audio Input Level ISO/Gain /EI: Regola guadagno o EI.
manopole IRIS: Regola il diaframma.
programmabili Focus: Regola la messa a fuoco.
Audio Input Level: Regola il livello audio.
IRIS Dial Assegna funzioni alla manopola IRIS.
(Stesse impostazioni di
Assignable Dial)
Assignable Dial Direction Imposta la direzione di rotazione della manopola
Normal / Opposite programmabile del telecomando dell’impugnatura.
Normal: Ruota in avanti.
Opposite: Ruota nella direzione opposta.
IRIS Dial Direction Imposta la direzione di rotazione delle manopola IRIS.
Normal / Opposite Normal: Ruota in avanti.
Opposite: Ruota nella direzione opposta.
Rec Lamp Rec Lamp Accende o spegne I’indicatore di registrazione.
Impostazioni On/ Off
dell’indicatore di
registrazione
Fan Control Setting Imposta la modalita di controllo della ventola del camcorder.

Impostazioni della
modalita di
controllo della
ventola

Auto / Minimum / Off in Rec

Anche se ¢ selezionata I’opzione “Off in Rec”, il ventilatore si
attiva ugualmente se la temperatura interna del camcorder
dovesse raggiunge un determinato valore.

HOLD Switch
Setting

Impostazioni del
selettore HOLD

with Rec Button
On/ Off

Consente di scegliere se bloccare o meno il pulsante di
registrazione.

with Hand Grip Remote
On/ Off

Consente di scegliere se bloccare il funzionamento del
telecomando dell’impugnatura.
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Voce Impostazione della voce Descrizione
secondaria
Lens Zoom Ring Direction Imposta la direzione della ghiera dello zoom.
Impostazioni Left(W)/Right(T) / Right(W)/ m
obiettivo Left(T)

Abilitato solo quando si utilizza un obiettivo con innesto
E-mount che consente la scelta della direzione di azionamento
della ghiera dello zoom.

Distortion Comp.

Attiva o disattiva la funzione di correzione automatica della

Auto / Off distorsione.
* Non disponibile in modalita di registrazione cache
immagine o durante la registrazione.
» La compensazione della distorsione non ¢ applicata durante
la registrazione in modalita 4K o QFHD.
* Quando ¢ selezionato “Auto”, Monitor LUT presenta alcune
limitazioni (pagina 124).
Language Select Imposta la lingua di visualizzazione.
Impostazioni della SET: Imposta la lingua.
lingua
Clock Set Time Zone Imposta la differenza rispetto all’ora UTC in passi di 30
Impostazioni Da UTC 12:00 Kwajalein a UTC  minuti.
dell’ orologio +14:00
interno Date Mode Seleziona il formato di visualizzazione della data.
YYMMDD / MMDDYY / YYMMDD: Anno, mese, giorno
DDMMYY MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno
12H/24H Seleziona il formato di visualizzazione dell’ ora.
12H / 24H 12H: Orologio a 12 ore
24H: Orologio a 24 ore
Date Imposta la data corrente.
SET: Imposta il valore.
Time Imposta I’ora corrente.
SET: Imposta il valore.
Country NTSC/PAL Area Imposta la regione di utilizzo.
Impostazioni NTSC Area / PAL Area
regionali L’impostazione predefinita varia a

seconda del paese di acquisto.

Hours Meter Hours (System)

Visualizza le ore d’uso totali (non puo essere azzerato).

Impostazioni del  Hours (Reset)

Visualizza le ore d’uso totali (puo essere azzerato).

contaore

Reset Azzera I’indicazione Hours (Reset).
Execute / Cancel Execute: Reset
Basic User Name Imposta il nome utente desiderato (da 1 a 16 caratteri

Authentication  (admin)
Impostazioni di

alfanumerici).
SET: Imposta il valore.

autenticazione di  password
rete di base (pxw-fs7)

Imposta una password (da 1 a 16 caratteri alfanumerici).
SET: Imposta il valore.
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Voce Impostazione della voce Descrizione
secondaria
Wi-Fi Wi-Fi Seleziona se attivare o disattivare la connessione Wi-Fi.

Impostazioni della
connessione LAN
Wireless

Enable / Disable

SSID & Password

Visualizza SSID e password.

Wi-Fi Direct Connection
Execute / Cancel

Avvia una connessione di rete “Wi-Fi Direct”.
Execute: Connette

Client Visualizza informazioni sul dispositivo client connesso (nome
del modello e indirizzo MAC).
IP Address Visualizza I’indirizzo IP del camcorder.
192.168.1.1 m
Non visualizzato quando si utilizza I’adattatore CBK-WA100.
Subnet Mask Visualizza la subnet mask.
255.255.0.0

Non visualizzato quando si utilizza I’adattatore CBK-WA100.

MAC Address

Visualizza I’indirizzo MAC del modulo Wi-Fi collegato al
camcorder.

Regenerate Password
Execute / Cancel

Crea una nuova password.
Execute: Esegui

GPS GPS Attiva o disattiva la funzione GPS.
Impostazioni GPS On/ Off m

11 modulo GPS & incorporato nella maniglia.
IR Remote Setting Attiva o disattiva 1’azionamento del camcorder tramite il
Impostazioni del On/ Off telecomando a infrarossi fornito in dotazione.
telecomando
Camera Low BATT Imposta il livello di carica rimanente della batteria per la
Battery Alarm 5% 1 10% / 15% / - | 45% | visualizzazione dell’allarme di bassa tensione batteria (in
Impostazioni di 50% incrementi del 5%).
bassa tensione BATT Empty Imposta il livello di carica rimanente della batteria per la
batteria Da 3% a 7% visualizzazione dell’allarme batteria scarica.
Camera DC IN DC Low Voltagel Imposta la tensione alla quale visualizzare 1’allarme di bassa
Alarm Da11.5Val7.0V tensione su ingresso DC IN.
Impostazioni DC Low Voltage2 Imposta la tensione alla quale visualizzare 1’allarme di

dell’allarme della
tensione di
ingresso

Da11.0Val4.0V

tensione su ingresso DC IN insufficiente.
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Voce Impostazione della voce Descrizione

secondaria
Ext. Unit Near End:Info Battery Imposta il livello di carica rimanente della batteria per la
Battery Alarm Da 5% a 100% visualizzazione dell’allarme di bassa tensione batteria Info-
Impostazioni Lithium (in incrementi del 5%).

batteria unita di
estensione XDCA-
FS7

End:Info Battery
Da 0% a 5%

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme di batteria Info-Lithium esausta
ed arrestare 1’accesso ai supporti di memorizzazione.

Near End:Sony Battery
Da11.5Va 17.0V

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme di bassa tensione batteria per una
batteria non Info-Lithium.

End:Sony Battery
Da 110V a 11.5V

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme di batteria esausta per batterie
non Info-Lithium ed arrestare 1’accesso ai supporti di
memorizzazione.

Near End:Other Battery
Da11.5Val7.0V (11.8V)

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme di bassa tensione batteria per una
batteria Anton/Bauer.

End:Other Battery
Da11.0V a 14.0V

Imposta il livello di carica rimanente della batteria per la
visualizzazione dell’allarme di batteria esausta per batterie
Anton/Bauer ed arrestare 1’accesso ai supporti di
memorizzazione.

Detected Battery

Visualizza il tipo di batteria collegata all’unita di estensione
XDCA-FS7.

Se & connessa una batteria all’unita di estensione XDCA-FS7,
visualizza “Info Battery”, “Sony Battery” o “Other Battery”.
Se & collegata una sorgente di alimentazione in corrente
continua, viene visualizzato “DC IN”.

Se I’alimentazione proviene da batteria o alimentatore a
corrente continua connesso al camcorder, viene visualizzato

”»

Ext. Unit DC IN
Alarm
Impostazioni di
allarme tensione di
ingresso dell’unita
di estensione

DC Low Voltagel
Da 11.5Va 17.0V

Imposta la tensione alla quale visualizzare 1’allarme di bassa
tensione su ingresso DC IN.

DC Low Voltage2
Da11.0V a 14.0V

Imposta la tensione alla quale visualizzare 1’allarme di
tensione su ingresso DC IN insufficiente.

XDCA-FS7

All Reset Reset Ripristina i valori predefiniti di fabbrica di tutte le

Ripristina le Execute / Cancel impostazioni.

impostazioni Execute: Reset

predefinite

APR APR Esegue la funzione APR di ricostruzione automatica pixel per
Esegue APR Execute / Cancel la regolazione automatica del sensore di immagine.

Execute: Esegui

Montare sempre il coperchietto dell’obiettivo prima di
eseguire la funzione APR.

Camera Config HD/2K Modulation

Impostazioni di
uscita in modalita
down-converter

High / Low

Imposta la larghezza di banda in uscita della modalita down-
converter per la conversione in HD e 2K
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Voce Impostazione della voce Descrizione
secondaria
Version Number Visualizza la versione del software del camcorder.
Visualizza la X.XX
versione Version Up Esegue I’'upgrade del camcorder.*
Execute / Cancel Execute: Esegui
* L'upgrade aggiorna il software del camcorder.
Ext. Unit Version Number Visualizza la versione del software dell’unita di estensione
XXX XDCA-FS7.
Ext. Version Up Esegue I'upgrade dell’unita di estensione XDCA-FS7.*
Execute / Cancel Execute: Esegui
* L'upgrade aggiorna il software dell’unita di estensione
XDCA-FS7.
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Connessione di un dispositivo esterno

Connessione di monitor e dispositivi di registrazione

esterni

Per visualizzare le immagini di registrazione e
riproduzione del camcorder su un monitor
esterno, selezionare il segnale di uscita del
camcorder e utilizzare il cavo appropriato per il
monitor esterno da collegare.

E possibile anche collegare dispositivi di
registrazione, ad esempio un VTR, e registrare il
segnale in uscita dal camcorder.

E possibile visualizzare sul monitor esterno le
stesse informazioni che sono visibili nel mirino,
ad esempio informazioni di stato e menu.
Impostare Output Display (pagina 85) nel menu
Video su “On” per il tipo di segnale da inviare al
monitor.

Connettore SDI OUT (tipo BNC)

Attivare o disattivare I’uscita e selezionare il

formato di uscita mediante il menu Video
(pagina 83).

Per la connessione, utilizzare un cavo coassiale da
75 Q disponibile in commercio.

Controllare la messa a terra della connessione fra il
camcorder e il dispositivo esterno prima di accendere i
dispositivi.

(Si consiglia di accendere il camcorder e il dispositivo
esterno dopo la connessione del cavo coassiale da 75 Q).
Se il dispositivo esterno deve essere collegato al
camcorder mentre il camcorder ¢ acceso, collegare il
cavo coassiale da 75 Q al dispositivo esterno per primo e
successivamente collegarlo al camcorder.

Per avviare la registrazione simultaneamente
sul camcorder e sul dispositivo esterno

Con I’uscita segnale SDI abilitata, impostare SDI/
HDMI Rec Control (pagina 92) >Setting nel
menu Recording su “On” per abilitare
I’emissione di un segnale di trigger REC diretto al
dispositivo esterno connesso al connettore SDI
OUT. Questo sincronizzera la registrazione sul
dispositivo esterno con il camcorder.

« Se il dispositivo esterno connesso non & compatibile
con il segnale di trigger REC, il dispositivo non puo
essere comandato.

¢ Seil pulsante START/STOP di registrazione del corpo
e il pulsante START/STOP di registrazione della

maniglia comandano supporti di registrazione diversi,
il segnale di trigger REC viene emesso in conformita
con il funzionamento dello slot A.

* Se non & inserito un supporto, viene solamente emesso
il segnale di trigger REC.

Connettore HDMI OUT (Type A)

Attivare o disattivare ’uscita e selezionare il
formato di uscita mediante il menu Video
(pagina 83).

Per la connessione, utilizzare un cavo HDMI ad
alta velocita disponibile in commercio.
Selezionare il tipo di dispositivo collegato con la
voce HDMI Target Device (pagina 124) del
menu Video.

Connettore RAW OUT (tipo BNC)

Se viene montata un’unita di estensione XDCA-
FS7 sul camcorder, & possibile utilizzare un
registratore RAW esterno, ad esempio un
registratore AXS-RS, connesso al connettore
RAW OUT dell’unita XDCA-FS7 (pagina 35).




Sincronizzazione
esterna

Per le riprese con piut camcorder, & possibile
sincronizzare i camcorder a un segnale di
riferimento specifico o ai codici temporali
sincronizzati tramite il connettore Genlock delle
unita XDCA-FS7 (pagina 12) montate sui
camcorder.

Non ¢ possibile utilizzare il pacco batteria del camcorder
quando & montata un’unita di estensione XDCA-FS7. E
necessario montare un pacco batteria sull’unita
XDCA-FS7 oppure collegare un alimentatore esterno.

Sincronizzazione della fase dei segnali
video (genlock)

Per la zona PAL

Frequenza
fotogrammi del
formato di

Segnali di riferimento
validi

registrazione

50P 1920 x 1080 501
720 x 576 501
1280 x 720 50P

25p 1920 x 1080 50i
720 x 576 50i

50i 1920 x 1080 50i
720 x 576 50i

« Se il formato di registrazione selezionato ¢ 1280x720
60P, & necessario fornire sia un segnale video che un
segnale di tempo.

« Se il segnale di riferimento non & stabile, sara
impossibile ottenere la sincronizzazione genlock.

* La sottoportante non & sincronizzata.

Abilitare la funzione genlock fornendo un segnale
di riferimento ai connettori Genlock (pagina 12)
delle unita XDCA-FS7 montate sui camcorder.

I segnali di riferimento utilizzabili variano a
seconda della frequenza fotogrammi del formato
di registrazione selezionato.

Per la zona NTSC

Frequenza Segnali di riferimento
fotogrammi del validi
formato di
registrazione
59.94P 1920 x 1080 59.94i
720 x 486 59.94i
1280 x 720 59.94P
29.97P 1920 x 1080 59.94i
720 x 486 59.94i
24.0P 1920 x 1080 48i (24PsF)
23.98P 1920 x 1080 47.95i
(23.98PsF)
59.94i 1920 x 1080 59.94i

720 x 486 59.94i
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Sincronizzazione del codice temporale
con altri dispositivi

Impostare I’unita che fornisce il codice temporale
su una modalita in cui il codice temporale
continui ad avanzare (es. Free Run o Clock).

1

Impostare I’opzione Timecode del
menu TC/UB come indicato di seguito.
Mode: Preset

Run: Free Run

Premere il pulsante programmabile
(pagina 47) a cui € assegnata la funzione
DURATION/TC/U-BIT per
visualizzare il codice temporale sullo
schermo.

Controllare che il selettore TC IN/OUT
(pagina 12) dell’unita XDCA-FS7 si
trovi nella posizione IN e fornire un
segnale video di riferimento HD o SD e
un codice temporale sincronizzato con il
segnale video sui connettori Genlock e
TC IN/OUT rispettivamente.

11 generatore del codice temporale del camcorder
si sincronizza con il codice temporale di
riferimento e sullo schermo appare 1’indicazione
“EXT-LK”.

Una volta trascorsi dieci secondi circa
dall’acquisizione della sincronizzazione, lo stato



di sincronizzazione esterno viene mantenuto
anche se la sorgente di riferimento esterna del
codice temporale viene scollegata.

« Controllare che il codice temporale di riferimento e il
segnale video di riferimento siano in un rapporto di
fase conforme agli standard SMPTE per i codici
temporali.

Durante il funzionamento in modalita di
sincronizzazione esterna, il codice temporale
acquisisce istantaneamente la sincronizzazione con il
codice temporale esterno e nella sezione di
visualizzazione dei dati viene visualizzato il valore del
codice temporale esterno. Tuttavia, non avviare
immediatamente la registrazione. Prima di avviare la
registrazione & necessario attendere alcuni secondi la
stabilizzazione del generatore del codice temporale.
Se la frequenza del segnale video di riferimento e la
frequenza fotogrammi del camcorder non sono
identiche, non sara possibile ottenere la
sincronizzazione e il camcorder non potra funzionare
correttamente. In questo caso, il codice temporale non
potra sincronizzarsi correttamente con il codice
temporale esterno.

Se la sorgente del codice temporale esterno viene
disconnessa, il codice temporale potra variare di un
fotogramma all’ora rispetto al codice temporale di
riferimento.

Per rilasciare la sincronizzazione esterna
Cambiare I’impostazione di Timecode nel menu
TC/UB oppure spegnere il camcorder.

La sincronizzazione esterna si disconnette anche
se si avvia la registrazione in modalitd Quick &
Slow Motion.

Sincronizzazione del codice temporale di
un altro dispositivo con il codice
temporale del camcorder

Impostare I’unita che fornisce il codice temporale
su una modalita in cui il codice temporale
continui ad avanzare (es. Free Run o Clock).

1

Impostare il codice temporale del
camcorder con I’opzione Timecode
(pagina 90) del menu TC/UB.

Controllare che il selettore TC IN/OUT
(pagina 12) sitrovi nella posizione OUT,
quindi collegare il connettore TC IN/
OUT e il connettore Genlock

(pagina 12) agli ingressi del codice
temporale e Genlock, rispettivamente,
del dispositivo che si desidera
sincronizzare.
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Gestione ed editing di

clip con un computer

Connessione con cavo USB

Utilizzo di un lettore di schede XQD
(opzione)

Collegare un lettore di schede MRW-E80 XQD
(opzione) mediante un cavo USB, quindi inserire
una scheda di memoria nello slot. La scheda di
memoria viene riconosciuta come un’unita di
estensione del computer.

Utilizzo della modalita di
memorizzazione di massa

Collegare il camcorder mediante un cavo USB,
quindi inserire una scheda di memoria nello slot.
La scheda di memoria viene riconosciuta come
un’unita di estensione del computer.

1 Spostare I’interruttore POWER del
camcorder su ON.

Sullo schermo o nel mirino viene
visualizzato un messaggio di conferma della
connessione USB.

11 messaggio di conferma della connessione USB
non viene visualizzato se ¢ gia visualizzato un altro
messaggio di conferma o un indicatore di
avanzamento, ad esempio durante la formattazione
o il recupero di una scheda di memoria XQD.

Il messaggio di conferma verra visualizzato al
termine della formattazione o del recupero. 11
messaggio di conferma USB non ¢ visualizzato
neanche quando ¢ visualizzata la schermata delle
proprieta del clip. Il messaggio verra visualizzato al
termine dell’ operazione o quando si ritorna alla
schermata delle miniature.

Ruotare la manopola SEL/SET e
selezionare Execute.



3 Su Windows, controllare che la scheda
sia aggiunta come disco rimovibile nella
finestra “My Computer”.

Su Macintosh, controllare che una
cartella con il nome “NO NAME” o
“Untitled” (modificabile) sia stata
creata sul Desktop.

« Non eseguire le seguenti operazioni se 1’indicatore di
accesso & illuminato in rosso.
- Spegnere I’apparecchio o scollegare il cavo di
alimentazione
- Rimuovere la scheda di memoria XQD
- Scollegare il cavo USB
« 1l funzionamento non & garantito con tutti i computer.

Utilizzo di sistemi di editing non lineare

In un sistema di editing non lineare, ¢ necessario
utilizzare un software di editing (opzione) che
supporti i formati registrati dal camcorder.
Utilizzare un software applicativo dedicato per
salvare in anticipo sul disco rigido del computer i
clip di cui eseguire I’editing.
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Appendice

Precauzioni per l'uso

La ventola ¢ una parte di consumo e necessita di
una sostituzione periodica.

Se I’apparecchio viene utilizzato a temperatura
ambiente, il ciclo normale di sostituzione & di
circa 5 anni.

Tuttavia, cio ha un valore puramente indicativo e
non implica alcuna garanzia sulla durata di vita
prevista di questo componente. Per ulteriori
informazioni sulla sostituzione dei componenti,
rivolgersi al proprio rivenditore.

Qualora I’unita venga spostata rapidamente da un
ambiente freddo a uno caldo, oppure se la
temperatura ambiente dovesse aumentare
improvvisamente, & possibile che si formi umidita
sulle superfici esterne dell’unita e/o al suo
interno. Questo fenomeno & denominato
condensazione. In tal caso, spegnere 1’unita ed
attendere la scomparsa della condensazione
prima di riavviarla. L’utilizzo dell’unita mentre &
presente condensazione puo causare danni
all’unita stessa.

11 pannello LCD di cui & dotato I’apparecchio &
prodotto con tecnologia ad alta precisione che
consente di ottenere una percentuale di pixel
funzionanti minima di ben 99,99%. B quindi
possibile che una piccolissima percentuale dei
pixel possa rimanere “bloccata”, sempre
disattivata (nera), sempre attivata (rossa, verde o
blu) oppure lampeggiante. E inoltre possibile che,
dopo un lungo periodo d’uso, alcuni pixel si
“blocchino” spontaneamente a causa delle
caratteristiche fisiche del display a cristalli
liquidi. Tali fenomeni non sono il risultato di

guasti e non hanno alcun effetto sui dati registrati.

Il morsetto della batteria dell’apparecchio (il
connettore per pacchi batteria e adattatori CA) ¢
un prodotto di consumo.

Se i piedini del morsetto sono piegati e deformati
a causa di urti o vibrazioni, o se vengono corrosi
a causa di un uso prolungato all’aria aperta,
I’alimentazione potrebbe non essere fornita
correttamente.
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Si consiglia di eseguire dei controlli periodici per
assicurare il funzionamento corretto
dell’apparecchio e prolungarne la vita utile.

Per ulteriori informazioni sui controlli, contattare
il servizio tecnico o un rappresentante Sony.

Informazioni sulla batteria ricaricabile integrata
Il camcorder ¢ dotato di una batteria ricaricabile
interna che consente la memorizzazione di data,
ora e altre impostazioni anche quando & spento.
Se non & connesso un adattatore CA o il
camcorder viene utilizzato senza pacco batteria,
la batteria ricaricabile si scarichera
completamente dopo circa 3 mesi. Utilizzare il
camcorder dopo aver ricaricato la batteria.
Tuttavia, anche se la batteria ricaricabile interna &
scarica, il funzionamento del camcorder non
risulta compromesso purché non si registri data e
ora.



Formati di uscita e limitazioni

Formati video e segnali di uscita

Le impostazioni predefinite sono indicate in grassetto (ad esempio, 2048x1080P (Level A)).

» Larisoluzione del formato di registrazione ¢ limitata dall’impostazione di Base Setting >Imager Scan Mode nel menu

System (pagina 97).

« Se larisoluzione dell’uscita video & superiore a quella dell’immagine, non viene emessa nessuna immagine riprodotta.

Formati di uscita del connettore SDI OUT

Quando Gountry >NTSC/PAL Area nel menu System & impostato su NTSC Area

Quando si utilizza una configurazione di base (XAVC-1/XAVC-L /MPEG HD)

Impostazioni del formato di

registrazione

(Rec Format >Video Format nel menu

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI

Segnale di uscita SDI

System) nel menu Video)
SDI HDMI
4096x2160 59.94P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080P 1920x1080P 1920%x1080 59.94P Level-A
(Level A)
1920x1080P - 1920%1080 59.94P Level-B
(Level B)
1920%1080i 1920%x1080i 1920%x1080 59.94i
4096x2160 29.97P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF | 1920x1080i 19201080 29.97PsF
4096x2160 24.00P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF |- 1920%x1080 24PsF
- 1920x1080P Nessuna uscita
4096x2160 23.98P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF |- 19201080 23.98PsF
- 1920x1080P Nessuna uscita
3840x2160 59.94P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080P 1920x1080P 1920%1080 59.94P Level-A
(Level A)
1920x1080P - 1920%1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 19201080 59.94i
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Impostazioni del formato di Impostazioni di uscita SDI/ Segnale di uscita SDI
registrazione HDMI
(Rec Format >Video Format nel menu | (Output Format >SDI e HDMI
System) nel menu Video)
SDI HDMI
3840%x2160 29.97P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF
3840x2160 23.98P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF |- 1920x1080 23.98PsF
- 1920x1080P Nessuna uscita
1920x1080 59.94P 2048x1080P - 2048%1080 59.94P Level-A
(Level A)
2048x1080P - 2048%1080 59.94P Level-B
(Level B)
1920x1080P 1920x1080P 1920%1080 59.94P Level-A
(Level A)
1920x1080P - 1920%x1080 59.94P Level-B
(Level B)
1920%1080i 1920%x1080i 1920%x1080 59.94i
- 720%x4801 Nessuna uscita
- 720x480P Nessuna uscita
1920x1080 59.94i 1920x1080i 1920x1080i 1920x1080 59.94i
- 720x4801 Nessuna uscita
- 720x480P Nessuna uscita
19201080 29.97P 2048x1080PsF |- 2048%1080 29.97PsF
1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
- 720%x4801 Nessuna uscita
1920x1080 23.98P 2048x1080PsF |- 2048x1080 23.98PsF
1920x1080PsF |- 1920%x1080 23.98PsF
- 1920x1080P Nessuna uscita
1920x1080i (2- | 1920x1080i (2- |1920%x1080 59.94i (2-3PD)
3PD) 3PD)
- 720%x480i (2- Nessuna uscita
3PD)
1280x720 59.94P 1280x720P 1280x720P 1280x720 59.94P
- 720%x4801 Nessuna uscita
- 720x480P Nessuna uscita
1280%720 29.97P 1280x720P 1280x720P 1280%720 59.94P (2-2RP)
- 720x4801 Nessuna uscita
1280x720 23.98P 1280x720P (2- |1280x720P (2- |1280x720 59.94P (2-3PD)
3PD) 3PD)
- 720%x480i (2- Nessuna uscita
3PD)
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Quando si utilizza un’unita di estensione (RAW)

Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI

nel menu Video)

Segnale di uscita SDI

SDI HDMI
RAW Output Format 2048x1080P - 2048x1080 59.94P Level-A
4096x2160 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 59.94P Level-B
1920x1080 59.94P (Level B)
1920%1080P 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 59.94i
RAW Output Format 2048x1080P - 2048x1080 59.94P Level-A
4096x2160 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 59.94P Level-B
1280720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1280%720P 1280x720P 1280x720 59.94P
RAW Output Format 2048x1080P |- 2048x1080 59.94P Level-A
2048x1080 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 59.94P Level-B
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920x1080P - 1920x1080 59.94P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 59.94i
RAW Output Format 2048x1080P |- 2048x1080 59.94P Level-A
2048x1080 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 59.94P Level-B
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P Level-A
(Level A)
1920%1080P - 1920x1080 59.94P Level-B
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format 2048x1080PsF |- 2048x1080 29.97PsF
4096x2160 29.97P 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
Video Format (valore fisso)
1920x1080 29.97P
RAW Output Format 2048x1080PsF |- 2048x1080 29.97PsF
2048x1080 29.97P 1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF

Video Format (valore fisso)
1920x1080 29.97P
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Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

HDMI

Impostazioni di uscita SDI/

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita SDI

SDI HDMI
RAW Output Format 2048x1080PsF |- 2048%1080 23.98PsF
4096x2160 23.98P 1920x1080PsF |- 1920x1080 23.98PsF
Video Format (valore fisso) - 1920x1080P Nessuna uscita
1920x1080 23.98P
RAW Output Format 2048x1080PsF 2048x1080 23.98PsF
2048x1080 23.98P 1920%1080PsF 1920x1080 23.98PsF
Video Format (valore fisso) - 1920x1080P Nessuna uscita
1920x1080 23.98P

Quando si utilizza un’unita di estensione (ProRes 422)

Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

HDMI

Impostazioni di uscita SDI/

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita SDI

SDI HDMI
1920x1080 59.94i 1920x1080i 1920x1080i 1920x1080 59.94i
1920x1080 29.97P 1920x1080PsF | 1920x1080i SDIOUT 1
1920x1080 29.97P
SDIOUT 2
1920x1080 29.97PsF
1920x1080 23.98P 1920x1080P 1920x1080P 19201080 23.98P*1

*1 Non puod emettere un segnale compatibile con 1’adattatore CBK-WA100.

Quando Country >NTSC/PAL Area nel menu System & impostato su PAL Area

Quando si utilizza una configurazione di base (XAVC-1/XAVC-L/MPEG HD)

Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

HDMI

Impostazioni di uscita SDI/

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita SDI

SDI HDMI
4096x2160 50P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080P 1920x1080P 1920%1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
4096x2160 25P - 4096x2160P Nessuna uscita
- 3840x2160P Nessuna uscita
1920x1080PsF | 1920x1080i 1920%x1080 25PsF
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Impostazioni del formato di

registrazione

(Rec Format >Video Format nel menu

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI

Segnale di uscita SDI

System) nel menu Video)

SDI HDMI
3840x2160 50P - 4096x2160P Nessuna uscita

- 3840x2160P Nessuna uscita

1920x1080P 1920x1080P 1920%1080 50P Level-A

(Level A)

1920x1080P - 1920x1080 50P Level-B

(Level B)

1920x1080i 1920%x1080i 1920%x1080 50i
3840%x2160 25P - 4096x2160P Nessuna uscita

- 3840x2160P Nessuna uscita

1920x1080PsF | 1920x1080i 1920x1080 25PsF
1920x1080 50P 2048x1080P - 2048x1080 50P Level-A

(Level A)

2048x1080P - 2048x1080 50P Level-B

(Level B)

1920x1080P 1920x1080P 1920%1080 50P Level-A

(Level A)

1920x1080P - 1920x1080 50P Level-B

(Level B)

1920x1080i 1920x1080i 1920x1080 50i

- 7205761 Nessuna uscita

- 720x576P Nessuna uscita
1920%x1080 50i 1920x1080i 1920x1080i 1920%x1080 50i

- 720x5761 Nessuna uscita

- 720x576P Nessuna uscita
1920x1080 25P 2048x1080PsF |- 2048x1080 25PsF

1920x1080PsF | 1920x1080i 1920x1080 25PsF

- 7205761 Nessuna uscita
1280%720 50P 1280x720P 1280x720P 1280%720 50P

- 720x5761 Nessuna uscita

- 720x576P Nessuna uscita
1280720 25P 1280x720P 1280x720P 1280720 50P (2-2RP)

- 7205761 Nessuna uscita
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Quando si utilizza un’unita di estensione (RAW)

Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita SDI

SDI HDMI
RAW Output Format 2048x1080P - 2048x1080 50P Level-A
4096x2160 50P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 50P Level-B
1920x1080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
RAW Output Format 2048x1080P - 2048x1080 50P Level-A
4096x2160 50P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 50P Level-B
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format 2048x1080P |- 2048x1080 S0P Level-A
2048x1080 50P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 50P Level-B
1920x1080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
RAW Output Format 2048x1080P |- 2048x1080 S0P Level-A
2048x1080 50P (Level A)
Video Format (valore fisso) 2048x1080P - 2048x1080 50P Level-B
1280%720 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P Level-A
(Level A)
1920x1080P - 1920x1080 50P Level-B
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format 2048x1080PsF |- 2048x1080 25PsF
4096x2160 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (valore fisso)
1920x1080 25P
RAW Output Format 2048x1080PsF |- 2048x1080 25PsF
2048x1080 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (valore fisso)
1920x1080 25P
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Quando si utilizza un’unita di estensione (ProRes 422)

Impostazioni del formato di Impostazioni di uscita SDI/ Segnale di uscita SDI
registrazione HDMI
(Rec Format >Video Format nel menu | (Output Format >SDI e HDMI
System) nel menu Video)
SDI HDMI

1920x1080 50i 1920x1080i 1920x1080i 1920x1080 50i
1920%x1080 25P 1920x1080PsF | 1920x1080PsF | SDI OUT 1

1920x1080 25P

SDIOUT 2
1920x1080 25PsF
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Formati di uscita per il connettore HDMI OUT

Quando Gountry >NTSC/PAL Area nel menu System & impostato su NTSC Area

Quando si utilizza una configurazione di base (XAVC-1/XAVC-L/MPEG HD)

Impostazioni del formato di

registrazione

(Rec Format >Video Format nel menu

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI

Segnale di uscita HDMI

System) nel menu Video)
SDI HDMI
4096x2160 59.94P - 4096x2160P 4096x2160 59.94P
- 3840x2160P 3840%x2160 59.94P
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x10801 1920x10801 1920x1080 59.94i
4096x2160 29.97P - 4096x2160P 4096x2160 29.97P
- 3840x2160P 3840%x2160 29.97P
1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
4096x2160 24.00P - 4096x2160P 4096x2160 24P
- 3840x2160P 3840%x2160 24P
1920x1080PsF |- Nessuna uscita
- 1920x1080P 1920%x1080 24P (Pure)
4096x2160 23.98P - 4096x2160P 4096x2160 23.98P
- 3840x2160P 3840%x2160 23.98P
1920x1080PsF |- Nessuna uscita
— 1920x1080P 1920x1080 23.98P (Pure)
3840%x2160 59.94P - 4096x2160P 4096x2160 59.94P
_ 3840x2160P 3840x2160 59.94P
1920x1080P  |1920x1080P | 19201080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i1 1920x1080i 1920%x1080 59.94i
3840%x2160 29.97P - 4096x2160P 4096x2160 29.97P
- 3840x2160P 3840%2160 29.97P
1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
3840%x2160 23.98P - 4096x2160P 4096x2160 23.98P
- 3840x2160P 3840x2160 23.98P
1920x1080PsF |- Nessuna uscita
- 1920x1080P 1920x1080 23.98P (Pure)
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Impostazioni del formato di Impostazioni di uscita SDI/ Segnale di uscita HDMI
registrazione HDMI
(Rec Format >Video Format nel menu | (Output Format >SDI e HDMI
System) nel menu Video)

SDI HDMI
1920%x1080 59.94P 2048x1080P - Nessuna uscita

(Level A)

2048x1080P - Nessuna uscita

(Level B)

1920x1080P | 1920x1080P | 1920x1080 59.94P

(Level A)

1920x1080P - Nessuna uscita

(Level B)

1920x10801 1920x1080i 1920%x1080 59.94i

- 720%x4801 720x480 59.941

- 720x480P 720x480 59.94P
1920x1080 59.94i 1920x1080i 1920x1080i 1920x1080 59.941

- 720%x480i 720%480 59.941

- 720x480P 720x480 59.94P
1920%x1080 29.97P 2048x1080PsF |- Nessuna uscita

1920x1080PsF | 1920x1080i 1920%x1080 29.97PsF

- 720%x480i 720%x480 59.94i (PsF)
1920x1080 23.98P 2048x1080PsF |- Nessuna uscita

1920x1080PsF |- Nessuna uscita

- 1920x1080P 1920x1080 23.98P (Pure)

1920x1080i (2- 1920x1080i (2- 1920x1080 59.94i (2-3PD)

3PD) 3PD)

- 720x480i (2- 720x480 59.94i (2-3PD)

3PD)

1280720 59.94P 1280x720P 1280x720P 1280720 59.94P

- 720%x4801 720x480 59.941

- 720x480P 720x480 59.94P
1280x720 29.97P 1280x720P 1280x720P 1280%720 59.94P (2-2RP)

- 720%x480i 720%x480 59.94i (PsF)
1280x720 23.98P 1280x720P (2- |1280x720P (2- | 1280x720 59.94P (2-3PD)

3PD) 3PD)

- 720%x480i (2- 720%480 59.941

3PD)
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Quando si utilizza un’unita di estensione (RAW)

Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
RAW Output Format 2048x1080P - Nessuna uscita
4096x2160 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i 1920x10801 1920x1080 59.94i
RAW Output Format 2048x1080P |- Nessuna uscita
4096x2160 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format 2048x1080P |- Nessuna uscita
2048x1080 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1920x1080 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i 1920x10801 1920x1080 59.94i
RAW Output Format 2048x1080P |- Nessuna uscita
2048x1080 59.94P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1280x720 59.94P (Level B)
1920x1080P 1920x1080P 1920x1080 59.94P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1280x720P 1280x720P 1280x720 59.94P
RAW Output Format 2048x1080PsF |- Nessuna uscita
4096x2160 29.97P 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
Video Format (valore fisso)
1920x1080 29.97P
RAW Output Format 2048x1080PsF |- Nessuna uscita
2048x1080 29.97P 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
Video Format (valore fisso)
1920x1080 29.97P
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Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

HDMI

Impostazioni di uscita SDI/

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI

RAW Output Format 2048x1080PsF |- Nessuna uscita
4096x2160 23.98P 1920x1080PsF |- Nessuna uscita

Video Format (valore fisso) - 1920x1080P | 1920x1080 23.98P (Pure)
1920x1080 23.98P

RAW Output Format 2048x1080PsF |- Nessuna uscita
2048x1080 23.98P 1920x1080PsF |- Nessuna uscita

Video Format (valore fisso) _ 1920x1080P 1920x1080 23.98P (Pure)
1920x1080 23.98P

Quando si utilizza un’unita di estensione (ProRes 422)

Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

Impostazioni di uscita SDI/
HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
19201080 59.94i 1920x1080i 1920x1080i 1920x1080 59.94i
1920x1080 29.97P 1920x1080PsF | 1920x1080i 1920x1080 29.97PsF
1920x1080 23.98P 1920x1080P 1920x1080P 1920x1080 23.98P (Pure)

Quando Country >NTSC/PAL Area nel menu System & impostato su PAL Area

Quando si utilizza una configurazione di base (XAVC-1/XAVC-L/MPEG HD)

Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

Impostazioni di uscita SDI/
HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
4096x2160 S0P - 4096x2160P 4096x2160 S0P
- 3840x2160P 3840x2160 50P
1920x1080P 1920x1080P 19201080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
4096x2160 25P - 4096x2160P 4096x2160 25P
- 3840x2160P 3840x2160 25P
1920x1080PsF | 1920x1080i 1920x1080 25PsF
3840x2160 50P - 4096x2160P 4096x2160 50P
- 3840x2160P 3840x2160 50P
1920x1080P 1920x1080P 1920%x1080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i 1920x1080i 1920x1080 50i

121



Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI

nel menu Video)

Segnale di uscita HDMI

SDI HDMI
3840x2160 25P - 4096x2160P 4096x2160 25P

- 3840x2160P 3840x2160 25P

1920x1080PsF | 1920x1080i 1920%x1080 25PsF
1920x1080 50P 2048x1080P - Nessuna uscita

(Level A)

2048x1080P - Nessuna uscita

(Level B)

1920x1080P 1920x1080P 1920x1080 50P

(Level A)

1920x1080P - Nessuna uscita

(Level B)

1920x1080i 1920x1080i 1920x1080 50i

- 720x576i 720%x576 50i

- 720x576P 720x576 50P
1920%x1080 50i 1920x1080i 1920x1080i 1920%x1080 50i

- 720%x5761 720%x576 50i

- 720x576P 720x576 50P
1920x1080 25P 2048x1080PsF |- Nessuna uscita

1920x1080PsF | 1920x1080i 1920x1080 50i (PsF)

- 720%x5761 720%x576 50i (PsF)
1280%720 50P 1280x720P 1280x720P 1280%720 50P

- 720%x5761 720%x576 50i

- 720x576P 720x576 50P
1280720 25P 1280x720P 1280x720P 1280x720 50P (2-2RP)

- 720x576i 720%x576 50i (PsF)

Quando si utilizza un’unita di estensione (RAW)

Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
RAW Output Format 2048x1080P - Nessuna uscita
4096x2160 50P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1920%x1080 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920%1080i 1920%x1080i 1920%x1080 50i
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Impostazioni del formato di
registrazione

(Rec Format >RAW Output Format e
Video Format nel menu System)

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI

nel menu Video)

Segnale di uscita HDMI

SDI HDMI
RAW Output Format 2048x1080P - Nessuna uscita
4096x2160 50P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1280x720 50P (Level B)
1920x1080P 1920x1080P 1920x1080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format 2048x1080P - Nessuna uscita
2048x1080 50P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1920%x1080 50P (Level B)
1920x1080P 1920x1080P 19201080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1920x1080i 1920x1080i 1920x1080 50i
RAW Output Format 2048x1080P |- Nessuna uscita
2048x1080 50P (Level A)
Video Format (valore fisso) 2048x1080P - Nessuna uscita
1280x720 50P (Level B)
1920x1080P 1920x1080P 19201080 50P
(Level A)
1920x1080P - Nessuna uscita
(Level B)
1280x720P 1280x720P 1280x720 50P
RAW Output Format 2048x1080PsF |- Nessuna uscita
4096x2160 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF
Video Format (valore fisso)
1920x1080 25P
RAW Output Format 2048x1080PsF |- Nessuna uscita
2048x1080 25P 1920x1080PsF | 1920x1080i 1920x1080 25PsF

Video Format (valore fisso)
1920x1080 25P

Quando si utilizza un’unita di estensione (ProRes 422)

Impostazioni del formato di
registrazione

(Rec Format >Video Format nel menu
System)

Impostazioni di uscita SDI/

HDMI

(Output Format >SDI e HDMI
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
1920x1080 50i 1920x1080i 1920x1080i 1920x1080 50i
19201080 25P 1920x1080PsF | 1920x1080i 1920%x1080 50i (PsF)

123



Impostazioni di uscita HDMI per dispositivi HDMI

Output Setting >SHDMI Target |Output Display >SDI/HDMI nel | Uscita HDMI
Device nel menu Video menu Video OSD On/Off |MLUT On/Off
Recorder (predefin.) SDI=On, HDMI=On (predefin.) - Segue SDII
* In grigio, non selezionabile.
SDI=On, HDMI=Off Off
SDI=Off, HDMI=Off Off
Monitor SDI=On, HDMI=On (predefin.) On Segue SDI2
SDI=On, HDMI=Off -
* In grigio, non selezionabile.
SDI=Off, HDMI=Off Off

« Se con il cambiamento di HDMI Target Device le impostazioni correnti di Output Display diventano non pitt
disponibili, tali impostazioni cambieranno come segue.

- Viene impostato automaticamente il valore predefinito.

- Se il valore predefinito non puo essere selezionato, viene impostato automaticamente “SDI=On, HDMI=On.”

« HDMI Target Device non puo essere impostato su Recorder se Codec & impostato su ProRes.

Stati in cui Monitor LUT non pud essere configurato indipendentemente

Nei seguenti casi, Monitor LUT >SDI2, HDMI e Viewfinder nel menu Video non possono essere

impostate individualmente. Sono sincronizzate con I’impostazione SDI1 & Internal Rec.

- Quando Output Format >HDMI nel menu Video ¢ 4096x2160 o 3840x2160
- Quando S&Q Motion >Setting nel menu Recording &€ On
- Quando Lens >Distortion Comp. nel menu System ¢ Auto
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Avvisi durante I'utilizzo

Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il mirino del
camcorder visualizza un messaggio, gli indicatori di registrazione iniziano a lampeggiare e viene emesso
un segnale acustico.

1l segnale acustico di avvertimento viene emesso dall’altoparlante integrato e sul connettore cuffie.

Messaggi di errore

Il camcorder si arrestera nel caso abbia luogo una condizione che causa la visualizzazione di un messaggio
del tipo seguente.

Messaggio sul Segnale  Indicatoredi Causa e soluzione
mirino acustico  registrazione
di avverti-
mento
E + codice d’errore Continuo Lampeggia Indica un’anomalia del camcorder. La registrazione si arresta,

rapidamente anche se il mirino continua a visualizzare @REC.
Spegnere il camcorder e verificare eventuali problemi nei
dispositivi collegati, cavi o supporti di memorizzazione. Se il
messaggio d’errore persiste dopo aver riacceso il camcorder,
rivolgersi al proprio rappresentante di assistenza tecnica Sony.
(Se il camcorder non si spegne spostando su OFF
I’interruttore di alimentazione POWER, rimuovere la batteria
o scollegare 1’alimentazione dal connettore DC IN).

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Messaggio sul Segnale Indicatoredi Causa e soluzione
mirino acustico  registrazione
di avverti-
mento
Media Near Full Intermittente Lampeggiante La capacita rimanente sulla scheda di memoria XQD si sta
esaurendo.

Sostituire non appena possibile.

Media Full Continuo Lampeggia Non ¢ possibile registrare, copiare o dividere clip perché la
rapidamente capacita rimanente sulla scheda XQD ¢ insufficiente.
Sostituire immediatamente.

Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta esaurendo.
Ricaricare non appena possibile.

Battery End Continuo Lampeggia 11 pacco batteria ¢ scarico. La registrazione & disabilitata.
rapidamente Arrestare le operazioni e sostituire il pacco batteria.

Temperature High Intermittente Lampeggiante La temperatura interna ¢ elevata.
Spegnere il camcorder e lasciarlo raffreddare prima di
utilizzarlo nuovamente.
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Messaggio sul Segnale Indicatoredi Causa e soluzione
mirino acustico  registrazione
di avverti-
mento
Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN ¢ bassa (livello 1).
Controllare la sorgente di alimentazione.
Insufficient Voltage Continuo Lampeggia La tensione sul connettore DC IN ¢& insufficiente (livello 2).
rapidamente La registrazione & disabilitata.

Collegare un’altra sorgente di alimentazione.
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Messaggi di avviso e operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e operativi. Seguire le
istruzioni fornite per risolvere il problema.

Messaggio sul mirino

Causa e soluzione

Battery Error

E stata rilevata un’anomalia nel pacco batteria.

Please Change Battery Sostituire con un pacco batteria normale.
Backup Battery End La carica della batteria di backup ¢ insufficiente.
Please Change Caricare la batteria di backup.

Unknown Media(A)!)
Please Change

E stata inserita una scheda di memoria che & stata partizionata oppure
una scheda di memoria contenente un numero di clip superiore al
massimo gestibile da questo camcorder.

La scheda non puo essere utilizzata nel camcorder e deve essere
sostituita.

Cannot Use Media(A)!)
Unsupported File System

E stata inserita una scheda con un file system diverso oppure non
formattata.

La scheda non puo essere utilizzata nel camcorder e deve essere
sostituita oppure formattata con il camcorder.

Media Error
Media(A)!) Needs to be Restored

Si ¢ verificato un errore sulla scheda di memoria e la scheda deve essere
ripristinata.
Ripristinare la scheda di memoria.

Media Error
Cannot Record to Media(A)!D

La scheda di memoria potrebbe essere danneggiata e non puo essere
utilizzata per la registrazione.

La riproduzione & possibile, & consigliabile quindi eseguire una copia e
sostituire la scheda di memoria.

Media Error
Cannot Use Media(A)!)

La scheda di memoria potrebbe essere danneggiata e non puo essere
utilizzata per la registrazione o la riproduzione.

La scheda non puo essere utilizzata nel camcorder e deve essere
sostituita.

Media(A)!) Error
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa di un
errore durante I’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media (A)D

La scheda di memoria ha raggiunto la fine della sua vita utile.

Eseguire un backup e sostituire la scheda immediatamente. Se si
continua a utilizzare la scheda & possibile che la scheda non consenta pitt
I’esecuzione di registrazioni o riproduzioni.

Per ulteriori informazioni, consultare le istruzioni per ['uso della
scheda di memoria.

Fan Stopped

La ventola di raffreddamento si ¢ arrestata.
Evitare I'utilizzo a temperature elevate. Scollegare 1’alimentazione e
contattare il rappresentante di assistenza tecnica Sony.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

Le impostazioni di formato di Clip Naming sono state ripristinate perché
¢ stato caricato un file ALL non valido.

Configurare le impostazioni di formato desiderate e provare a salvare il
file ALL di nuovo.

1) Per la scheda nello slot B si visualizza “Media (B)”.
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Impostazioni salvate in file

Si: impostazione salvata
No: impostazione non salvata

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Camera ISO/Gain/EI Mode Si Si
1SO/Gain<H> Si Si

1SO/Gain<M> Si Si

1SO/Gain<L> Si Si

Exposure Index<H> Si Si

Exposure Index<M> Si Si

Exposure Index<L> Si Si

Shockless Gain Si Si

Auto Exposure Level Si Si
Mode Si Si

Speed Si Si

AGC Si Si

AGC Limit Si Si

Auto Shutter Si Si

A.SHT Limit Si Si

Clip High light Si Si

Detect Window Si Si

Detect Window Indication Si Si

Focus Focus Area Si No
Focus Area (Push AF) Si No

AF Assist Si No

Shutter Mode Si Si
Shutter Speed Si Si

Shutter Angle Si Si

ECS Frequency Si Si

Color Bars Setting No No
Type Si No

Noise Suppression Setting Si Si
Level Si Si

Flicker Reduce Mode Si No
Frequency Si No

SteadyShot Setting Si No
Handle Zoom Zoom Speed Type Si No
Zoom Speed Si No

Auto Black Balance Auto Black Balance - -
AF Micro Adjustment Setting No No
Amount No No

Clear All - -

Video Light Set Video Light Set Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint White Preset White Si Si
Color Temp <A> Si Si

Color Temp Balance <A> Si Si

R Gain <A> Si Si

B Gain <A> Si Si

Color Temp <B> Si Si

Color Temp Balance <B> Si Si

R Gain <B> Si Si

B Gain <B> Si Si
Filter White Memory Si No

Shockless White Si Si
White Switch<B> Si No

ATW Speed Si Si

Offset White Offset White <A> Si Si
Warm Cool <A> Si Si

‘Warm Cool Balance <A> Si Si

Offset White <B> Si Si

Warm Cool <B> Si Si

Warm Cool Balance <B> Si Si

Offset White<ATW> Si Si

Warm Cool<ATW> Si Si

Warm Cool Balance<ATW> Si Si

Black Setting Si Si
Master Black Si Si

R Black Si Si

B Black Si Si

Gamma Setting Si Si
Step Gamma Si Si

Master Gamma Si Si

R Gamma Si Si

G Gamma Si Si

B Gamma Si Si

Gamma Category Si Si

Gamma Select Si Si

Black Gamma Setting Si Si
Range - -

Master Black Gamma Si Si

Knee Setting Si Si
Auto Knee Si Si

Point Si Si

Slope Si Si

Knee Saturation Si Si

Knee Saturation Level Si Si

White Clip Setting Si Si
Level Si Si
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Detail Setting Si Si
Level Si Si
H/V Ratio Si Si
Crispening Si Si
Level Depend Si Si
Level Depend Level Si Si
Frequency Si Si
Knee Aperture Si Si
Knee Aperture Level Si Si
Limit Si Si
White Limit Si Si
Black Limit Si Si
V Black Limit Si Si
V Detail Creation Si Si
Skin Detail Setting Si Si
Area Detection - -
Area Indication No No
Level Si Si
Saturation Si Si
Hue Si Si
Width Si Si
Aperture Setting Si Si
Level Si Si
Matrix Setting Si Si
Adaptive Matrix Si Si
Preset Matrix Si Si
Preset Select Si Si
User Matrix Si Si
Level Si Si
Phase Si Si
User Matrix R-G Si Si
User Matrix R-B Si Si
User Matrix G-R Si Si
User Matrix G-B Si Si
User Matrix B-R Si Si
User Matrix B-G Si Si
Multi Matrix Setting Si Si
Area Indication No No
Color Detection - -
Axis No No
Hue Si Si
Saturation Si Si
Maintenance Test Saw Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Audio Audio Input CHI1 Input Select Si No
CH2 Input Select Si No
CH3 Input Select Si No
CH4 Input Select Si No
INPUT1 MIC Reference Si No
INPUT2 MIC Reference Si No
CH1 Wind Filter Si No
CH2 Wind Filter Si No
CH3 Wind Filter Si No
CH4 Wind Filter Si No
CH3 Level Control Si No
CH4 Level Control Si No
CH3 Input Level Si No
CH4 Input Level Si No
Audio Input Level Si No
Limiter Mode Si No
CH1&2 AGC Mode Si No
CH3&4 AGC Mode Si No
AGC Spec Si No
1kHz Tone on Color Bars Si No
CHI1 Level Si No
CH2 Level Si No
CH3 Level Si No
CH4 Level Si No
Audio Output Monitor CH Si No
Monitor Volume Si No
Headphone Out Si No
Alarm Volume Si No
Output Limiter Si No
HDMI Output CH Si No
Video Output On/Off SDI Si No
HDMI Si No
Output Format SDI Si No
HDMI Si No
REF No No
Output Setting HDMI Target Device Si No
4K/2K to HD Conv. Si No
Monitor LUT Category Si No
LUT Select Si No
Look Profile Select Si No
User 3D LUT Select Si No
SDI1 & Internal Rec Si No
SDI2 Si No
HDMI Si No
Viewfinder Si No
Output Display SDI2 Si No
HDMI Si No

131



LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

VF VF Setting Brightness Si No
Color Mode Si No

Peaking Setting Si No
Peaking Type Si No

Frequency Si No

Normal Peaking Level Si No

Color Si No

Color Peaking Level Si No

Zebra Setting Si No
Zebra Select Si No

Zebral Level Si No

Zebral Aperture Level Si No

Zebra2 Level Si No

Marker Setting Si No
Color Si No

Center Maker Si No

Safety Zone Si No

Safety Area Si No

Aspect Marker Si No

Aspect Mask Si No

Aspect Safety Zone Si No

Aspect Safety Area Si No

Aspect Select Si No

User Box Si No

User Box Width Si No

User Box Height Si No

User Box H Position Si No

User Box V Position Si No

100% Marker Si No

Guide Frame Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Display On/Off Setting Si No
Shutter Setting Si No
ND Filter Position Si No
Gain Setting Si No
Rec/Play Status Si No
HXR-IFRS Rec Control Si No
Color Temp. Si No
Frame Rate / Interval Si No
Battery Remain Si No
Timecode Si No
Audio Manual Si No
Audio Level Meter Si No
Media Status Si No
Focus Position Si No
Iris Position Si No
Zoom Position Si No
SteadyShot Si No
Focus Mode Si No
Focus Area Indicator Si No
Focus Area Ind. (Push AF) Si No
Focus Indicator Si No
Auto Shutter Si No
AGC Si No
Auto Iris Si No
AE Mode Si No
Auto Exposure Level Si No
White Balance Mode Si No
SDI/HDMI Rec Control Si No
Rec Format Si No
Gamma Si No
Timecode Lock Si No
Wi-Fi Condition Si No
Clip Name Si No
Focus Assist Indicator Si No
Focus Area Marker Si No
Video Level Warning Si No
Clip Number Si No
GPS Si No
Level Gauge Si No
Lens Info Si No
Notice Message Si No
Video Signal Monitor Setting Si No
Source Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
TC/UB Timecode Mode Si No
Run Si No
Setting No No
Reset - -
TC Format Si No
TC Display Display Select Si No
User Bits Mode Si No
Setting No No
HDMI TC Out Setting Si No
Recording S&Q Motion Setting Si No
High Frame Rate Mode Si No
Frame Rate Si No
Interval Rec Setting No No
Interval Time Si No
Number of Frames Si No
Pre-Lighting Si No
Picture Cache Rec Setting Si No
Cache Rec Time Si No
Simul Rec Setting Si No
Rec Button Set Si No
SDI/HDMI Rec Control Setting Si No
Thumbnail Display Clip Properties - -
Set Index Picture - -
Thumbnail View Essence Mark Thumbnail - -
Clip Thumbnail - -
Set Shot Mark Add Shot Mark1 - -
Delete Shot Mark1 - -
Add Shot Mark2 - —
Delete Shot Mark2 - -
Set Clip Flag Add OK - -
Add NG - -
Add KEEP - -
Delete Clip Flag - -
Lock/Unlock Clip Select Clip - -
Lock All Clips - -
Unlock All Clips - -
Delete Clip Select Clip - -
All Clips - -
Filter Clips OK - -
NG - -
KEEP - -
None - -
Customize View Thumbnail Caption Si Si
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LEVEL 1

LEVEL 2

LEVEL 3

All File

Scene File

Media

Update Media

Media(A)

Media(B)

Format Media

Media(A)

Media(B)

SD Card

Clip

Auto Naming

Camera ID

Reel Number

Camera Position

Title Prefix

Number Set

File

All File

Load SD Card

Save SD Card

File ID

Scene File

Recall Internal Memory

Store Internal Memory

Load SD Card

Save SD Card

File ID

Scene White Data

User Menu Item

Load SD Card

Save SD Card

File ID

User Gamma

Current Settings

Load SD Card

Reset

Monitor LUT

Current Settings

Load SD Card

Reset

Monitor 3D LUT

Current Settings

Load SD Card

Reset

Lens File

White Offset R

White Offset B
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

System Base Setting Shooting Mode Si No
Color Space Si No

Imager Scan Mode Si No

Codec Select Si No
Rec Format Video Format Si No
RAW Output Format Si No

Genlock Reference - -
Assignable Button <I> Si No
<2> Si No

<3> Si No

<4> Si No

<5> Si No

<6> Si No

Assignable Dial Assignable Dial Si No
IRIS Dial Si No

Assignable Dial Direction Si No

IRIS Dial Direction Si No

Rec Lamp Rec Lamp Si No
Fan Control Setting Si No
HOLD Switch Setting With Rec Button Si No
With Hand Grip Remote Si No

Lens Zoom Ring Direction Si No
Distortion Comp. Si No
Language Select Si No
Clock Set Time Zone Si No
Date Mode Si No
12H/24H Si No
Date No No
Time No No
Country NTSC/PAL Area Si No
Hours Meter Hours(System) - -
Hours(Reset) - -

Reset - -
Basic Authentication User Name No No
Password No No
Wi-Fi Wi-Fi Si No
SSID & Password - -

Wi-Fi Direct Connection - -

Client - -

IP Address - -

Subnet Mask - -

MAC Address - -

Regenerate Password - -
GPS GPS Si No
IR Remote Setting Si No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Camera Battery Alarm Low BATT Si No
BATT Empty Si No
Camera DC IN Alarm DC Low Voltagel Si No
DC Low Voltage2 Si No
Ext. Unit Battery Alarm Near End:Info Battery Si No
End:Info Battery Si No
Near End:Sony Battery Si No
End:Sony Battery Si No
Near End:Other Battery Si No
End:Other Battery Si No
Detected Battery No No
Ext. Unit DC IN Alarm DC Low Voltagel Si No
DC Low Voltage2 Si No
All Reset Reset - -
APR APR - -
Camera Config HD/2K Modulation Si No
Version Number - -

Version Up

Ext. Unit Version Number

Ext. Unit Version Up
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blocch

lagrammi a

”»

Fare riferimento alle voci relative in “Impostazione dell’audio da registrare” (pagina 45) e “Elenco delle

”

voci del menu di configurazione” (pagina 65).

Audio Input (CH1&CH2)

Internal
MIC

=

Shoet

Audio Input Level
Side
Level + Side
Through

CH1 INPUT
LEVEL
0~10

( ( |
Q ! Q
O, Q O Q
O I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

o o o

<CH1 Input Select> <CH1 Wind Filter> CH1 LEVEL OOz,_.mO_.* <CH1 Level>
Input1 On AUTO
Internal MIC Off MAN
Shoet
(T -—— == (T

(
|

Q
O
I
I
I
I
|

|
!
|
|
!
|
J

t
1
|
|
!
|
|
|

1
!
|
!
!
|
)

|
!
|
|
)

\ﬁ

<CH1 Input Select> <CH2 Wind Filter> CH2 LEVEL OOz._.mO_.* <CH2 Level>

Input1
Input2
Internal MIC
Shoe2

On
Off

AUTO
MAN

Audio Input Level
Side
Level + Side
Through

CH2 INPUT <Audio Input Level>

LEVEL
0~10

0~99

<Limiter Mode> <CH1&2 AGC Mode>

Off, -6dB
-9dB, -12dB
—15dB, -17dB

Mono
Stereo

* Impostare su MAN con ingresso audio da adattatore XLR.
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Audio Input (CH3&CH4)

Internal
E’I‘

Shoe1

)

)

O
I
I
I
I
I
I
I

- ==~

|
!
|
|
)

<CH3 Input Select> <CH3 Wind Filter> <CH3 Level Control>™ <CH3 Level>

Off
Internal MIC
Shoe1

o,
O
I
I
I
I
|
|

On
Off

Auto
Manual

Audio Input Level
CHS3 Input Level
Level + CH3 Input Level
Through

<CH3 Input Level>
0~99

!
!
|
!
J

) G | S

)

<CH4 Input Select> <CH4 Wind Filter> <CH4 Level Oo::o_v» <CH4 Level>

off
Internal MIC
Shoe2

On
Off

Audio Input Level
CH4 Input Level
Level + CH4 Input Level
Through

<CH4 Input Level> <Audio Input Level>

0~99

0~99

<Limiter Mode> <CH3&4 AGC Mode>

Off, -6dB
-9dB, -12dB
—15dB, -17dB

Mono
Stereo

* Impostare su Manual con ingresso audio da adattatore XLR.
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Audio Output

CH1

CH2

CH3

SDI

CH4

<HDMI Output CH>
CH1/CH2, CH3/CH4

<Monitor CH>
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

<Output Limiter> <Monitor Volume>

On/Off

(

ouT

HDMI OUT

0~15

<Headphone Out>
Mono/Stereo

\

1
1 X
O

<Alarm Volume>
0~7

Headphone

Internal
Speaker
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Licenze

Licenza MPEG-4 AVC Patent
Portfolio

QUESTO PRODOTTO E SOGGETTO A
LICENZA AVC PATENT PORTFOLIO PER
USO PERSONALE E NON COMMERCIALE
DEL CLIENTE O ALTRI USI PER I QUALI
NON SI RICEVE ALCUN COMPENSO PER

(i) CODIFICARE VIDEO IN CONFORMITA
ALLO STANDARD AVC (“AVC VIDEO”)
E/O

(ii) DECODIFICARE VIDEO AVC
CODIFICATO DA UN CLIENTE
IMPEGNATO IN ATTIVITA PERSONALE
E/O OTTENUTO DA UN PROVIDER
VIDEO CON LICENZA PER FORNIRE
VIDEO AVC.

NESSUNA LICENZA E CONCESSA O E DA
RITENERSI IMPLICITA PER ALTRO USO.
ULTERIORI INFORMAZIONI SONO
DISPONIBILI PRESSO MPEG LA, L.L.C.
VISITARE IL SITO
HTTP://WWW.MPEGLA.COM

141

Ottenere software sotto licenza
GPL/LGPL

Questo prodotto utilizza software a cui si
applicano le licenze GPL/LGPL. Questa nota ha
lo scopo di informare 1’utente del suo diritto di
accesso, modifica e ridistribuzione del codice
sorgente per tali programmi software secondo le
condizioni stabilite dalle licenze GPL/LGPL.

11 codice sorgente ¢ fornito su Internet. Per il
download, utilizzare il seguente URL e seguire le
istruzioni.
http://www.sony.net/Products/Linux/common/
search.html

Preferiremmo non essere contattati relativamente
al contenuto del codice sorgente.

Per i contenuti di queste licenze, vedere
“Licensel.pdf” nella cartella “License” del CD-
ROM fornito.

Per visualizzare i file PDF deve essere installato
Adobe Reader sul computer.
Se Adobe Reader non ¢ installato sul computer, &
possibile scaricarlo accedendo al seguente URL.
http://get.adobe.com/reader/



CONTRATTO DI LICENZA CON
L'UTENTE FINALE

IMPORTANT:

BEFORE USING THE SOFTWARE
CONTAINED IN THE SOLID STATE
MEMORY CAMCORDER, PLEASE READ
THIS END USER LICENSE AGREEMENT
(“EULA”) CAREFULLY. BY USING THE
SOFTWARE YOU ARE ACCEPTING THE
TERMS OF THIS EULA. IF YOU DO NOT
ACCEPT THE TERMS OF THIS EULA, YOU
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and
Sony Corporation (“SONY”). This EULA
governs your rights and obligations regarding the
software of SONY and/or its third party licensors
(including SONY s affiliates) and their respective
affiliates (collectively, the “THIRD-PARTY
SUPPLIERS”) contained in the wireless adapter,
together with any updates/ upgrades provided by
SONY, any printed, on-line or other

electronic documentation for such software, and
any data files created by operation of such
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in
the SOFTWARE having a separate end user
license agreement (including, but not limited to,
GNU General Public license and Lesser/Library
General Public License) shall be covered by such
applicable separate end user license agreement in
lieu of the terms of this EULA to the extent
required by such separate end user license
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The
SOFTWARE is protected by copyright and other
intellectual property laws and international
treaties.

COPYRIGHT

All right and title in and to the SOFTWARE
(including, but not limited to, any images,
photographs, animation, video, audio, music, text
and “applets” incorporated into the SOFTWARE)
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.
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GRANT OF LICENSE

SONY grants you a limited license to use the
SOFTWARE solely in connection with the
wireless adapter and only for your individual use.
SONY and the THIRD-PARTY SUPPLIERS
expressly reserve all rights, title and interest
(including, but not limited to, all intellectual
property rights) in and to the SOFTWARE that
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute,
attempt to derive source code, modify, reverse
engineer, decompile, or disassemble any of the
SOFTWARE, whether in whole or in part, or
create any derivative works from or of the
SOFTWARE unless such derivative works are
intentionally facilitated by the SOFTWARE. You
may not modify or tamper with any digital rights
management functionality of the SOFTWARE.
You may not bypass, modify, defeat or
circumvent any of the functions or protections of
the SOFTWARE or any mechanisms operatively
linked to the SOFTWARE. You may not separate
any individual component of the SOFTWARE
for use on more than one wireless adapter unless
expressly authorized to do so by SONY. You may
not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not
share, distribute, rent, lease, sublicense, assign,
transfer or sell the SOFTWARE. The software,
network services or other products other than
SOFTWARE upon which the SOFTWARE’S
performance depends might be interrupted or
discontinued at the discretion of the suppliers
(software suppliers, service suppliers, or SONY).
SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other
products will continue to be available, or will
operate without interruption or modification.

EXCLUDED SOFTWARE AND OPEN
SOURCE COMPONENTS

Notwithstanding the foregoing limited license
grant, you acknowledge that the SOFTWARE
may include EXCLUDED SOFTWARE. Certain
EXCLUDED SOFTWARE may be covered by
open source software licenses (“Open Source
Components”), which means any software
licenses approved as open source licenses by the
Open Source Initiative or any substantially
similar licenses, including but not limited to any
license that, as a condition of distribution of the



software licensed under such license, requires
that the distributor make the software available in
source code format. If and to the extent disclosure
is required, please visit www.sony.com/linux or
other SONY -designated web site for a list of
applicable OPEN SOURCE COMPONENTS
included in the SOFTWARE from time to time,
and the applicable terms and conditions
governing its use. Such terms and conditions may
be changed by the applicable third party at any
time without liability to you. To the extent
required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will
apply in lieu of the terms of this EULA. To the
extent the terms of the licenses applicable to
EXCLUDED SOFTWARE prohibit any of the
restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will
not apply to such EXCLUDED SOFTWARE. To
the extent the terms of the licenses applicable to
Open Source Components require SONY to make
an offer to provide source code in connection with
the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH
COPYRIGHTED MATERIALS

The SOFTWARE may be capable of being used
by you to view, store, process and/or use content
created by you and/or third parties. Such content
may be protected by copyright, other intellectual
property laws, and/or agreements. You agree to
use the SOFTWARE only in compliance with all
such laws and agreements that apply to such
content. You acknowledge and agree that SONY
may take appropriate measures to protect the
copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are
not limited to, counting the frequency of your
backup and restoration through certain
SOFTWARE features, refusal to accept your
request to enable restoration of data, and
termination of this EULA in the event of your
illegitimate use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE
SOFTWARE MAY BE DESIGNED TO BE
USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT
SERVICES (“CONTENT SERVICE”). USE OF
THE SERVICE AND THAT CONTENT IS
SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU
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DECLINE TO ACCEPT THOSE TERMS,
YOUR USE OF THE SOFTWARE WILL BE
LIMITED. You acknowledge and agree that
certain content and services available through the
SOFTWARE may be provided by third parties
over which SONY has no control. USE OF THE
CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT
SERVICE MAY BE DISCONTINUED AT ANY
TIME.

INTERNET CONNECTIVITY AND THIRD
PARTY SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet
connection for which you are solely responsible.
Further, you are solely responsible for payment of
any third party fees associated with your Internet
connection, including but not limited to Internet
service provider or airtime charges. Operation of
the SOFTWARE may be limited or restricted
depending on the capabilities, bandwidth or
technical limitations of your Internet connection
and service. The provision, quality and security of
such Internet connectivity are the sole
responsibility of the third party providing such
service.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export
and re-export restrictions and regulations of the
area or country in which you reside, and not to
transfer, or authorize the transfer, of the
SOFTWARE to a prohibited country or otherwise
in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not
designed, manufactured or intended for use or
resale as on-line control equipment in hazardous
environments requiring fail-safe performance,
such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air
traffic control, direct life support machines, or
weapons systems, in which the failure of the
SOFTWARE could lead to death, personal injury,
or severe physical or environmental damage
(“HIGH RISK ACTIVITIES”). SONY, each of
the THIRD-PARTY SUPPLIERS, and each of
their respective affiliates specifically disclaim
any express or implied warranty, duty or
condition of fitness for HIGH RISK
ACTIVITIES.



EXCLUSION OF WARRANTY ON
SOFTWARE

You acknowledge and agree that use of the
SOFTWARE is at your sole risk and that you are
responsible for use of the SOFTWARE. The
SOFTWARE is provided “AS IS,” without
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”)
EXPRESSLY DISCLAIM ALL
WARRANTIES, DUTIES OR CONDITIONS,
EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT AND FITNESS FOR A
PARTICULAR PURPOSE. SONY DOES NOT
WARRANT OR MAKE ANY CONDITIONS
OR REPRESENTATIONS (A) THAT THE
FUNCTIONS CONTAINED IN ANY OF THE
SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE
UPDATED, (B) THAT THE OPERATION OF
ANY OF THE SOFTWARE WILL BE
CORRECT OR ERROR-FREE OR THAT ANY
DEFECTS WILL BE CORRECTED, (C) THAT
THE SOFTWARE WILL NOT DAMAGE ANY
OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE,
NETWORK SERVICES (INCLUDING THE
INTERNET) OR PRODUCTS (OTHER THAN
THE SOFTWARE) UPON WHICH THE
SOFTWARE’S PERFORMANCE DEPENDS
WILL CONTINUE TO BE AVAILABLE,
UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE
IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR
ADVICE GIVEN BY SONY OR AN
AUTHORIZED REPRESENTATIVE OF SONY
SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE
THE SCOPE OF THIS WARRANTY. SHOULD
THE SOFTWARE PROVE DEFECTIVE YOU
ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR
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CORRECTION. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THESE EXCLUSIONS
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”)
SHALL NOT BE LIABLE FOR ANY
INCIDENTAL OR CONSEQUENTIAL
DAMAGES FOR BREACH OF ANY EXPRESS
OR IMPLIED WARRANTY, BREACH OF
CONTRACT, NEGLIGENCE, STRICT
LIABILITY OR UNDER ANY OTHER LEGAL
THEORY RELATED TO THE

SOFTWARE, INCLUDING, BUT NOT
LIMITED TO, ANY DAMAGES ARISING
OUT OF LOSS OF PROFITS, LOSS OF
REVENUE, LOSS OF DATA, LOSS OF USE
OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER’ S
TIME, EVEN IF ANY OF THEM HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN ANY CASE, EACH AND ALL
OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE
LIMITED TO THE AMOUNT ACTUALLY
PAID FOR THE PRODUCT. SOME
JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION
OR LIMITATION MAY NOT APPLY TO
YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA,DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information
collected from the SOFTWARE, including but
not limited to information about (i) the
SOFTWARE and (ii) the software applications,
contents and peripheral devices that interact with
your wireless adapter and the SOFTWARE
(“Information”). Information includes, but is not
limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2)
performance of the wireless adapter, the
SOFTWARE and their components; (3)



configurations of your wireless adapter, the
SOFTWARE and the software applications,
contents and peripheral devices that interact with
the wireless adapter and the SOFTWARE; (4) use
and frequency of use of the functions of (x) the
SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with
the SOFTWARE; and (5) location data, as
indicated below. SONY and its affiliates, partners
and agents may use and disclose Information
subject to applicable laws in order to improve its
products and services or to provide products or
services to you. Such uses include, but are not
limited to: (a) administering the functionalities of
the SOFTWARE; (b) to improve, service, update
or upgrade the SOFTWARE; (c) improving,
developing and enhancing the current and future
products and services of SONY and other parties;
(d) to provide you with information about the
products and services offered by SONY and other
parties; (e) complying with applicable laws or
regulations; and (f) to the extent offered,
providing you with location-based services of
SONY and other parties, as indicated below. In
addition, SONY retains the right to use
Information to protect itself and third parties from
illegal, criminal or harmful conduct.

Certain services available through the
SOFTWARE may rely upon location
information, including, but not limited to, the
geographic location of the wireless adapter. You
acknowledge that for the purpose of providing
such services, SONY, the THIRDPARTY
SUPPLIERS or their partners may collect,
archive, process and use such location data, and
that such services are governed by the privacy
policies of SONY or such third party. By
reviewed the privacy policies applicable to such
services and consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally
identify the owner or user of the SOFTWARE
without your knowledge or consent. Any use of
Information will be in accordance with the
privacy policies of SONY or such third party.

Please contact applicable contact address of each
area or country for SONY’ s current privacy

policy. Please contact applicable third parties for
privacy policies relating to personally identifiable
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and other information you provide when you use
or access third party software or services.

Information may be processed, stored or
transferred to SONY, its affiliates or agents which
are located in countries outside of your country of
residence. Data protection and information
privacy laws in certain countries may not offer the
same level of protection as your country of
residence and you may have fewer legal rights in
relation to Information processed and stored in, or
transferred to, such countries. SONY will use
reasonable efforts to take appropriate technical
and organizational steps to prevent unauthorized
access to or disclosure of Information, but does
not warrant it will eliminate all risk of misuse of
such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY
SUPPLIERS may automatically update or
otherwise modify the SOFTWARE, including,
but not limited to, for purposes of enhancement of
security functions, error correction and
improvement of functions, at such time as you
interact with SONY" s or third parties’ servers, or
otherwise. Such updates or modifications may
delete or change the nature of features or other
aspects of the SOFTWARE, including, but not
limited to, functions you may rely upon. You
acknowledge and agree that such activities may
occur at SONY” s sole discretion and that SONY
may condition continued use of the SOFTWARE
upon your complete installation or acceptance of
such update or modifications. Any updates/
modifications shall be deemed to be, and shall
constitute part of, the SOFTWARE for purposes
of this EULA. By acceptance of this EULA, you
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER,
SEVERABILITY

This EULA and SONY’ s privacy policy, each as
amended and modified from time to time,
together constitute the entire agreement between
you and SONY with respect to the SOFTWARE.
The failure of SONY to exercise or enforce any
right or provision of this EULA shall not
constitute a waiver of such right or provision. If
any part of this EULA is held invalid, illegal, or
unenforceable, that provision shall be enforced to
the maximum extent permissible so as to maintain



the intent of this EULA, and the other parts will
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for
the International Sale of Goods shall not apply to
this EULA. This EULA shall be governed by the
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA
shall be subject to the exclusive venue of the
Tokyo District Court in Japan, and the parties
hereby consent to the venue and jurisdiction of
such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this
EULA to the contrary, you acknowledge and
agree that any violation of or noncompliance with
this EULA by you will cause irreparable harm to
SONY, for which monetary damages would be
inadequate, and you consent to SONY obtaining
any injunctive or equitable relief that SONY
deems necessary or appropriate in such
circumstances. SONY may also take any legal
and technical remedies to prevent violation of
and/or to enforce this EULA, including, but not
limited to, immediate termination of your use of
the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to
violate this EULA. These remedies are in addition
to any other remedies SONY may have at law, in
equity or under contract.

TERMINATION

Without prejudice to any of its other rights,
SONY may terminate this EULA if you fail to
comply with any of its terms. In case of such
termination, you must: (i) cease all use, and
destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section
below entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND
ANY OF THE TERMS OF THIS EULA AT ITS
SOLE DISCRETION BY POSTING NOTICE
ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL
ADDRESS PROVIDED BY YOU, BY
PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN
UPGRADES/ UPDATES OR BY ANY OTHER
LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment,

you should promptly contact SONY for
instructions. Your continued use of the
SOFTWARE after the effective date of any such
notice shall be deemed your agreement to be
bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express

intended thirdparty beneficiary of, and shall have
the right to enforce, each provision of this EULA
with respect to the SOFTWARE of such party.

Should you have any questions concerning this
EULA, you may contact SONY by writing to
SONY at applicable contact address of each area
or country.

Copyright © 2012 Sony Corporation.

Licenze Open Software

Sulla base degli accordi di licenza fra Sony e i
detentori dei diritti di copyright del software,
questo prodotto utilizza software aperto.

Per soddisfare i requisiti stabiliti dai detentori dei
diritti di copyright sul software, Sony ¢ tenuta a
informare gli utenti del contenuto di dette licenze.
Per i contenuti di queste licenze, vedere
“Licensel.pdf” nella cartella “License” del
CD-ROM fornito.



Specifiche tecniche

Generale

Peso  Circa 2,0 kg (solo corpo)
Dimensioni

(Solo corpo: mm)D)
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1) Le dimensioni indicate sono approssimative.

Requisiti di alimentazione
12 Vee (da 11,0 Va 17,0 V)
Consumo energetico
Circa 19 W (corpo, obiettivo
SELP28135G, registrazione XAVC-I
QFHD 59.94P, mirino acceso)
Temperatura di esercizio
Da0°Ca40°C
Temperatura di immagazzinamento
Da —20 °C a 460 °C
Tempo di funzionamento continuato
Circa 60 minuti (con pacco batteria
BP-U30)

Formato di registrazione video
XAVC Intra
AVC/H.264 High 4:2:2 Intra Profile
QFHD: VBR, 600 Mbps max.
4K: VBR, 600 Mbps max.
HD: CBG, 222 Mbps
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XAVC Long

AVC/H.264 High Profile

QFHD: VBR, 150 Mbps max., 4:2:0,
Long

HD: VBR, 50 Mbps max., 4:2:2, Long
MPEG HD 422

MPEG-2 Long GOP

Modalita HD422: CBR, 50 Mbps,
MPEG-2 422P@HL

ProRes 422 HQ D

Apple ProRes 422 HQ

4:2:2, 10-bit, VBR, 220 Mbps max.
ProRes 422 1)

Apple ProRes 422

4:2:2, 10-bit, VBR, 147 Mbps max.

Formato di registrazione audio
LPCM 24-bit, 48 kHz, 4 canali

Frequenza di fotogrammi di registrazione
XAVC Intra
4096 x 2160/59.94P, 50P, 29.97P, 24P,
23.98P, 25P
3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P
1920 x 1080/59.94P, 50P, 59.94i, 50i,
29.97P, 23.98P, 25P
XAVC Long
3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P
1920 x 1080/59.94P, 50P, 59.94i, 50i,
29.97P, 23.98P, 25P
MPEG HD 422
1920 x 1080/59.94i, 50i, 29.97P,
23.98P, 25P
1280 x 720/59.94P, 50P, 29.97P,
23.98P, 25P
ProRes 422 HQ D
1920 x 1080/59.94i, 50i, 29.97P, 25P,
23.98P
ProRes 422 1)
1920 x 1080/59.94i, 50i, 29.97P, 25P,
23.98P

Tempo di registrazione/riproduzione
XAVC Intra 4096 x 2160/3840 x 2160
59.94p
Circa 22 minuti: Con QD-G128A
Circa 11 minuti: Con QD-G64A
50P
Circa 26 minuti: Con QD-G128A
Circa 13 minuti: Con QD-G64A



29.97P
Circa 44 minuti
Circa 22 minuti
23.98P/24P
Circa 55 minuti
Circa 27 minuti
25P
Circa 52 minuti
Circa 26 minuti

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

XAVC Intra 1920 x 1080

59.94P
Circa 59 minuti
Circa 30 minuti
50P
Circa 71 minuti
Circa 35 minuti
59.94i

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

Circa 118 minuti: Con QD-G128A

Circa 59 minuti: Con QD-G64A
50i

Circa 141 minuti: Con QD-G128A

Circa 70 minuti: Con QD-G64A
29.97P

Circa 118 minuti: Con QD-G128A

Circa 59 minuti: Con QD-G64A
23.98P

Circa 147 minuti: Con QD-G128A

Circa 74 minuti: Con QD-G64A
25P

Circa 141 minuti: Con QD-G128A

Circa 70 minuti: Con QD-G64A

XAVC Long 3840 x 2160
59.94P/50P
Circa 87 minuti: Con QD-G128A
Circa 44 minuti: Con QD-G64A
29.97P/23.98P/25P
Circa 131 minuti: Con QD-G128A
Circa 66 minuti: Con QD-G64A

XAVC Long 1920 x 1080
Modalita 50M
Circa 262 minuti: Con QD-G128A

Circa 131 minuti
Modalita 35M

Circa 374 minuti

Circa 187 minuti
Modalita 25M

Circa 524 minuti

Circa 262 minuti

: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A
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MPEG HD 422

Circa 262 minuti: Con QD-G128A
Circa 131 minuti: Con QD-G64A

ProRes 422 HQ V
59.94i/29.97P
Circa 60 minuti
Circa 30 minuti
50i/25P
Circa 72 minuti
Circa 36 minuti
23.98P
Circa 74 minuti
Circa 37 minuti

ProRes 422 1)

59.94i/29.97P
Circa 90 minuti
Circa 45 minuti

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

: Con QD-G128A
: Con QD-G64A

50i/25P
Circa 108 minuti: Con QD-G128A
Circa 54 minuti: Con QD-G64A
23.98P
Circa 112 minuti: Con QD-G128A
Circa 56 minuti: Con QD-G64A

1) Quando ¢ connessa I’unita di estensione
XDCA-FS7 (opzione)

1 tempi di registrazione e riproduzione potrebbero
variare a seconda delle condizioni di utilizzo e delle
caratteristiche della memoria.

Sezione videocamera

Dispositivo di generazione immagine (tipo)

Sensore immagine CMOS equivalente a
Super 35

Numero di pixel

11,6 Megapixel (totali),
8,8 Megapixel@17:9/
8,3 Megapixel @16:9 (effettivi)

Filtri ND

1: Trasparente
2: 1/4AND
3: 1/16ND
4: 1/64ND
Sensibilita
Gamma video: T14 a 24p
(2000 1x, 89,9% riflettanza, 3200K)



Sensibilita ISO
S-Log3 Gamma ISO2000 (sorgente
luminosa D55)
Tlluminazione minima
0,7 1x (18 dB, 23.98P, Shutter: OFF, ND
Clear, F1.4)
Attacco obiettivo
E-mount
Latitudine
14 stop
Rapporto S/N video
57 dB (Gamma video/soppressione
rumore: off)
Velocita otturatore
Da 1/3 a 1/9000 sec. (23.98P)
Angolo otturatore
Da 5,6° a 300°
Slow & Quick Motion
XAVC QFHD: Da 1 a 60P,
XAVCHD: Da 1 a 180P
Bilanciamento del bianco
Modalita preset (2100K a 10000K),
modalita memoria A, B (da 1500K a
50000K)
Guadagno
-3,0,3,6,9,12,18dB
Curva di gamma
STDI, STD2, STD3, STD4, STDS,
STD6, HG1, HG2, HG3, HG4, HG7,
HGS8, S-Log?2, S-Log3, USER1, USER?2,
USER3, USER4, USERS5

Sezione audio

Frequenza di campionamento

48 kHz

Quantizzazione
24 bit
Risposta di frequenza

Modalita MIC ingresso XLR:

Da 50 Hz a 20 kHz (+3 dB o
inferiore)

Modalita LINE ingresso XLR:
Da20Hza20kHz (+3dB o
inferiore)

Gamma dinamica
90 dB (tipico)
Distorsione
0,08% o inferiore (livello di ingresso
—40 dBu)
Altoparlante incorporato
Mono
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Microfono interno
Mono

Sezione ingressi/uscite

Ingressi

INPUT 1/2:
Tipo XLR, 3 pin, femmina
Commutabile LINE / MIC / MIC+48V
MIC: Riferimento —40, =50, —60 dBu

Uscite

SDI OUT 1/2:
Tipo BNC, 0,8 Vp-p, non
bilanciato(uscita 3G HD/1,5G HD)
Conforme a standard SMPTE ST424
Level-A/B, SMPTE ST425 Level-A/B,
SMPTE ST292-1
Audio a 4 canali

Cuffie (mini jack stereo):
—16 dBu (livello di uscita di riferimento,
volume di monitoraggio massimo,
carico 16 Q)

HDMI: Type A, 19 pin

Altro:
DC IN: conforme a EIAJ,da 11 Vcca 17 Vee
Connettore dell’unita di estensione:
Proprietario (144 pin)
Slitta Multi-interface
Proprietario (21 pin)
REMOTE:
Tipo sub mini, dia. 2,5, 3 poli

USB:  Conforme allo standard 2.0, tipo mini
AB per I’archiviazione di massa (1)
Tipo A per la connessione W-LAN (1)
VF: Proprietario (40 pin)

Sezione display

Monitor LCD
Dimensione schermo
Diagonale 8,8 cm (3,5 pollici)
Rapporto di aspetto
16:9
Numero di pixel
960 (orizz.) X 540 (vert.)



Sezione slot supporti di memoria

Slot schede XQD per registrazione video (2)
Slot scheda SD UTILITY (1)

Accessori forniti

Mirino (dotato di oculare, coppa oculare, asta,
morsetto)
Telecomando impugnatura
Modulo LAN wireless USB (IFU-WLM3)
Telecomando a infrarossi (RM-845)
Adattatore CA/Caricabatterie
Pacco batteria (BP-U30)
Tensione massima: 16,4 V DC
Tensione nominale: 14,4 V DC
Capacita: 28 Wh
Cavo di alimentazione (1)
Cavo mini USB (1)
Staffa di montaggio opzione (1)
Coperchio attacco obiettivo (1)
Coperchietto di protezione del connettore della
maniglia (incluse due viti M2) (1)
Coperchietti del connettore modulo LAN
wireless USB (2)
Riserva coperchio del connettore W-LAN (1)
Riserva coperchio del connettore dell’unita di
estensione (1)
Kit per attacco accessori (attacco accessori (1),
piastra dell’attacco (1), viti (4))
Prima di usare 1’apparecchio (1)
Istruzioni per I'uso (CD-ROM) (1)

Design e le specifiche tecniche passibili di
cambiamenti senza preavviso.

SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO RISULTANTI
DALLA MANCATA IMPLEMENTAZIONE
DI MISURE DI PROTEZIONE ADEGUATE
SUI DISPOSITIVI DI TRASMISSIONE, DA
INEVITABILI DIFFUSIONI DI DATI
RISULTANTI DALLE SPECIFICHE
TECNICHE DELLA TRASMISSIONE O DA
PROBLEMATICHE RELATIVE ALLA
SICUREZZA DI QUALSIASI TIPO.
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Note

» Eseguire sempre una registrazione di prova, e
verificare che il contenuto sia stato registrato
correttamente.

LA SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRESI,
MA SENZA LIMITAZIONE A,
RISARCIMENTI O RIMBORSI A CAUSA
DI GUASTI DI QUESTO APPARECCHIO
O DEI SUOI SUPPORTI DI
REGISTRAZIONE, SISTEMI DI
MEMORIZZAZIONE ESTERNA O
QUALSIASI ALTRO SUPPORTO O
SISTEMA DI MEMORIZZAZIONE PER
REGISTRARE CONTENUTI DI
QUALSIASI TIPO.

Verificare sempre che 1’apparecchio stia
funzionando correttamente prima di usarlo.
LA SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRESI,
MA SENZA LIMITAZIONE A,
RISARCIMENTI O RIMBORSI A CAUSA
DELLA PERDITA DI PROFITTI ATTUALI
O PREVISTI DOVUTA A GUASTI DI
QUESTO APPARECCHIO, SIA DURANTE
IL PERIODO DI VALIDITA DELLA
GARANZIA SIA DOPO LA SCADENZA
DELLA GARANZIA, O PER
QUALUNQUE ALTRA RAGIONE.

SONY NON SARA RESPONSABILE PER
RICHIESTE O RICORSI DI NESSUN TIPO
PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.

SONY NON SARA RESPONSABILE PER
LA PERDITA, RIPARAZIONE O
RIPRODUZIONE DEI DATI REGISTRATI
SUL SISTEMA DI MEMORIZZAZIONE
INTERNO, SU SUPPORTI DI
REGISTRAZIONE, SU SISTEMI DI
MEMORIZZAZIONE ESTERNI, O SU
QUALSIASI ALTRO TIPO DI SUPPORTO
O SISTEMA DI MEMORIZZAZIONE.
SONY NON SARA RESPONSABILE PER
LA CANCELLAZIONE O LA MANCATA
CONTINUAZIONE PER QUALSIASI
CAUSA O CIRCOSTANZA DI SERVIZI
CORRELATI A QUESTO APPARATO.




Download del software

Quando I’unita viene utilizzata in collegamento
con un PC, scaricare driver, plug-in e software
applicativo necessari del dispositivo dai seguenti
siti web.

Sito web per i prodotti business di Sony:

Stati Uniti http://pro.sony.com

Canada http://www.sonybiz.ca
America Latina http://sonypro-latin.com
Europa http://www.pro.sony.eu/pro

Medio oriente, http://sony-psmea.com

Africa

Russia http://sony.ru/pro/
Brasile http://sonypro.com.br
Australia http://pro.sony.com.au
Nuova Zelanda http://pro.sony.co.nz
Giappone http://www.sonybsc.com

Asia e Pacifico http://pro.sony-asia.com

Corea http://bp.sony.co.kr
Cina http://pro.sony.com.cn
India http://pro.sony.co.in

Software Sony Creative, pagina di download del
software:
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment

151

Marchi di fabbrica

XDCAM ¢ un marchio di Sony Corporation.

¢ XAVCe sono marchi registrati di Sony
Corporation.

* XQD e DCQAD sono marchi di Sony
Corporation.

* HDMLI, il logo HDMI e “High-Definition
Multimedia Interface” sono marchi o marchi
registrati di HDMI Licensing LLC negli Stati
Uniti e/o in altri paesi.

Altri nomi di societa o prodotto sono marchi o
marchi registrati dei rispettivi detentori. In questo
documento i marchi non sono contrassegnati dai
simboli ® o ™.



http://www.sony.net/
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